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Chapter 1: Integrating with Other Applications -
Overview
Integrating OMi with other software products is a great way to extend your IT management capability.
This document describes some of themajor integrations betweenOMi and other HPE products, but
does not constitute a full list of all possible integrations. For a complete list of available product
integrations, see the Integrations Catalog on HPE Software Support.

OMi-OMi Integrations

Integrations betweenmultiple OMi deployments enable the exchange of events by using event
synchronization and topology synchronization.

For more information on working with multiple OMi deployments, see theOMi Administration Guide.

OMi-Configuration Management Systems Integrations

OMi integrates with HPE Universal CMDB to enable sharing topologies (CIs and relationships)
between instances and enabling a consistent CI ID in an environment. The integration uses the
ConfigurationManagement System (CMS) topology. A single instance is configured to be the CMS and
the global ID generator; synchronization is achieved by using the topology synchronization.

For details on setting up these integrations, see theData Flow Management Guide.

SSL Setup

Ensure that the software products that you are integrating use the same SSL setup. For example, it is
not supported to use HTTP for OO and at the same time HTTPS for OMi, or vice versa.
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Chapter 2: OMi - APM Integration Overview
Important note: In the following sections, we will refer to the product as BSM, and to the
integration of BSM 9.25 and later, and APM 9.30, with OMi as the APM Integration.

The Application PerformanceManagement (APM) integration of BSM with OMi enables you to:

l Integrate user interface components from separately deployed APM systems directly into the OMi's
MyWorkspace pages. In this way, relevant information is shown directly within the OMi user
interface, although this data comes from the BSM system.

l Use theOMi embedded graphing component to show performance data stored within the Profile
database of the BSM system. For detailed information around business transactions, business
transaction flows, or specific information about location-basedmonitoring within BSM, it will be
required to drill down intoMyBSM pages. For this purpose, OMi provides drill-down operations that
allow to launch the BSM user interface in the context of a specific CI or event.

For information on supported version see the Integrations Catalog.

Understanding the Integration Process

Each instance of the APM Integration is represented in OMi as a connected server. If you are
integratingmultiple BSMs, each one will be a separate connected server.

When you integrate BSM with OMi, there are a number of steps that occur behind the scenes:

1. Topology Synchronization. The first step of the integration involves pulling the topology of CIs
from BSM into OMi. This can take some time, and in very large environments can take several
hours.

The topology of domain-specific CIs such as Business Transactions (BTs) and Business
Transaction Flows (BTFs) are not synchronized by default. Instead, we synchronize the Business
Application CI which reflects any status changes to these CIs and any BT/BTF CIs that are
related to it in BSM.

Note that the following procedure describes how to integrate BSM into OMi by using the default
integration TQLs. If you have any topologies not covered by the out-of-the-box TQLs, create a
custom integration TQL. The TQL needs to be defined on the BSM side. For information on how to
create an integration TQL, see theModeling Guide.
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Topology from BSM can also be synchronized via an external UCMDB. In this case, BSM CIs are
pulled into the UCMDB and then pushed to OMi. For more information on setting up the topology
synchronization with an external UCMDB, see "(external UCMDB only) Step 1: Prepare the
topology synchronization" on page 21.

2. BSM Status Change Alert Creation. After the BSM topology is integrated into OMi, BSM status
change alerts are created within BSM to generate events upon HI or KPI status change.
Forwarding rules then define that these alerts will be sent to OMi. As a result, when a CI's status
changes in BSM, an event is sent to OMi to update the CI's status.

3. Initial Status Synchronization.When setting up the APM-OMi integration, there is an initial
status synchronization so that each CI in OMi receives the status it has in BSM. After the initial
synchronization, whenever a CI's status changes in BSM, OMi receives a status change event.
This event changes the CI's status in OMi, but the event is not displayed in the Event Console.

In general, when a KPI's status changes in BSM, the KPI changes status in OMi. In addition, if an
HI's status changes on one of the CIs that we synchronized from BSM into OMi, this status
change is reflected directly in OMi.

4. Downtime Synchronization. After the above steps are complete, you can synchronize
downtimes, so that any downtimes defined in OMi will also apply to BSM. This includes the
downtime CI, the CIs connected to the downtime, and the scheduling and action configurations
(such as stoppingmonitoring, sending alerts and emails, and so on). In addition, OMi serves as
the central downtimemanagement location, so you can enable one time initial synchronization of
BSM downtime to OMi, in order to help start managing all downtimes on theOMi side.

OMi Integrations Guide
Chapter 2: OMi - APM Integration Overview
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Chapter 3: How to Integrate BSM with OMi
To integrate BSM with anOMi deployment, complete the following steps:

l "Before You Begin: To integrate a BSM deployment that has been upgraded from BSM 9.24 (or
earlier)" below

If your BSM deployment is not upgraded from BSM 9.24 (or earlier), begin here:

l "(RTSM only) Step 1: Install the UCMDB Data Flow Probe" on page 19 or "(external UCMDB only)
Step 1: Prepare the topology synchronization" on page 21

l "Step 2: Set Up TLS and Root Certificates" on page 24

l "Step 3: Configure Lightweight Single Sign-On" on page 25

l "Step 4: Create the Integration User" on page 26

l "Step 5: Set Up an APMConnected Server in OMi and Complete the Integration" on page 28

l "(APM 9.30 only) Step 6: Enabling Alert and Status Forwarding" on page 34

l "(APM 9.30 only) Step 7: Creating OMi Authentication User Name and Password" on page 34

l "(APM 9.30 only) Step 8: Importing Certificates for REST Service" on page 35

l "(APM 9.30 only) Step 9: Using Unsecured http REST Access" on page 36

l "Step 10: KPI Assignments in OMi " on page 37

l "Troubleshooting for the APM-OMi Integration" on page 39

Before You Begin: To integrate a BSM deployment

that has been upgraded from BSM 9.24 (or earlier)

To integrate a BSM 9.25 (or later) deployment that has been upgraded from a running BSM 9.24 (or
earlier), youmust complete the following steps first.

If you integrate remotely, copy all the content packs to your computer and then point to the local
location to deploy the package.
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1. (For BSM 9.2x only) On your BSM server, check if uCMDB content pack 11.13.859 is installed.
On the BSM system, navigate to:

Admin > RTSM Administration > Administration > Package Manager.

Click Install Content Pack. If the Install Content Pack window displays the current version of the
installed content pack, continue with the next step. Otherwise, install the content pack by using
the PackageManager as follows:

a. Navigate toAdmin > RTSM Administration > Administration > Package Manager to
open the RTSM PackageManager.

b. Click Install Content Pack to open the Install Content Packwindow.

c. Select 11* from Version and click Install to install the content pack version 11. Note that you
will only see content packs that are available but not yet installed. Those that are installed,
you will not see here.

2. On your BSM server, import all the packages listed below. Note that youmust import these .zip
files, even if these files are already present on the BSM server:

BLE.zip
Business.zip
Diagnostics.zip
OMi_Integration.zip
Sitescope.zip

To get the TQLs from BLE.zip:

a. Navigate toAdmin > RTSM Administration > Administration > Package Manager to
open the RTSM PackageManager.

b. Click to open theDeploy Packages to Serverwindow and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.

d. Open BLE.zip, then click BLE.zip to see the list of resources.

e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.

To get the TQLs from Business.zip:

a. Navigate toAdmin > RTSM Administration > Administration > Package Manager to
open the RTSM PackageManager.

OMi Integrations Guide
Chapter 3: How to Integrate BSM with OMi
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b. Click to open theDeploy Packages to Serverwindow and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.

d. Open Business.zip, then click Business.zip to see the list of resources.

e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.

To get the TQLs from Diagnostics.zip:

a. Navigate toAdmin > RTSM Administration > Administration > Package Manager to
open the RTSM PackageManager.

b. Click to open theDeploy Packages to Serverwindow and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.

d. Open Diagnostics.zip, then click Diagnostics.zip to see the list of resources.

e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.

To get the TQLs from OMi_Integration.zip:

a. Navigate toAdmin > RTSM Administration > Administration > Package Manager to
open the RTSM PackageManager.

b. Click to open theDeploy Packages to Serverwindow and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.

d. Open OMi_Integration.zip, then click OMi_Integration.zip to see the list of resources.

e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.

To get the TQLs from Sitescope.zip:

a. Navigate toAdmin > RTSM Administration > Administration > Package Manager to
open the RTSM PackageManager.

b. Click to open theDeploy Packages to Serverwindow and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.

d. Open Sitescope.zip, then click Sitescope.zip to see the list of resources.

OMi Integrations Guide
Chapter 3: How to Integrate BSM with OMi
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e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.

To validate that these packages containing individual TQLs have been loaded correctly, you can
look them up in theModeling Studio. Navigate to:

a. Administration > RTSM Administration > Modeling > Modeling Studio

b. Select Resource Type: Queries. In the list, expandRoot and scroll down to verify that CIs_
For_CIStatusChange_in_OMi is present. Next, expandRoot > Integration > OMi_
Integration to verify that the following packages are present:

OMi_Sync_Biz
OMi_Sync_BPI
OMi_Sync_Diag_TV
OMi_Sync_SiS
OMi_Sync_SiS_EMS

3. On your BSM or APM deployment, proceed as follows to check whether OMi is configured for
single sign-on configuration. First, read out the values from the JMX console to determine whether
further steps are required:

a. For BSM versions 9.25, open the JMX console on your BSM gateway server by typing in a
web browser:

http://localhost:8080/jmx-
console/HtmlAdaptor?action=inspectMBean&name=Foundations%3Aservice%3DInfrast
ructure+Settings+Manager

b. For BSM versions 9.26 or APM 9.30, open the JMX console on your BSM gateway server by
typing in a web browser:

http://localhost:29000

Navigate to Foundations > Foundations: service=Infrastructure Settings Manager

c. Find themethod java.lang.String getGlobalSettingValue().

d. Change contextName to SingleSignOn.

e. Change settingName to lw.sso.configuration.xml.

f. Click Invoke.

In the resulting output, search for the string omi. If the string omi is present twice, your deployment
is configured correctly and no further steps are required.

4. If the resulting output does not contain the string omi, BSM is not yet correctly configured for

OMi Integrations Guide
Chapter 3: How to Integrate BSM with OMi
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integrating with OMi. In this case, youmust append the necessary data:

a. On your BSMGateway Server, copy and paste the entire result output in a text editor and
append the following URLs between the <restURLs> and the </restURLs> tags:

<url>.*/topaz.*/omi.*/integration.*</url>
<url>.*/topaz.*/acweb.*</url>
<url>.*/topaz.*/personalization.*</url>
<url>.*/topaz.*/bsmLight.*</url>
<url>.*/topaz.*/ldapContext.*</url>
<url>.*/topaz.*/bsmLight.*/BPM.*</url>

b. Also append the following between the <inbound> and </inbound> tag:

<service service-pattern=
".*/topaz.*/omi.*/integration.*" service-type="rest">
<in-lwsso refid="ID000001"/>
<in-custom
classname="com.mercury.topaz.reportsExt.login.BsmLwSsoBasicAuthHandler"/>
<in-lwssoAutoCreate refid="ID000002"/>
</service>

c. Copy the entire content from the two steps above.

d. Open the JMX console on your BSM gateway server by typing in a web browser, preferably
Firefox:

http://localhost:<port>/jmx-
console/HtmlAdaptor?action=inspectMBean&name=Foundations%3Aservice%3DInfrast
ructure+Settings+Manager

For BSM 9.25, <port> is 8080.

For BSM 9.26 and APM 9.30, <port> is 29000.

e. Find themethod void setGlobalSettingValue().

f. Change the contextName to SingleSignOn.

g. Change the settingName to lw.sso.configuration.xml.

h. Paste the new content into theValue field.

i. Click Invoke.

j. Restart theMercury AS process.

Note: In a distributed environment, youmust manually establish a trust relationship between

OMi Integrations Guide
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your BSM andOMi systems. Run the following command on the BSM data processing
server:

<OMi_HOME>/opr/bin/BBCTrustServer.[bat|sh] <FQND of OMi data processing
server>

(RTSM only) Step 1: Install the UCMDB Data Flow

Probe

If you plan a direct integration between BSM-OMi (no external UCMDB) to integrate BSM CIs directly
into the RTSM, complete the following steps. If you plan to synchronize topology from BSM via an
external UCMDB, skip these steps and instead begin with "(external UCMDB only) Step 1: Prepare the
topology synchronization" on page 21.

The UCMDB Data Flow Probe pulls data from BSM toOMi. To install the UCMDB Data Flow Probe for
OMi:

1. Get the UCMDB Data Flow Probe installation bits from theOMi media kit. The UCMDB Data
Flow Probemust be of the same version as the RTSM that OMi uses. The UCMDB Data Flow
Probe can be installed on either the OMi gateway server or data processing server. For more
details on the installation of the Data Flow Probe, see the Data Flow Probe ReadMe on themedia
kit.

2. Install the UCMDB Data Flow Probe according to the instructions in theUCMDB Data Flow Probe
Installation Guide. Make sure:

o The UCMDB Data Flow Probe is connected to OMi.

o HP BSM is selected as the application server.

o TheOMi gateway server or virtual server name is specified.

3. Set credentials so that the domain name appears in a drop-down list during configuration of the
connected server:

a. Navigate to:

Administration > RTSM Administration > Data Flow Management > Data Flow Probe
Setup

b. Select DefaultDomain(Default) and expandCredentials to go toGeneric Protocol.

OMi Integrations Guide
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c. Click New in theGeneric Protocol pane to open theGeneric Protocol Parameters
wizard.

d. Leave the default values in theGeneral section.

e. Enter the user name and password of one of the following in theGeneric section:

l BSM user who has SDK permission and is allowed to perform synchronizations

l BSM administrator

l Integration user (as described in "Step 4: Create the Integration User" on page 26)

4. Start the Data Flow Probe before integrating BSM, by using

<INSTALL_DIR>/UCMDB/DataFlowProbe/bin/gateway.bat|sh start.

To see whether the UCMDB Data Flow Probe started successfully, check the following log file :

<INSTALL_DIR>/UCMDB/DataFlowProbe/runtime/log/WrapperProbeGw.log

Allow approximately 10minutes for this process to finish as the Data Flow Probe is uploading a
large number of files from the RTSM.

5. Increase the RTSM timeout in these two places if network latency is likely:

Note: The JMX Console can only be used remotely when its use is configured in BSM or OMi
respectively. For information on how to configure your JMX Console remotely, see theOMi
Administration Guide.

To log in the JMX Console, use the user name sysadmin and the password admin.

a. On your OMi deployment, open the RTSM JMX console in a web browser:

http://localhost:21212/jmx-console/.

Click UCMDB:service=Settings Services.

Click setSettingValue.

For customerID, enter value 1.

For name, enter task.DataAccess.Manager.getAdapterClassesConfig.timeOut.

For value, enter the increased RTSM timeout in milliseconds (default is 20000).

b. Also, in the RTSM JMX console http://localhost:21212/jmx-console/HtmlAdaptor,

Click UCMDB:service=Settings Services.

Click setSettingValue.
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For customerID, enter value 1.

For name, enter configuration.remote.action.timeout.

For value, enter the increased RTSM timeout in milliseconds (default is 35000).

(external UCMDB only) Step 1: Prepare the topology

synchronization

If you plan to synchronize topology via an external UCMDB, follow these steps to synchronize CIs
between BSM, OMi, and the UCMDB. In this case, HPE advises that you use the external UCMDB as
Global ID generator.

Make sure that the Data Flow probe has been installed on the UCMDB server.

If you plan to integrate BSM CIs directly into the RTSM, see "(RTSM only) Step 1: Install the
UCMDB Data Flow Probe" on page 19.

This section includes:

l "Task 1: Create Integration Point in UCMDB for BSM" below

l "Task 2: Create Integration Job to pull CIs from BSM" on the next page

l "Task 3: Create Integration Point in UCMDB for OMi" on the next page

l "Task 4: Create Integration Job to Push CIs to OMi" on page 23

l "Task 5: Verify the Topology Synchronization" on page 24

Task 1: Create Integration Point in UCMDB for BSM

Create an integration point in the UCMDB for BSM:

1. In the UCMDB, go to:

Managers > Data Flow Management > Integration Studio

2. Click New Integration Point orEdit, enter a name and description of your choice, and select the
adapter: UCMDB 9.x

3. Enter the following information for the adapter: 
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o Hostname/IP: <gateway server hostname>

o Port: < 80 or 443 depending on your protocol>

o Protocol: <communication protocol>

o Remote Machine State:Actual

o Push Back Ids For Population:Enabled

o CMDB State (Data Push):Actual

o Data Flow Probe:CMDB

4. Specify the credentials for the user you created to access the BSM system.

5. Click OK, then click theSave button above the list of the integration points.

Task 2: Create Integration Job to pull CIs from BSM

Next, create an integration job that will pull the CIs from BSM based on the TQLs specified:

1. Select the Integration Point you created in Step 1. Click thePopulation tab on the right pane, and
click Create New.

2. Click Add and go toRoot > Integration > OMi_integration.

3. Choose the following five TQLs (running order does not matter for this integration):

o OMi_Sync_Biz

o OMi_Sync_BPI

o OMi_Sync_Diag_TV

o OMi_Sync_SiS

o OMi_Sync_SiS_EMS

4. Select the check box Allow Integration Job to delete removed data.

5. In theScheduler Definition section, define the job schedule.

Task 3: Create Integration Point in UCMDB for OMi

Create an integration point in the UCMDB for OMi:
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1. In the UCMDB, go to:

Managers > Data Flow Management > Integration Studio

2. Click New Integration Point orEdit, enter a name and description of your choice, and select the
adapter: UCMDB 10.x

3. Enter the following information for the adapter: 

o Hostname/IP: <gateway/LB server hostname>

o Port: < 80 or 443 depending on your protocol>

o Protocol: <communication protocol>

o Remote Machine State:Actual

o Push Back Ids for Population:Enabled

o Push Back Ids for Push:Disabled

o CMDB State (Data Push):Actual

o Data Flow Probe:CMDB

4. Specify the credentials for the user you created to access the OMi system.

5. Click OK, then click theSave button above the list of the integration points.

Task 4: Create Integration Job to Push CIs to OMi

Next, create an integration job that will push the CIs from the UCMDB toOMi based on the TQLs
specified:

1. Select the Integration Point you created in Step 3. Click theData Push tab on the right pane, and
click Create New.

2. Based on the CIs you would like to push from the UCMDB toOMi, use an appropriate TQL. As a
starting point, you can use RTSMtoCMSSync.

If you use the RTSMtoCMSSync TQL as a starting point, youmust make sure that the correct
attributes for your integration are synchronized. Right click any node and select Properties to
bring up theQuery Node Propertieswindow. On theElement Layout tab, select Select
attributes for layout. In theConditions section, adjust the conditions in order to include the
attributes you need. If you would like to include all attributes, set Attributes condition toAll.

OMi Integrations Guide
Chapter 3: How to Integrate BSM with OMi

HPE Operations Manager i (10.60) Page 23 of 272



Task 5: Verify the Topology Synchronization

Run the integration jobs and verify the integration results in the UCMDB Manager.

Step 2: Set Up TLS and Root Certificates

If you have hardened your OMi server, youmust configure TLS in the Data Flow Probe and establish
trust between the Data Flow Probe server and theOMi server.

1. Enable TLS in the DFP to connect to OMi:

a. Open <DFP_HOME>/conf/DataFlowProbe.properties.

b. Change the property appilog.agent.probe.protocol from HTTP to HTTPS.

c. Change the property serverPortHttps from 8443 to 443.

2. Establish trust between the DFP server and theOMi server:

a. Import issue of OMi server certificate into JRE’s trust store:

<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/bin/keytool -import -trustcacerts -
file <CA cert>.pem -alias <ca cert alias> -keystore

<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/lib/security/cacerts

b. Import issue of BSM server certificate into JRE’s trust store:

<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/bin/keytool -import -trustcacerts -
file <CA cert>.pem -alias <ca cert alias> -keystore

<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/lib/security/cacerts

3. Restart the DFP server.

Youmust import the root certificate from your certification authority to the OMi and the BSM data
processing servers and gateway servers.

1. On theOMi gateway and data processing servers, run the following command:

<OMi_HOME>/bin/opr-cert-mgmt.[bat|sh] -import <alias><path>

2. On the BSM gateway and data processing servers, run the following command:
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<BSM_HOME>/JRE/bin/keytool.[exe, sh]-import -trustcacerts -file <Root
Certificate of your Certificate Authority> -alias <any name> -keystore <BSM_
HOME>/JRE/lib/security/cacerts

3. Restart the OMi and BSM gateway and data processing servers.

Step 3: Configure Lightweight Single Sign-On

Note: If you use IDM SSO, youmust temporarily switch to Lightweight Single Sign-On and restart
OMi for the change to take effect, before proceeding with the integration. Once the integration is up
and running, you can switch back to IDM SSO.

A limitation after switching back to IDM SSO:

l Once established, the data flow probe will store credentials in its cache and does not need LW
SSO. However, if you want to change the credentials used by the data flow probe to connect to
APM, or if the data flow probe cache is cleared, youmust temporarily switch back to LW
SSO and configure the data flow probe.

Aligning Lightweight Single Sign-On on both deployments enables you to view BSM components in the
OMi user interface.

Set up Lightweight Single Sign-On (LW-SSO) and align initString on both systems. It is good
practice that the product added to the existing environment gets the same key as the already existing
deployments. For example, if OMi is added last, the key needs to be changed in OMi. If more than one
BSM server is connected to the sameOMi server, change the initString parameter on the BSM side.

Note: LW-SSOwill not work if TLS is enabled for one product but not the other. Make sure that the
TLS setup is consistent between products before trying to configure LW-SSO.

l In OMi:

a. Navigate to AuthenticationManagement:

Administration > Users > Authentication Management

b. In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor panel.

c. In the Single Sign On Editor panel, select Lightweight.

d. Copy the Token Creation Key (initString) value.
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e. Click Save to save your configuration.

For details on configuring LW-SSO, see theOMi Administration Guide.

l For BSM versions 9.25 and higher and APM version 9.30, perform the following in your BSM or
APM deployment:

a. Navigate to the gateway server and open via browser http://localhost:29000/

b. Insert your credentials which you configured in the Configuration ServerWizard.

c. Search for Topaz:service=LW-SSO Configuration.

d. Paste the Token Creation Key (initString) value that you copied from OMi in the previous
instructions.

e. Click Set to save your changes.

Step 4: Create the Integration User

Note: This step is not relevant for APM 9.30 or if you use user admin. For APM 9.30, see "(APM
9.30 only) Creating a Standard User with Integration User Role" on page 28.

In this step you will begin by creating your integration user in the BSM JMX console, and then configure
the user by using the BSM user interface.

1. In your BSM deployment (DPS), go to the jmx console: http://localhost:21212/jmx-console

2. Select UCMDB:service=Security Services.

3. Go to createIntegrationUser() and create your integration user using the following values:

customerID: 1
userName: <integration user name>
password: <pwd>
dataStoreOrigin: <any value>

4. Click Invoke.

5. Invoke the getUsersList MBeanwith customerID=1 to check if the user is shown in the list of
integration users.

6. In your BSM deployment go toAdmin > Platform > User and Permissions > User
Management.
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7. Select Create New Userswith the same user name as the integration user created previously.

8. Click the icon of the user you have just created.

9. Go to the tabPermissions tab.

10. Grant theAdministrator role to your integration user.

11. Click Apply Permissions to finish.

Note: Youmust wait at least tenminutes for the changes to take effect. You can define this in the
following setting:

Navigate to: Admin > Platform > Setup and Maintenance > Infrastructure Settings

Select the context: Applications -Operations Management

Scroll toOperations Management - Topaz Authorization Service Settings

Click the edit button in the lineRefresh Interval and enter 10 in the fieldValue in theEdit Setting
dialog box.

How to Change the Integration User's Password

When you change the integration user's password on the BSM system, the passwordmust be updated
in BSM User Management and in the OMi connected server. To change the integration user's
password, perform the following steps:

1. In your BSM deployment (DPS), go to the jmx console: http://localhost:21212/jmx-console

2. Select UCMDB Service:Security Services.

3. Go to changeIntegrationUserPassword() and use the following values:

customerID: 1
userName: <integration user name>
password: <new pwd>

4. Click Invoke.

5. In your BSM deployment go toAdmin > Platform > User and Permissions > User
Management.

6. Select your integration user in the Groups/Users list.

7. On theGeneral tab, enter the new password in the Password and Confirm Password fields. Click
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Apply.

8. In your OMi deployment, navigate toAdministration > Setup and Maintenance > Connected
Servers.

9. Edit the APM connected server. In the Server Properties section, enter the new password in the
Password and Verify password fields and save.

10. In the Synchronization section, re-trigger steps 1-3 to avoid any inconsistencies after the
password change.

(APM 9.30 only) Creating a Standard User with

Integration User Role

Note: Do not perform this step if you upgraded from BSM 9.2x and already created an integration
user. It will be created automatically as part of the upgrade.

For APM 9.30, youmust create a standard user with SDK access permissions.

1. Navigate toAPM UI > Admin > Platform > Users and Permissions > User Management.

2. Create a new user.

3. Click thePermissions tab, and assign an appropriate role to the user.

4. In Managers > Administration > Security Manager, navigate to the Customize tab. Grant the
created userAccess to SDK permission.

Step 5: Set Up an APM Connected Server in OMi and

Complete the Integration

Note: This step will auto-detect the target APM version. BSM 9.25 and higher and APM 9.30 are
supported.

In the previous steps, you set up your environment to enable the APM Integration. In the following
section, you will perform the integration. In this step, you enable the following:
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l Configure and initiate topology synchronization.

l Initiate event, status, and UI integration.

l Initiate status and downtime synchronization.
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To integrate the configuration items (CIs) that exist in BSM toOMi, perform the following steps:

1. Make sure port 383 is open.

2. On your OMi deployment, navigate to:

Administration > Setup and Maintenance > Connected Servers

3. In the central Connected Servers pane, click New and select APM. Alternatively, you can click

New in the Application PerformanceManagement (APM) area in the right pane.

The Create APM Server panel opens.

4. In the General section, enter a display label, an identifier (a unique internal name if you want to
replace the automatically generated one), and, optionally, a description of the connection being
specified.

5. In the Server Properties section, complete the following information:

a. Enter the fully qualified domain name of the Application User URL setting. To find this FQDN,
follow these steps:

i. On your BSM deployment, navigate toAdmin > Platform > Setup and Maintenance
> Infrastructure Settings.

ii. Select Foundations and use the list to set the administration context toPlatform
Administration.

iii. Go to thePlatform Administration - Host Configuration section.

iv. Copy the FQDN part of the URL in the Value field of the Default Virtual Gateway Server
for Application Users URL entry. The FQDN part of the URL is the URLwithout
https:// and <port number>.

v. Paste this FQDN part into the Fully qualified domain name field.

b. Enter the user name and password of your integration user.

c. Optional. If the URL path has changed, youmust add the new URL, otherwise leave this field
empty.

d. Enter the port number of the APM server. The default port value is automatically inserted and
can be restored by clickingSet default port.

e. Make sure theUse secure HTTP check box is selected if you are using secure
communication (default).

f. Select theSync event updates back to APM servers check box if you want to synchronize
event updates back to the APM server.

6. In the Synchronization section, complete the following information:
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Note: If you plan to synchronize topology from BSM via an external UCMDB, skip this step,
as CIs have already been synchronized during "(external UCMDB only) Step 1: Prepare the
topology synchronization" on page 21.You can proceed directly to "Continue the Setup of
BSM in OMi and Start the Integration" on page 33.

If you integrate BSM CIs directly into the RTSM, click the box on the left of Step 1: Topology:

a. If theUse OMi as Global ID Generator option is editable, select your desired global ID
generator. If theUse OMi as Global ID Generator option is grayed out, a global ID generator
already exists in your environment. In this case, proceed with selecting your Data Flow Probe.

b. Select the name of your Data Flow Probe from the drop-down list. Then specify the domain
name that was used during the Data Flow Probe installation.

c. Make sure that theActivate after save check box is selected if you want to enable the server
connection immediately.

d. Click Create to start the topology synchronization and to create the APM integration point.
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Verify the Integration

The previous procedure involves pulling the topology of the CIs from BSM into OMi. This can take
some time, and in very large environments can take several hours.

The following section describes how to verify that the synchronization is complete, in order to continue
with the integration setup.

1. On theOMi server, navigate to:

Administration > Setup and Maintenance > Connected Servers

2. Check the status of the last executed job in the pane to the right of your connected server. Wait

until one integration job runs successfully before continuing. To update the status, click

Refresh.

Additionally, you can check the status of the integration jobs in the RTSM Integration Studio:

3. Navigate to:

Administration > RTSM Administration > Data Flow Management > Integration Studio

On the left-hand side of the Integration Studio, you see a list of all integration points.

4. Select the APM2OMi integration point. You see two integration jobs:

sync_continuous
sync_initial

Wait until at least one of these completes before continuing.

You can start manually either integration job by clicking the full synchronization icon or the delta
synchronization icon.
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Continue the Setup of BSM in OMi and Start the

Integration

In this section, you configure event, status, and UI integration.

1. On theOMi server, navigate to:

Administration > Setup and Maintenance > Connected Servers

2. Double-click your APM connected server to open the Edit APM Server panel. Alternatively, you

can select it and click Edit.

3. Go to the Synchronization section, and perform the following:

a. Select the check box next toStep 2: OMi to APM Setup. This step integrates UI mash-up
components and communication certificates and configures OMi server settings in APM.

b. Click Save to complete this step.

4. Go back toAdministration > Setup and Maintenance > Connected Servers.

5. Double-click your APM connected server to open the Edit APM Server panel. Alternatively, you

can select it and click Edit.

6. Go to the Synchronization section, and perform the following:

a. Select the check box next toStep 3: Synchronization. CIs in OMi are updated with KPI
status from the corresponding CIs in APM and downtime definitions are copied from APM to
OMi.

b. Optional. Select theSynchronize downtime check box to allow one time initial
synchronization of BSM downtime to OMi, in order to help start managing all downtimes on
theOMi side.

c. Click Save.

7. In the Test Connection section, click Run Test to check that the specified connection
attributes are correct. If an error message is displayed, correct the connection information, and
retest the connection.
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(APM 9.30 only) Step 6: Enabling Alert and Status

Forwarding

For APM 9.30, in order to enable alert and status forwarding, youmust manually deploy the OprEvent
template on the OMi side.

1. On your OMi deployment, navigate to:

Administration >Monitoring > Policy Templates.

2. Expand the following:

Templates grouped by type > Events > Event from REST web service

3. Click OprEvent template.

4. Click Assign and Deploy Template.

5. Select all OMi GW systems.

6. Click Next.

7. Click Next.

8. Click Finish.

(APM 9.30 only) Step 7: Creating OMi Authentication

User Name and Password

As part of the new integration between APM andOMi, embeddedOMi under APM no longer exists, and
the integration relies on connecting to OMi via REST.

Creating OMi Authentication User Name and Password

APM 9.30 users need to set an OMi user name and password for sending events from APM toOMi

1. Run the following command on the agent or OpsCx instance to which the policy was deployed in "
(APM 9.30 only) Step 6: Enabling Alert and Status Forwarding" above. This sets the user
name/password for the webservice that APM is using (same user/password of course as in APM):
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<InstallDir>/opr/bin/opr-rest-ws-policy-configuration.{bat,sh} -enable_auth -credentials -
username <username> [-password <password>]

2. In APM, select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

3. Select Foundations.

4. Select OMi Integration.

5. In the OMi Integration - General Settings table:

o Locate Login and enter the user name you used in step 1 to create your OMi authorization user
name.

o LocatePassword and enter the password you used in step 1 to create your OMi authorization
password.

Use the user name and password that you created above.

6. Save your changes.

(APM 9.30 only) Step 8: Importing Certificates for

REST Service

Note: This step is only required if a secured connection is required. If a secure connection is not
required, complete the instructions in "(APM 9.30 only) Step 9: Using Unsecured http REST
Access" on the next page.

To import the certificates:

1. On theOMi agent or OpsCx instance where the policy was deployed, retrieve the OMi certificates
for the REST service, by entering ovcert -list in a cmdwindow.

Note: The certificate to be trusted is the one issued on the agent or OpsCx instance where
the policy was deployed in "(APM 9.30 only) Step 6: Enabling Alert and Status Forwarding" on
the previous page. For example, if the policy was deployed on theOMi gateway server, then
import the certificate from theOMi gateway server.

2. Export the certificate by using the following command:

ovcert -exporttrusted -file <location of file> -alias <trusted certificate name>
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For example:

ovcert -exporttrusted -file c:\trust.pem -alias CA_c37b8bd5-5b9b-4626-be18-
c78ef76040e5_2048

where

c:\trust.pem is the location for the file which will be exported

CA_<UUID>_2048 is the CA certificate of OMi (where <UUID> is the ID retrieved when
using the ovcoreid -ovrg server command).

3. Import the certificate by running the following command from the JRE64/bin folder on the APM
gateway and data processing servers:

keytool.exe -import -trustcacerts -keystore ..\lib\security\cacerts -storepass changeit -alias
ANYCERTID -file <location of file>

4. Restart the APM server on both the gateway and data processing server.

(APM 9.30 only) Step 9: Using Unsecured http REST

Access

Note: This step is optional only if a secured connection is not required. If a secure connection is
required, complete the instructions in "(APM 9.30 only) Step 8: Importing Certificates for REST
Service" on the previous page.

The default communicationmethod is https. In order to use http, perform the following:

1. Access APM JMX, for example:

http://<localhost>:29000/mbean?objectname=OMi-Integration%3Aservice%3DSettings

2. Enter the URL to connect to OMi by using setOmiUrlmethod, for example:

http://<OMi GW>:30005

3. To view the settings, use themethod getOmiUrl.
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Step 10: KPI Assignments in OMi

Note: This step is not relevant if you upgraded to APM 9.30 from BSM 9.25 or BSM 9.26, and
already configured this integration.

BSM sends KPI status information for certain CI types to OMi. Per default, this is done for Business
Application CIs, but BSM can also send KPI status changes for other CI Types. Such a KPI status
change is sent to OMi in the form of a special event with a Health Indicator (HI) that contains the KPI
name and the new status. These KPI change events are processed separately from other events and
are not stored in the event database.

When a KPI change event arrives in OMi, the following is triggered:

l Assuming an “Application Availability KPI change event” arrives, a corresponding Health Indicator
“Application Availability” is created automatically (for the corresponding CI type).

l If the CI Type does not yet have a KPI assignment for that specific KPI, then a new KPI
assignment is created automatically that uses the HI “Application Availability” to set the KPI
“Application Availability” and no further steps are necessary. The KPI status of the “Application
Availability” KPI will be synchronized automatically.

l If the CI Type already has a KPI assignment, then the KPI assignment needs to be adjusted
manually.

BecauseOMi already has an out-of-the-box KPI assignment for Business Application CIs, youmust
perform the followingmanual steps.

1. In OMi, navigate toAdministration > Service Health > CI Status Calculation >
KPI Assignments.

2. Select the CI Types ConfigurationItem > BusinessElement > BusinessApplication.

3. Pause the assignments for BPM and RUM. These are predefined KPI assignments, which are not
suitable for an OMi system.

4. Click New to open the Create KPI Assignment panel. Specify an appropriate display name

and, optionally, a description.

5. In theKPI Configurations section, click New KPI Configuration.

6. Select the KPI definition Application Availability. Leave the default values in the Business Rule

and Calculated BasedOn fields, and add the Related HI Application Availability. Click
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Apply.

7. Repeat Steps 5 and 6 for the KPI definitionApplication Performance, and the Related HI
Application Performance. Check Activate after save and create the KPI Assignment.

8. In the CI Type selection pane, select the CI type BusinessElement and click Apply all rules to
update all CIs.

If a CI Type already has a KPI assignment for the KPI that received a change event from the APM
system, the new HI needs to be addedmanually.

1. In OMi, navigate toAdministration > Service Health > CI Status Calculation >
KPI Assignments.

2. Select the appropriate CI Type.

3. Update the existing KPI assignment and in the KPI Configurations section, include the new HI
which represents the KPI status change.

4. Save the KPI Assignment.

5. In the CI Type selection pane, select the appropriate CI Type and click Apply all rules to
update all CIs.

Additional APM-OMi Integration Configurations

Integrating BSM with a new, second instance of OMi

To integrate BSM with a new instance of OMi, after disconnecting the original OMi system from BSM,
perform the following:

Note: It is not possible to simultaneously connect twoOMi systems to one BSM system. The
original OMi systemmust first be disconnected before connecting a new OMi instance to BSM.

1. Connect BSM toOMi and execute the topology synchronization following the steps in "Step 5: Set
Up an APMConnected Server in OMi and Complete the Integration" on page 28.

2. After the topology synchronization, go to theOMi Integration Studio and select the Integration
Point with the name "APM2OMi <name of connected server>".

3. On the right side, select one of the two sync_* jobs.
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4. On the toolbar, click Clear caches.... After completion, click Full synchronization.

5. The global IDs generated by the new OMi instance are now properly pushed to BSM.

BSM Status Forwarding Settings

In BSM, additional settings control CI status forwarding from BSM to OMi. In most cases, you do not
need to change these settings. In BSM, navigate toAdmin > Platform > Setup and Maintenance >
Infrastructure Settings. Select Foundations: OMi Integration. Edit the settings as desired.

For example, theHI Statuses Sync - CITs configuration file in theOMi Integration - General
Settings section is an XML file that defines the CITs with HIs that should be forwarded to OMi. If
desired, you can edit this XML file to change the CITs whose HIs will be forwarded from BSM toOMi.

Troubleshooting for the APM-OMi Integration

Adjust KPI assignments

To adjust and troubleshoot KPI assignments in OMi, perform the following:

1. In BSM, create a KPI assignment with theApplication AvailabilityKPI type, and any of the
available HIs.

2. Send an event onOMi by using the sendEvent.bat|.sh tool. The event should contain a severity
with the new state of the KPI, a category KpiStatusChange, an ETI Hint containing only the name
of the affected KPI, and a RelatedCiHint with a valid hint for the CI resolver.

Example: In this example, Application Performance has been chosen as the
assignment in step 1.

<OMi_HOME>/opr/support/sendEvent.[bat|sh] -t example -c KpiStatusChange -s
Normal -rch GUCMDB:<GlobalCi_Of_BusinessApplication_CI> -eh "Application
Performance"

3. In OMi, navigate toAdministration > Service Health > KPI Assignments.

4. In the left pane, select ConfigurationItem > BusinessElement > BusinessApplication.

5. In the central pane, select the assignment that contains Application Availability, Availability
Performance, and click Edit to edit the KPI assignment.
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6. In the Edit KPI Assignment panel, navigate to the KPI Configurations section.

7. Select theApplication AvailabilityKPI, and click Edit.

8. In the Related HIs field, add the Application Availability HI to the list of selected HIs.

Note: If you do not see any HIs in the Related HIs drop-downmenu, wait until CI status
changes are from BSM toOMi. The forwarding of CI status changes is triggered by the first
change of a CI status of any CI that is present in BSM and has been synchronized toOMi.
These adjustments can only be done when a corresponding CI status event has been
received in OMi. Otherwise, you will not see the Application Performance or Application
Availability HIs.

9. Click Save.

10. Perform steps 7 to 10 for the Application Performance HI and KPI.

11. Click Apply all rules for the assignment to take effect on existing CIs.

Failed to re-direct topology from BSM9.2x to OMi 10.11

If you integrate SitesScope with BSM 9.26 for OMi features (topology and events) and upgrade BSM
9.26 to OMi 10.11, the integration betweenOMi and SiteScope does not behave as it used. You will not
see the new topology and events from your existing SiteScope in the new upgradedOMi.

Workaround: Reset the BSM integration in SiteScope and delete the integration in OMi10.11's
Connected server and re-integrate SiteScope from OMi10.11.

To reset the BSM integration in SiteScope:

1. Log in to SiteScope with your user ID and password.

2. Go toPreferences > Integration Preferences.

3. Edit the existing BSM integration.

4. Click theBSM Preferences Available Operations tab and click Reset.

5. Click OK. The BSM integration is deleted.

Topology synchronization fails with APM 9.30

If LDAP was configured on the APM 9.30 system, it's possible that the integration user's password
was not correctly saved in the RTSM database, which will cause the topology integration to fail. To
manually update the integration user's password in the RTSM, do the following:
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1. Log in to APM as an administrative user.

2. In the same browser in a different tab, connect to the RTSMwith http://<APM>:21212, and
select User Management.

3. Find the integration user and select Change Password.

4. Fill in the new password (you can leave the old password blank).

5. Save the new password and trigger the topology synchronization again.

Integration Fails with Trust for event synchronization failed error

If you are running the OMi-APM integration and APM is using IIS and theOMi-APM integration fails
with a Trust for event synchronization failed error, perform the following on all APM gateways
running on IIS.

1. From the Start menu, click Administrative Tools > Internet Information Services (IIS)
Manager.

2. In the Connections pane, click Default Web Site.

3. In the right pane, double-click Request Filtering.

4. Click theHTTP Verbs tab.

5. In the right pane, right-click and select Allow Verb.

6. In the Allow Verb dialog box, enterPUT and click OK.

7. Click the File Name Extensions tab.

8. In the right pane, right-click and select Allow File Name Extension.

9. In the Allow File Name Extension dialog box, enter group and click OK.

10. Reset IIS.
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Chapter 4: How to Display BSM Data in OMi
BSM user interface components can be directly integrated into OMiWorkspaces to view and drill down
to detailed BSM information.

Note: All APM systems connected to OMi must be the same version and/or provide the same
features.

Create a BSM User Interface Element

1. On theOMi server, navigate to:

Workspaces > My Workspace

2. Create a new page:

a. Click theNew Page icon on the top left of the toolbar.

b. Click Add Component in the graphics on the left to open theComponent Gallery.

c. Select APM from the list on the left of theComponent Gallery to display the BSM
components.

d. Double-click the desired BSM.

It is not possible to apply a filter to the user interface components from the BSMs that are displayed in
OMi.

The following BSM use cases are supported:

1. Selecting BSM components from theOMi components gallery and opening them in a frame inside
the OMi components dashboard.

2. Wiring in case of a CI change. For example, a CI 1 is selected and its associated data is
displayed. If now a different CI, CI 2, is selected, the data displayed changes to data associated
with CI 2.

The following components are currently available in OMi:

l Platform Components

Application Health
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Note: The Application Health component:

o Does not support wiring.

o Is available starting from APM 9.31.

Top View

Hierarchy View

APM Based Impact

l BPM Components

Application Summary

BPM PerformanceMatrix

BPM Performance Status

BPM Error Summary Distribution by Category/Type

Application Health Business Summary

BPM Error Summary Distribution by Location/BPM Custom Attributes

BPM Error Summary Distribution by Transaction

Metrics Over Time

l RUM Components

Application Health Performance

Application Health Availability

RUM Event Count By classification

l SiteScope components

Cross Performance Reports

SiteScopeMulti View

l Service Level Management components

SLA Summary

Current Status Snapshot

Historic Status Snapshot
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Chapter 5: How to Customize BSM-OMi
Integration
There are several OMi Integration Infrastructure setting that will enable you to customize your BSM-
OMi Integration.

To customize the BSM-OMi integration:

1. In the BSM application, select Admin > Platform > Setup and Maintenance > Infrastructure
Settings.

2. Select Foundations > OMi Integration.

3. Configure the OMi Integration settings as follows:

o HI Statuses Sync - CITs configuration file. Define which CI types to include in the HI status
synchronization. The following CI types are included by default: node, running_software,
business_application. You can add additional CI types or remove existing ones. The CI type
name is the internal name (not the display name, for example, the display name is business_
application, not Business Application). You can view the CI type name underRTSM > CIT
manager.

o KPIs list per CI type (Business Application). Define which KPI to use for synchronizing the
KPI status change. The following CI type is included by default: Application Availability and
Application Performance for CI type business_application. You can add additional KPIs
and CI types or remove existing ones. Keep inmind that the TQL integration for topology
synchronization jobs must bemodified to cover the sameCI type. If the CIs and theGID are
missing from OM, no status change will be reflected.

o Events chunk size. Size of chunk of events sent during initial KPI/HI synchronization. You
can enter a number between 1 and 500.

o Interval between session. Interval between events chunks sending sessions (seconds). You
can enter a number between 1 and 10.

o Event forwarding CI Alert name if status improved. Enter the event description that is
generated when status changes and becomes better.

o Event forwarding CI Alert name if status worsened. Enter the event description that is
generated when status changes and becomes worse.

In addition, you can use the tql -CIs_For_CIStatusChange_in_OMi to define which CI types to use to
synchronize KPI status changes.
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Chapter 6: How to Create and Forward End User
Management Alerts to OMi
It is best practice to forward End User Management (EUM) related information to OMi. With EUM
alerts, you can:

l Configure granular trigger conditions based event based triggers or time based triggers. For
example, you can send an alert when a transaction fail or exceeds a specified amount of time.

l Filter the alert by transaction, location, or mobile device

l Configure the notification frequency

By creating EUM alerts, you can pass critical Business Process Monitor (BPM) transactions and CIs
that are not part of the integration to OMi. When you create EUM alerts you should tailor them
according to your specific requirements. In the Actions tab, be sure to select the generating event
alert action. Events that are created in this manner, are automatically forwarded to OMi as part of the
integration predefined forwarding rules.

For information about creating andmanaging EUM alerts, see theBSM Application Administration
Guide.
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Part III: Operations Manager i -
HPE SiteScope Integration
This part of the guide contains the following chapters:

l "SiteScope Integration - Overview" on page 47

This chapter provides the SiteScope integration overview.

l "SiteScope Integration - Tasks" on page 48

This chapter describes various tasks that youmust perform to configure and use the SiteScope
integration.

Information on setting up a SiteScope connected server, importing SiteScope templates, and
troubleshooting the use of SiteScope templates in OMi is described in theOMi Administration Guide



Chapter 7: SiteScope Integration - Overview
SiteScope is an agentless monitoring solution that enables you to remotely monitor the availability and
performance of your IT infrastructure (for example, servers, operating systems, network devices,
network services, applications, and application components). The SiteScope integration with OMi has
multiple parts, which can be enabled individually or in combination with one another. The parts of the
integration described in this guide are:

l Event integration: SiteScope can forward events to OMi. For information, see "Configure the
event integration" on page 50.

l Topology integration: SiteScope can forward topology information to OMi. For information, see
"Configure the topology integration" on page 51.

l Drilldown integration: When SiteScopemonitors are used to set the status of a configuration item
(CI), you can drill down from the CI in OMi to a SiteScopemonitor that contributes to the HI's
status. For information, see "How to Drill Down to SiteScope" on page 52.

l Configuring and deploying SiteScope monitors from OMi: OMi provides a script that enables
you to import templates from a SiteScope server so that you can include them in aspects, thus
allowing you tomanage the configuration and deployment of SiteScopemonitors from within OMi.
For information, see "Configuring and deploying SiteScopemonitors from OMi" on page 48.
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Chapter 8: SiteScope Integration - Tasks
This section describes the tasks that youmust perform to configure and use the SiteScope integration:

l "Configuring and deploying SiteScopemonitors from OMi" below

l "Configure the event integration" on page 50

l "Configure the topology integration" on page 51

l "How to Drill Down to SiteScope" on page 52

Configuring and deploying SiteScope monitors from OMi

You can set up the OMi-SiteScope integration so that you can configure and deploy SiteScope
monitors from within OMi. To set up this integration, follow these steps:

Note: To enable this integration for TLS, perform the steps in "How to Connect to a SiteScope
Server That Requires TLS" on page 53 and "Setting up TLS between sisconfig and SiteScope
runtime" on page 55.

1. Install the Operations Agent on the SiteScope system.

Install Operations Agent from the SiteScope installer package, or download it from the
HPE Software Support (in the Search box, type "Operations Agent", select the relevant version,
under Document Type, select Patches, and locate the installation file).

OnWindows:

a. Log in to the node with administrator privileges.

b. Go to the directory where you extracted the contents of the ISO file.

c. Run the following command to install the agent:
cscript oainstall.vbs -i -a

On Linux:

a. Log on to the node with root privileges.

b. Go to the directory where you extracted the contents of the ISO file.

c. Run the following command to start the installation:
./oainstall.sh -i -a
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Formore detailed installation instructions, see theOperations Agent Installation Guide, available
from the HPE Software Support site.

Note:

o Use the -includeupdates installation to install Operations Agent with prepackaged
hotfixes. For details, see theOperations Agent Installation Guide.

2. Configure the Operations Agent.

This task registers the sisconfig subagent process (used for Monitoring Automation to deploy
monitoring to SiteScope), and installs the policy signing tool (used by SiteScope to install policies
locally).

a. Run the SiteScope Configuration Tool on the SiteScope server:

l OnWindows: Select Start > All Programs > HP SiteScope > Configuration Tool.

l On Linux (graphic mode): Run <SiteScope install Directory>/bin/config_tool.sh

l On Linux (consolemode): Run <SiteScope install Directory>/bin/config_tool.sh
-i console.

For more details on using the SiteScope Configuration Tool, see theHPE SiteScope
Deployment Guide.

b. In theConfigure HP Operations Agent installed separately option (HP Operations Agent
option in consolemode), select Configure HP Operations Agent to complete the installation
of the Operations Agent.

c. Restart SiteScope.

d. If the agent is installed on a RedHat ES Linux 6.0 environment, after installing the Operations
Agent, check the installation status in the log files.

i. In the SiteScope log, check if the installation completed successfully by searching for
the results of installOATask.

Log file name: HPSiteScope_config_tool.log

Log file location onWindows platforms: win- %temp%

Log file location on UNIX/Linux platforms: /temp or /var/temp

ii. In the Operations Agent log files:

Log file name: oainstall.log, oapatch.log
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Log file location onWindows platform: %ovdatadir%\log

Log file location on UNIX/Linux platforms: /var/opt/OV/log

3. Set up the SiteScope system as a connected server on the OMi server. For more information on
setting up a SiteScope connected server and on selecting the target SiteScope server for
deployment, see theOMi Administration Guide.

4. Configure templates in SiteScope and import them. For information on importing templates from a
SiteScope server and assigning SiteScope policy templates to remote servers, as well as for
troubleshooting information, see theOMi Administration Guide.

Guidelines for Using Multiple SiteScope Monitors of Same Monitor Type

Follow these guidelines if you are deployingmultiple SiteScopemonitors of the samemonitor type on
the same host. These guidelines are important for accurate graphing of SiteScopemetric data using
OMi Performance Dashboard.

l Do not monitor the samemetric frommultiple monitors. It may randomly select onemetric value
over the other, causing errors.

l Ensure that the name of your SiteScopemonitor follows this convention:

<monitor name> on <hostname>

For example, whenmonitoring a server named sample.domain.comwith two separate Unix
resourcemonitors for file system usagemetrics and network usagemetrics, name the twomonitors
as follows:

File_system_usage on sample.domain.com and Network_usage on sample.domain.com

l If you are using SiteScope templates to createmonitors, follow this naming convention:

<prefix name> on %%host%%

Configure the event integration

1. Log in to SiteScope, and navigate toPreferences > Integrations Preferences.

2. Click New Integration, and in the resulting window select HP Operations Manager Integration.

3. Enter the FQDN of the OMi server.

4. Check the following boxes:
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a. Enable sending events

b. Connect directly to BSM

c. Prefer events over metric in BSM Service Health (global preference)

5. Uncheck theEnable exporting templates to HP Operations Manager box.

6. Click Connect to activate the agent.

Note: If you have not configured certificate auto-granting, youmust manually grant the
certificate request in OMi:

o Navigate toAdministration > Setup and Maintenance > Certificate Requests

o Select the certificate request.

o Click theGrant icon.

7. Click Install Polices, then click Analyze to verify the configuration.

8. In the Test Integration section, enter a test message, and click Send Test Message. Then click
Send Test Event. Click OK to close the window, then click OK in the following Disable Policy
Result window. Verify that both events are in the OMi Event Browser.

Configure the topology integration

1. In OMi, create a connected server for the SiteScope server. For information on creating a
connected server, seeOMi Administration Guide.

2. Verify that the integration has been configured automatically in SiteScope:

o In SiteScope, navigate toPreferences > Integration Preferences.

o Youwill see a new BSM integration configured as a result of creating the connected server in
OMi.

3. Configure all pre-existingmonitors to set Service Health based on events.

Now that you have integrated SiteScope with OMi, any pre-existingmonitors have been updated
with an HPE Integrations Settings section. In this section, the BSM Service Health Preferences
show Service Health is affected by Metrics. This settingmust be changed to Events, so that
events carry indicators to set Service health. To change the BSM Service Health Preferences
fromMetrics to Events:
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a. In themonitor tree, right-click the SiteScope container and select Global Search and
Replace.

b. In the wizard, select all monitors. In the Choose Changes tab, check theBSM Service
health affected by box and set the associated drop down list toEvents.

4. Verify that the topology has been created in the RTSM.

a. In OMi, navigate toAdministration > RTSM Administration > IT Universe Manager.

b. Search for all node CIs. You should now see one or more new CIs created by SiteScope.

c. Troubleshooting: If topology is not appearing in the RTSM, you can check for errors in the
SiteScope logs.

If you see an error in <SiteScope>\logs\bac_integration\discovery.log, clear the
topology cache on SiteScope:

l Set the SiteScope service.

l Delete the 4 files in <SiteScope>\discovery\hsqldb directory

l Start the SiteScope service.

l Re-synchronize the topology. Log in to SiteScope and navigate toPreferences >
Integration Preferences. Edit BSM Integration, and in the resulting window click Re-
Synchronize underBSM Preferences Available Operations.

How to Drill Down to SiteScope

When SiteScopemonitors are used to set the status of a configuration item (CI), you can drill down
from the CI (or from a health indicator (HI) on the CI) to a SiteScopemonitor that contributes to the HI's
status.

1. Access menu commands from aCI or HI in aMy Workspace page or component, for example
360° View, Top View, View Explorer, Health Indicator, or the SiteScopeMulti-View component.
Select Go to >SiteScope. The SiteScope UI opens directly to the parent group of the relevant
monitor.

If monitors frommultiple groups contribute to the CI's or HI's status, theDrilldown to SiteScope
dialog box opens. Select themonitor to which you want to drill down and open it in SiteScope.

The Drilldown to SiteScope dialog box displays the following hierarchy:
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o The root level shows health indicators.

If you open the dialog box for a CI, one or more HIs that contribute to the CIs status are listed.
If you open the dialog box for an HI, this HI appears as the root.

o The level below the root shows the SiteScope systems (connected server name) that have
monitors contributing to the HI.

o The lowest level shows the SiteScopemonitors that contribute to the HI.

Note: In theSystem Monitors view, if you select Go to > SiteScope from amonitored CI,
SiteScope opens themonitor's parent group. If you select this from a group CI, SiteScope
opens directly to the group.

2. Select a SiteScopemonitor, and click Drilldown.

For details on working with SiteScope, see SiteScope Help.

How to Connect to a SiteScope Server That Requires TLS

To connect to a SiteScope server that requires TLS, OMi must trust the root certificate that was used to
sign the SiteScope certificate. This is done by adding the root certificate to the CA keystore of the OMi
server and to the CA keystore of the SiteScope server.

Complete one of the following procedures depending on the type of certificate that was used to sign the
SiteScope certificate:

Note: If the OMi server runs a Linux operating system, replace the paths in the following
procedures with their Linux equivalents.

l Certificate from a certificate authority. If the SiteScope certificate was signed with a certificate
from a certificate authority, import the certificate to the SiteScope CA keystore and to the CA
keystore of the OMi server:

a. Obtain the root certificate (and any other intermediate certificate) from the certificate authority.

b. On the SiteScope server to which you want to deploy policies, import the root certificate (and
any other intermediate certificate) to the SiteScope CA keystore. Type:

C:\SiteScope\java\bin\keytool -importcert -alias <yourCA> -file
<CAcertificateFile> -keystore C:\SiteScope\java\lib\security\cacerts

When prompted for the password, type the keystore password. (The default password is
changeit.)
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c. On theOMi server to which you want to export SiteScope templates, import the root certificate
(and any other intermediate certificate) to the OMi CA keystore. Type:

<OMi_HOME>\bin\opr-cert-mgmt.[bat|sh] -import <alias> <path>

When prompted for the password, type the keystore password. (The default password is
changeit.)

d. Restart SiteScope, so that the newly imported certificate will be recognized and used by the
integration.

l SiteScope self-signed certificate. If the SiteScope certificate is a self-signed certificate (for
example, a certificate that was created and configured with the SiteScope tool ssl_util), export the
self-signed certificate from SiteScope and import it to the CA keystores of the OMi server and
SiteScope:

a. On the SiteScope server, export the self-signed certificate, type:

C:\SiteScope\java\bin\keytool -exportcert -keystore
C:\SiteScope\groups\serverKeystore -alias sitescope -file <certificateFile>

When prompted for the keystore password, type the password that was specified when using
the ssl_util tool.

b. On the SiteScope server, import the self-signed certificate to the SiteScope CA keystore.
Type:

C:\SiteScope\java\bin\keytool -importcert -file <certificateFile> -keystore
C:\SiteScope\java\lib\security\cacerts

When prompted for the password, type the keystore password. (The default password is
changeit.)

c. Copy the certificate to the OMi server to which you want to export SiteScope templates.

d. On theOMi server, import the self-signed certificate to the OMi CA keystore. Type:

<OMi_HOME>\bin\opr-cert-mgmt.[bat|sh] -import <alias> <path>

Note: Formore information on the opr-cert-mgmt tool, see the OMi Extensibility Guide.

When prompted for the password, type the keystore password (the default password is
changeit).

e. Restart SiteScope, so that the newly imported certificate will be recognized and used by the
integration.

f. Required if both OMi and SiteScope use HTTPS setup. Import the SiteScope serverKeystore
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to the OMi CA keystore:

i. Copy the SiteScope serverKeystore, located in
C:\SiteScope\groups\serverKeystore, to the following location in OMi: <OMi_
HOME>\JRE\lib\security

ii. Import the serverKeystore to OMi cacerts:

<OMi_HOME>\JRE\bin\keytool -importkeystore -destkeystore cacerts -
deststorepass <keypass> -srckeystore /tmp/serverKeystore -srcstorepass
<keypass>

For <keypass>, define the keystore password that you set in SiteScope.

iii. Restart SiteScope and theOMi gateway server.

Setting up TLS between sisconfig and SiteScope runtime

The sisconfig component is the adapter between theOperations Agent and the SiteScope runtime. If
you are performing the integration to enable configuration and deployment of SiS monitors from OMi,
and you want TLS to be enabled, follow these steps:

1. Set up TLS for SiteScope:

a. If SiteScope was not yet configured to run with HTTPS, set up a self-signed certificate:

<SiteScopeDir>/java/bin/keytool -genkey -dname "CN=www.example.net,
OU=myOffice, O=myCompany, L=myLocation, ST=myState, C=myCountry" -alias
myAlias -keypass mykeypass -keystore

<SiteScopeDir>/groups/serverKeystore -storepass mykeypass -kelalg "RSA" -
validity 742

b. Modify tomcat:

In <SiteScopeDir>/Tomcat/conf/server.xml comment the port="8080" and add the
following:

<Connector port="8443" maxThreads="150" minSpareThreads="25"
maxSpareThreads="75" enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true" clientAuth="false"
sslProtocol="TLS" keystoreFile="<SitescopeDir>/groups/serverKeystore"
keystorePass="passphrase" />

Restart tomcat.
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2. Set up TLS for sisconfig:

a. Import the SiteScope root certificate to the Java keystore so that siconfig can find it:

<SitescopeDir>/java/bin/keytool -import -keystore
SitescopeDir>/java/lib/security\cacerts -storepass mykeypass -trustcacerts -
file "<SitescopeDir>/groups/serverKeystore"

b. Set https_enabled=true and check that the port is 8443:

<OvBinDir>/ovconfchg –ns opr.sisconfig –set https_enabled true

<OvBinDir>/ovconfchg –ns opr.sisconfig –set sis_port 8443

c. Restart sisconfig:

<OvBinDir>/ovc –restart sisconfig
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Chapter 9: Operations Manager i - HP
Operations Manager Integration Overview
HP Operations Manager (OM) can be integrated into your OMi environment to become a data source for
OMi. OM forWindows, OM for UNIX (UX and Solaris), andOM for Linux are supported.

After you install both OMi andOM, follow the described procedures to connect OMi andOM. This
connection enables bidirectional synchronization of events between the two systems, tool execution,
and instruction text retrieval. The connection configuration requires you to establish a trust relationship
between theOMi andOM systems, as well as to configure amessage forwarding policy.

The integration betweenOMi andOM provides you with the following capabilities:

l OM events > OMi. Events from OM are displayed in the OMi Event Browser.

l OM events > OMi health indicators. After you set up the integration, if the OM events have
corresponding health indicators defined, these health indicators automatically affect the status of
the relevant Configuration Items (CIs) in OMi applications such as Service Health. For an
introduction to health indicators, see theOMi User Guide.

l OMi Actions, Tools, and Instructions. You can specify tools, for example, to ping a system.
These tools are launched from events or the Actions panel and run on the associated CI. The tools
are designed to help users solve common problems quickly and efficiently. All available tools are
launched in the context of a CI. The selection of tools a particular user sees in context menus
depends on the tools that are available for the CI affected by a particular event.

Events received in the OMi Event Browser may contain event-related actions configured in OM. If
event-related actions exist, you can run these actions from theOMi console. OM actions can be
either operator-initiated, or can run automatically when an event occurs. For a complete overview of
available actions and how to run them, seeOMi Help.

Operators working with the OMmessage browser can see additional instructions for the selected
message. It is equally helpful for OMi operators to be able to access this information when using
OM servers to forward events to OMi. This information is displayed in the Instructions tab of the
Event Browser. For details, see theOMi User Guide.

l OM topology > RTSM topology. TheOM topology can synchronize with the OMi RTSM
topology. Using topology synchronization, the OM services are synchronized with OMi, and by
using correspondingmapping rules, they are transformed into CIs stored in the RTSM. For details,
see theOMi Administration Guide.
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Note: If the OM topology is not synchronized with the RTSM topology by using the OMi
topology synchronizationmechanism, theMonitored by property of the OMi CIs
corresponding to the OM services may be empty. As a consequence, these CIs are not
displayed in the SystemMonitors only Perspective, System HardwareMonitoring, and System
SoftwareMonitoring views.
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Chapter 10: Workflow: Configuring Connections
Between Operations Manager i and OM

1. Establish a trust relationship between OMi and OM

For connection and communication betweenOMi andOM hosts, establish a trust relationship
between all the servers.

For task details, see "Establishing a trust relationship for a server connection" on page 62.

To verify the trusted relationship, see "Verifying the trusted relationship" on page 65.

2. Set up the OM server as a connected server

Set up the OM server as a connected server so that you can run actions and tools from OMi, and
retrieve instructions from theOM server.

For task details, see "How to Create a Connection to anOM Server" on page 66.

3. Synchronize the topology

To populate the OMi database (RTSM) with the configuration item (topology) and service data
from OM, youmust synchronize the topology. Topology synchronization is configured to update all
specified servers with the topology and service data from theOM server.

For task details, see "How to Run Topology Synchronization" on page 70.

4. Configure the OM forwarding policy

To enable event synchronization betweenOM andOMi, set up amessage forwarding policy on the
OM server. The policy includes the node name of the target OMi server. Alternatively, specify the
load balancers, if configured, or oneGateway Server for eachOMi installation, as appropriate for
your high-availability arrangement.

o OM for Windows. For task details, see "How to Configure the OM forWindows Forwarding
Policy" on page 76.

o OM for UNIX or Linux. For task details, see "How to Configure the OM for UNIX or Linux
Forwarding Policy" on page 79.
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5. Validate event synchronization

Validate event synchronization and test the connection betweenOM andOMi.

For task details, see "How to Validate Event Synchronization" on page 83.

OMi Integrations Guide
Chapter 10: Workflow: Configuring Connections BetweenOperations Manager i andOM

HPE Operations Manager i (10.60) Page 61 of 272



Chapter 11: Establishing a trust relationship for
a server connection
For connection and communication betweenOMi and OM hosts or other OMi hosts, youmust
establish a trust relationship between the systems.

In OM server pooling, the virtual server must have a certificate that is trusted by all OM hosts in the
server pool and by all OMi hosts.

Note: The trust relationship must be set up on all nodes (data processing servers, gateway
servers, manager-of-manager configurations, load balancers, and reverse proxies). However,
some load balancer technologies include a by-pass or pass-through functionality for incoming
encryptedmessages to its pool members. When using such technologies, the trust relationship on
the load balancer node is not required if you are load balancing on the recommendedOSI layer 2 or
4.

How to establish a trust relationship between the data processing servers and

external server systems)

1. On theOMi data processing server, execute the following command:

BBCTrustServer[.bat|sh] <external_server>

Replace <external_server>with the FQDN of the external system (for example, ommgmtsv).

Note: The value of <external_server> should be the virtual name if the OM server is part of
a server pool or runs in a high-availability (HA) cluster.

When asked if to add a certificate to the trust store, enter y.

If the trusted certificate already exists, the tool asks you if you want to overwrite the existing
certificate. To replace the existing certificate with a new one, enter y.

2. OM servers only:

Note: If you have the appropriate OM patch or version, you can skip this step.

o OM forWindows: Starting with patches OMW_00121 (32-bit) andOMW_00122 (64-bit),
the BBCTrustServer tool is already installed in the %OvInstallDir%\contrib\OVOW
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folder.

o OM for UNIX or Linux: Starting with OM server version 9.10.220, the BBCTrustServer tool
is already installed in the /opt/OV/bin directory.

a. Locate the following files on the OMi data processing server:

<OMi_HOME>/opr/lib/cli/opr-cli.jar

<OMi_HOME>/opr/bin/BBCTrustServer.bat

<OMi_HOME>/opr/bin/BBCTrustServer.sh

b. OM forWindows only: Copy the files to themachine that is running the OM forWindows
management server.

Copy opr-cli.jar to %OvInstallDir%\java\opr-cli.jar.

Copy BBCTrustServer.bat to %OvBinDir%\BBCTrustServer.bat.

c. OM for UNIX and Linux only: Copy the files to themachine that is running the OM for UNIX or
Linux management server.

Copy opr-cli.jar to /opt/OV/java/opr-cli.jar.

Copy BBCTrustServer.sh to /opt/OV/bin/BBCTrustServer.sh.

Change the permissions of the BBCTrustServer tool by entering the following command:

chmod 555 /opt/OV/bin/BBCTrustServer.sh

3. If you do not have a load balancer or a reverse proxy, or your load balancer is configured to work on
OSI layers 2 or 4 (recommended by HPE), execute the following command on the external
system:

BBCTrustServer.[bat|sh] <load_balancer_or_single_gateway_server_or_RP_or_
Server_Pool_Virtual_Interface>

When asked if to add a certificate to the trust store, enter y.

If the trusted certificate already exists, the tool asks you if you want to overwrite the existing
certificate. To replace the existing certificate with a new one, enter y.

4. If you are using a reverse proxy or your load balancer is configured to work onOSI layer 7, you
must exchange the certificates manually:

a. On theOMi data processing server, execute the following command:

ovcert -exporttrusted -file <omi.cer>

b. On the external system, execute the following command:
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ovcert -exporttrusted -file <other.cer>

c. Copy <other.cer> from the external system to the OMi data processing server.

d. Copy <omi.cer> from theOMi data processing server to the external system.

e. On theOMi data processing server, execute the following commands:

ovcert -importtrusted -file <other.cer>

ovcert -importtrusted -file <other.cer> -ovrg server

f. On the external system, execute the following commands:

ovcert -importtrusted -file <omi.cer>

ovcert -importtrusted -file <omi.cer> -ovrg server

5. If you are using a load balancer or a reverse proxy, where your data sources are not
communicating directly with the OMi gateway servers, make sure that port 383 is routed through
the load balancer to the OMi gateway servers.

If the load balancer or the reverse proxy is configured to pass through traffic directly (OSI layers 2
or 4), skip to the next step. If configured to work onOSI layer 7, perform as follows:

o The certificate on the load balancer must be installed for port 383 (or the port that you
configured for secure communication).

o Communication between the load balancer and the gateway server systems must be secured.

o The load balancer must possess a server certificate for authentication so that the external
systems can connect successfully. The load balancer must also validate client certificates
presented by external clients (for example, OM servers).

o The load balancer must possess a client certificate for authentication with OMi.

a. Issue a certificate for the load balancer from theOMi data processing server:

ovcm -issue -file <certificate file> -name <Fully Qualified Domain Name of
Virtual Interface or Reverse Proxy> [ -pass <passphrase>]

b. Import this certificate as a server and client certificate into your load balancer.

For details on the required format, see your load balancer documentation. You can use
openssl to convert the certificates into the required format.

6. Check the connection between the servers. For details, see "Verifying the trusted relationship" on
page 65.
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Chapter 12: Verifying the trusted relationship
After establishing a trust relationship between theOMi Data Processing Server and external systems,
check the connection between the two systems. You can do this while setting up your connected

server by clicking Run Test or by using the command line interface.

How to check the connection between the OMi server environment and an external

system by using the command line interface

1. From the external host, verify that communication to the OMi installation is possible (the return
value should be eServiceOk) by executing the following command on the external server system:

bbcutil -ping https://<load_balancer_or_single_gateway_server_or_RP_or_Server_
Pool_Virtual_Interface>

Example of the command result:

https://<HPE OMi servername>: status=eServiceOK
coreID=7c66bf42-d06b-752e-0e93-e82d1644cef8 bbcV=06.10.105
appN=ovbbccb appV=11.03.031 conn=1 time=1094 ms

2. From all OMi Gateway Server hosts, verify that communication with the external server host is
possible (the return value should be eServiceOk) by executing the following command:

bbcutil -ping https://<external server hostname>

Example of the command result:

https://<external_host_server_name>: status=eServiceOK
coreID=0c43c032-5c94-7535-064a-f7654a86f2d3 bbcV=06.10.070
appN=ovbbccb appV=11.03.031 conn=7 time=140 ms

Troubleshooting

If the bbcutil –ping command executes but does not return eServiceOk, youmay need to restart the
ovc processes on the system that is not responding by running the following commands:

l Linux: /opt/OV/bin/ovc –kill and /opt/OV/bin/ovc –start

l Windows: ovc –kill and ovc –start
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Chapter 13: How to Create a Connection to an
OM Server
OMi can forward events, run actions and tools on the OM server, and retrieve instructions from theOM
server. Credentials for the OMweb service are required for this processing.

1. In the central Connected Servers pane, click New and select Operations Manager for UNIX

orOperations Manager for Windows. Alternatively, you can click New in the Operations

Manager for UNIX or Operations Manager forWindows area in the right pane.

The Create Operations Manager for UNIX Server or Create Operations Manager forWindows
Server panel opens.

2. In the General section, enter a display label, an identifier (a unique internal name if you want to
replace the automatically generated one), and, optionally, a description of the connection being
specified.

3. In the Server Properties section, complete the following information:

a. Enter the fully qualified domain name of the host system of the OM server.

Note: If the host system is a high-availability cluster, enter the fully qualified domain
name of the cluster package where the OM server is installed. If OM is installed in a
server pooling environment, add the virtual interface as the first OM server. Add all
physical pool servers separately as connected servers.

b. Enter the name of the integration user that is used to log in to the OM server.

For OM forWindows servers, specify both the domain to which the host system belongs and
the user name: <DOMAIN>\<user name>. If the host system is not part of a domain, replace
<DOMAIN>with the host name of the system.

HPE recommends to use a dedicated user so that it is clear which events are owned by and
being worked on in OMi.

Note: All messages forwarded from OM systems are treated as allowing read and write.
Any changes made to these events result in back synchronization to the originating OM
server.

l For OM for Windows, the selected user must have at least PowerUser rights and
must be amember of the HP-OVE-Admins group and the local administrators group
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(for example, HP-OVE-User).

l For OM for UNIX or Linux, only the Integration User (opc_adm) has the necessary OM
administrator rights to be able to synchronize topology and execute tools.

c. Select theEnable sending event updates to the Operations Manager for UNIX server or
Enable sending event updates to the Operations Manager for Windows server check
box if you want to forward events and synchronize event updates from this OMi server back to
the Operations Manager server.

d. Optional. Customize the way events and change notifications are delivered to this server by
using Advanced Delivery Options:

l Serial: Events and change notifications are delivered serially in the order in which they
were received.

l Serial per source: Default. Each originating server is provided with a dedicated outgoing
request delivery path. For each individual outgoing request delivery path, events and
change notifications are delivered serially in the order in which they were received. This
can increase the throughput for delivery of events and change notifications whenmany
events are received frommultiple originating servers, while maintaining the incoming
order.

l Parallel: The configured number of outgoing request delivery paths is used when
forwarding events and change notifications. This can further increase the throughput for
delivery of events and change notifications. However, because the source of the event is
not considered, maintenance of the incoming order cannot be guaranteed.

e. Select the Forward dynamic topology check box if you want to forward dynamic topology
information from theOMi instance to which you are logged in, to the OM instance that you are
currently configuring.

Note:  If you change the status of the Forward dynamic topology check box, youmust
restart theWDE process on all gateway servers. To do so, run the following commands:

<OMi_HOME>/opr/support/opr-support-utils.[bat|sh] -stop wde

<OMi_HOME>/opr/support/opr-support-utils.[bat|sh] -start wde

Important: In most cases, you should leave the Forward dynamic topology check box
clear. Otherwise, OMi will resend the topology data received from oneOM server to the
rest of OM servers. This may lead to unexpected consequences onOM servers (for
example, a deleted node on anOM server may reappear after some time, or new nodes
may appear on anOM server after you add a node by using a data collector, such as
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SiteScope).

4. In the Outgoing Connection section, complete the following information:

Note: If you are editing outgoing connection properties, youmust restart the
MercuryAS process for the changes to take effect.

o Select Use this server if you are using this server for receiving instructions, and executing
tools and actions on external nodes, and then follow these steps:

i. Enter the password for the integration user.

ii. Enter the port required to access the server for receiving instructions, and executing tools
and actions. The default port value is automatically inserted and can be restored by
clickingSet default port.

iii. Optional. If you are using secure communication (default), make sure that theUse
secure HTTP check box is selected, and then apply a certificate by clicking import the
certificate and using one of the followingmethods:

l Connect and Import from Server: Retrieves a certificate from the host system
specified in this server connection.

l Import from File: Opens the file browser and enables you to navigate to and specify
a Base64 Encoded X.509 certificate file for the server connection.

Note: In a clustered OM for Windows environment, the IIS web server on all cluster
nodes must have the same certificate. If different, valid certificates are used,
problems such as tools executionmay be experienced after switching to a node with
a different certificate. For more details, see the article available at
https://softwaresupport.hpe.com/km/KM01211399.

Note: Secure communication is necessary for OM server pooling environments.
However, do not use theConnect and Import from Server or Import from File
option.

Set up a trusted relationship between all OM andOMi servers as described in
"Establishing a trust relationship for a server connection" on page 62.

o Select Use other server if you are using an alternative server for providing instructions, and
executing actions and tools, and then select a server from the list. For the physical servers in a
server pooling environment, select the virtual interface connected server.

Note: Avoid selecting an alternative action execution server that creates a loop and
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results in specifying the connected server as the action execution server. Select an
alternative action execution server or use theUse this server option.

5. In the Test Connections section, click Run Test to check that the specified connection
attributes are correct. If an error message is displayed, correct the connection information, and
retest the connection.

6. Make sure that theActivate after save check box is selected if you want to enable the server
connection immediately.

7. Click Create.
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Chapter 14: How to Run Topology
Synchronization
Before configuring the forwarding of topology (node and service) data to OMi from OM servers,
complete the following configuration steps in OMi:

l Establish a trust relationship between the Data Processing Server and theOM server. For details,
see "Establishing a trust relationship for a server connection" on page 62.

l Add theOM server as a connected server to OMi. For details, see "How to Create a Connection to
anOM Server" on page 66.

l Optional. Import content packs. For details, see theOMi Administration Guide.

l Optional. Use the opr-sdtool.[bat|sh] command line tool to upload new or changed
synchronization packages from the file system to the database. For details, see theOMi
Extensibility Guide.

Note: You can also use the Content Manager to import and export the existing synchronization
packages in the Content Manager format.

After ensuring that the OM server is added to OMi as a connected server, configure the forwarding of
topology (node and service) data on the OM server.

The following sections describe how to configure topology synchronization:

l "How to Configure Topology Synchronization onOM forWindows Systems" below

l "How toMigrate from Scheduled Synchronization onOM forWindows Systems" on the next page

l "How to Configure Topology Synchronization onOM for UNIX or Linux Systems" on page 73

l "How toMigrate from Scheduled Synchronization onOM for UNIX or Linux Systems" on page 74

How to Configure Topology Synchronization on OM for Windows Systems

This section describes how to configure topology synchronization onOM forWindows management
servers. For further details, see the OM forWindows documentation.

To forward topology data to OMi, complete the following steps on the OM for Windows
management server from which you want to receive topology information:
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1. Prerequisite.Make sure that theminimum patch level for the OM forWindows management server
is installed:

o Version 8.16: Patch OMW_00121 or superseding patch

o Version 9.00: Patch OMW_00122 or superseding patch

2. Prerequisite. Configure trusted certificates for multiple servers.

In an environment with multiple servers, youmust configure each server to trust certificates that
the other servers issued.

3. In the console tree, right-click Operations Manager, and then click Configure > Server.... The
Server Configuration dialog box opens.

4. Click Namespaces, and then click Discovery Server. A list of values appears.

5. Add the hostname of the server to List of target servers to forward discovery data. If there is
more than one target server, separate the hostnames with semicolons, for example:

server1.example.com;server2.example.com

If the target server uses a port other than port 383, append the port number to the hostname, for
example:

server1.example.com:65530;server2.example.com:65531

6. Make sure that the value of Enable discovery WMI listener is true. This is the default value.

7. Click OK to save your changes and close the Server Configuration dialog box.

8. Restart the OvAutoDiscovery Server service for your changes to take effect:

net stop "OvAutoDiscovery Server"

net start "OvAutoDiscovery Server"

9. Start the initial synchronization of topology data:

a. In the console tree, select Tools > HP Operations Manager Tools.

b. Right-click Synchronize Topology and select All Tasks > Launch Tool....

The startInitialSync.bat tool is started and begins to send all the topology data to the
configured target management servers.

How to Migrate from Scheduled Synchronization on OM for Windows Systems

This section describes how tomigrate from scheduled synchronization onOM forWindows
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management servers. For further details, see the OM forWindows documentation.

To migrate from scheduled synchronization, complete the following steps on the OM for
Windows management server from which you want to receive topology information:

1. Prerequisite.Make sure that theminimum patch level for the OM forWindows management server
is installed:

o Version 8.16: Patch OMW_00121 or superseding patch

o Version 9.00: Patch OMW_00122 or superseding patch

2. Clear the agent repository cache on theOM management server by using the following command:

%OvBinDir%\ovagtrep -clearall

3. Remove the service auto-discovery policies from theOM management server node:

%OvBinDir%\ovpolicy -remove DiscoverOM

%OvBinDir%\ovpolicy -remove DiscoverOMTypes

4. Synchronize the policy inventory on the OM management server:

a. In the console tree, right-click themanagement server.

b. Select All Tasks > Synchronize inventory > Policies.

Themanagement server creates a deployment job to retrieve the inventory from the local
agent.

5. Make sure the listener process is running:

a. In the console tree, right-click Operations Manager, and select Configure Server.

The Server Configuration dialog box opens.

b. Click Namespaces, and select Discovery Server.

A list of values appears.

c. Set the value of Enable discovery WMI listener to true. This is the default value.

d. Click OK to save your changes and close the Server Configuration dialog box.

e. Restart the OvAutoDiscovery Server service for your changes to take effect:

net stop "OvAutoDiscovery Server"

net start "OvAutoDiscovery Server"

6. Start the initial synchronization of topology data:
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a. In the console tree, select Tools > HP Operations Manager Tools.

b. Right-click Synchronize Topology and select All Tasks > Launch Tool....

The startInitialSync.bat tool is started and begins to send all the topology data to the
configured target servers.

How to Configure Topology Synchronization on OM for UNIX or Linux Systems

This section describes how to configure topology synchronization onOM for UNIX or Linux
management servers. For further details, see the OM for UNIX or Linux documentation.

To forward topology data to OMi, complete the following steps on the OM for UNIX or Linux
management server from which you want to receive topology information:

1. Prerequisite.Make sure that theminimum patch level for the OM 9.10 for UNIX or Linux
management server is installed:

o HP-UX: Patch PHSS_42736 or superseding patch

o Linux: Patch OML_00050 or superseding patch

o Solaris: Patch ITOSOL_00772 or superseding patch

2. Prerequisite. Configure trusted certificates for multiple servers.

In an environment with multiple servers, youmust configure each server to trust certificates that
the other servers issued.

3. Prerequisite. Set up the forwarding target (OMi Gateway Server, Reverse Proxy, or Load
Balancer) in the node bank as amanaged node. To do so, run the following command:

/opt/OV/bin/OpC/utils/opcnode -add_node node_name=<node_name> net_type=NETWORK_
IP mach_type=<machine_type> group_name=<group_name> node_label=<node_name>

In this instance, <machine_type> relates to the operating system of the OMi host system, MACH_
BBC_WIN2K3_X64 (Windows) or MACH_BBC_LX26RPM_X64 (Linux), whereas <group_name> relates
to the operating system of the OM server host system, hp_ux, solaris, or linux.

4. Type the following command to enable topology synchronization:

/opt/OV/contrib/OpC/enableToposync.sh -online -target <comma_separated_server_
list>

Replace <comma_separated_server_list>with the fully qualified domain name of the target
management server. If you havemore than one target management server, separate each server
namewith a comma (,). Do not include spaces in the server list.
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This command restarts the service discovery server. The sourcemanagement server begins to
send any topology data changes immediately.

5. Type the following command to start the initial synchronization of topology data:

/opt/OV/bin/OpC/startInitialSync.sh

How to Migrate from Scheduled Synchronization on OM for UNIX or Linux Systems

This section describes how tomigrate from scheduled synchronization onOM for UNIX or Linux
management servers. For further details, see the OM for UNIX or Linux documentation.

To migrate from scheduled synchronization, complete the following steps on the OM for UNIX
or Linux management server from which you want to receive topology information:

1. Prerequisite.Make sure that theminimum patch level for the OM 9.10 for UNIX or Linux
management server is installed:

o HP-UX: Patch PHSS_42736 or superseding patch

o Linux: Patch OML_00050 or superseding patch

o Solaris: Patch ITOSOL_00772 or superseding patch

2. Clear the agent repository cache on themanagement server by using the following command:

/opt/OV/bin/ovagtrep -clearall

3. Remove the service auto-discovery policies from themanagement server node:

/opt/OV/bin/ovpolicy -remove DiscoverOM

/opt/OV/bin/ovpolicy -remove DiscoverOMTypes

4. Deassign the service auto-discovery policies from themanagement server node:

/opt/OV/bin/OpC/utils/opcnode -deassign_pol node_name=<management_server> net_
type=NETWORK_IP pol_name=DiscoverOMTypes pol_type=svcdisc

/opt/OV/bin/OpC/utils/opcnode -deassign_pol node_name=<management_server> net_
type=NETWORK_IP pol_name=DiscoverOM pol_type=svcdisc

/opt/OV/bin/OpC/opcragt -dist <management_server>

Replace <management_server>with the name of themanagement server.

5. Type the following command to enable topology synchronization:

/opt/OV/contrib/OpC/enableToposync.sh -online
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This command restarts the service discovery server. The sourcemanagement server begins to
send any topology data changes immediately.

6. Type the following command to start the initial synchronization of topology data:

/opt/OV/bin/OpC/startInitialSync.sh
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Chapter 15: How to Configure the OM for
Windows Forwarding Policy
To enable event synchronization betweenOM andOMi, set up amessage forwarding policy on the OM
server. The policy includes the node name of the target OMi server. Alternatively, specify the load
balancers, if configured, or oneGateway Server for eachOMi installation, as appropriate for your high-
availability arrangement.

Before setting up a policy and to avoid overwriting the current settings, verify if a policy of the type
Server-based Flexible Management is already active on the OM forWindows server. If a policy does
not exist, create a new policy as described in "Create a New Policy" below. If a policy already exists
and is active, adapt the policy as described in "Adapt an Active Policy" on the next page.

Create a New Policy

To set up a new policy onOM forWindows, complete the following steps:

1. Start the OM forWindows console as follows:

Start > Programs > HP > HP Operations Manager

2. In the left pane of the OM forWindows console, select the following:

Policy management > Policies grouped by type > Server Policies > Server-based Flexible
Management

3. Verify that no Server-based Flexible Management policy exists. If such a policy does exist, go to
"Adapt an Active Policy" on the next page.

4. Right-click Server-based Flexible Management (or a blank space in the right pane), and then
select New > Policy.

The Server-based Flexible Management Editor dialog box opens.

5. In theGeneral tab text pane, insert the following policy text:

TIMETEMPLATES
# none
RESPMGRCONFIGS
   RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
   SECONDARYMANAGERS
   ACTIONALLOWMANAGERS
   MSGTARGETRULES
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      MSGTARGETRULE DESCRIPTION "Forward all messages rule"
         MSGTARGETRULECONDS
         MSGTARGETRULECOND DESCRIPTION "Forward all messages"
         MSGTARGETMANAGERS
            MSGTARGETMANAGER
            TIMETEMPLATE "$OPC_ALWAYS"
            OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"

Note: This forwards all messages to OMi. If you want to reduce the number of messages to
be sent, modify the text of the policy so that only a selected subset of messages is sent to
OMi. For details, see the OM documentation.

6. Replace <OMi fully qualified host name> in the policy text with the fully qualified hostname
of the Gateway server to receive OMmessages (for example, HPEGwSrv.example.com).

In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway server (for example,
VirtualSrv.example.com).

7. Click Check Syntax to check for syntax errors in the new policy text.

8. After correcting any syntax errors, click Save and Close.

9. In the Save As dialog box that opens, enter a name and a description for the new policy.

10. Click OK to close the Save As dialog box.

11. From the Policy Management folder, right-click the policy, and the select All Tasks > Deploy on.

12. In the Deploy server policy on dialog box that opens, select the name of your OMmanagement
server.

13. Click OK to deploy the server-based flexible management policy on the OM forWindows
management server.

Adapt an Active Policy

If a message forwarding policy already exists on the OM forWindows system, complete the following
steps to edit this policy and add another message target manager to it:

1. Start the OM forWindows console as follows:

Start > Programs > HP > HP Operations Manager

2. In the left pane of the OM forWindows console, select the following:
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Policy management > Server policies grouped by type > Server-based Flexible
Management

3. In the right pane of the OM forWindows console, double-click the existing policy that you want to
edit. The Server-based Flexible Management Editor dialog opens.

If such a policy does not exist, go to "Create a New Policy" on page 76.

4. Add another message target manager as shown in the following example policy text:

TIMETEMPLATES
# none
RESPMGRCONFIGS
   RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
   SECONDARYMANAGERS
   ACTIONALLOWMANAGERS
   MSGTARGETRULES
      MSGTARGETRULE DESCRIPTION "Forward all messages rule"
         MSGTARGETRULECONDS
         MSGTARGETRULECOND DESCRIPTION "Forward all messages"
         MSGTARGETMANAGERS
            MSGTARGETMANAGER
            TIMETEMPLATE "$OPC_ALWAYS"
            OPCMGR IP 0.0.0.0 "<First Target Manager>"

            MSGTARGETMANAGER
            TIMETEMPLATE "$OPC_ALWAYS"
            OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"

Note: This forwards all messages to OMi. If you want to reduce the number of messages to
be sent, modify the text of the policy so that only a selected subset of messages is sent to
OMi. For details, see the OM documentation.

5. Replace <OMi fully qualified host name> in the text with the fully qualified hostname of the
Gateway server that should receive OMmessages (for example, HPEGwSrv.example.com).

In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway server (for example,
VirtualSrv.example.com).

6. Click Check Syntax to check for syntax errors in the new policy text.

7. After correcting any syntax errors, click Save and Close.

8. Redeploy the server-based flexible management policy on the OM forWindows management
server.
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Chapter 16: How to Configure the OM for UNIX
or Linux Forwarding Policy
To enable event synchronization betweenOM andOMi, youmust set up amessage forwarding policy
on eachOMmanagement server with the node name of the load balancer, if configured, or one
Gateway Server, as appropriate for your high-availability arrangement.

Before setting up a policy, make sure that the forwarding target is set up as a node (see "Set up a
Forwarding Target in the OM for UNIX or Linux Node Bank" below). In addition, verify if themsgforw
policy is already active on the OM for UNIX or Linux server. If themsgforw does not exist, create a
new policy as described in "Create a New Policy" below. If themsgforw policy already exists and is
active, adapt the policy as described in "Adapt an Active Policy" on page 81.

Set up a Forwarding Target in the OM for UNIX or Linux Node Bank

Note: Make sure that the SNMP agent is running before adding amanaged node to the OM
database.

The forwarding target (OMi Gateway Server, Reverse Proxy, or Load Balancer) must be set up in the
node bank as amanaged node. Youmust add themanaged node by using the opcnode command line
tool:

/opt/OV/bin/OpC/utils/opcnode -add_node node_name=<node_name> net_type=NETWORK_IP
mach_type=<machine_type> group_name=<group_name> node_label=<node_name>

In this instance, <machine_type> relates to the operating system of the OMi host system, MACH_BBC_
WIN2K3_X64 (Windows) or MACH_BBC_LX26RPM_X64 (Linux), whereas <group_name> relates to the
operating system of the OM server host system, hp_ux, solaris, or linux.

To verify that the node was added successfully, run the following command:

/opt/OV/bin/OpC/utils/opcnode -list_nodes

Create a New Policy

To set up a new message forwarding policy onOM for UNIX or Linux, complete the following steps:

1. Change to the work_respmgrs directory as follows:

cd /etc/opt/OV/share/conf/OpC/mgmt_sv/work_respmgrs/
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Note: Policy template files can be found in /etc/opt/OV/share/conf/OpC/mgmt_sv/tmpl_
respmgrs.

2. Create a new policy file by using the following command:

vi <policy file name>

3. Insert the following text into the new policy file:

TIMETEMPLATES
# none
RESPMGRCONFIGS
   RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
   SECONDARYMANAGERS
   ACTIONALLOWMANAGERS
   MSGTARGETRULES

MSGTARGETRULE DESCRIPTION "Forward all messages rule"
         MSGTARGETRULECONDS
         MSGTARGETRULECOND DESCRIPTION "Forward all messages"
         MSGTARGETMANAGERS
            MSGTARGETMANAGER
            TIMETEMPLATE "$OPC_ALWAYS"
            OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"

Note: This forwards all messages to OMi. If you want to reduce the number of messages to
be sent, modify the text of the policy so that only a selected subset of messages is sent to
OMi. For details, see the OM documentation.

4. Replace <OMi fully qualified host name> in the text with the fully qualified hostname of the
Gateway server that should receive OMmessages (for example, HPEGwSrv.example.com).

In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway server (for example,
VirtualSrv.example.com).

5. Enter the following command to check for syntax errors in the new policy text:

/opt/OV/bin/OpC/opcmomchk -msgforw <policy file name>

6. After correcting any syntax errors, copy the policy to themsgforw policy file in the respmgrs
directory as follows:

cp <policy file name> /etc/opt/OV/share/conf/OpC/mgmt_sv/respmgrs/msgforw

7. Inform the server processes to reread the configuration as follows:

/opt/OV/bin/ovconfchg
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Message forwarding from OM toOMi is now configured and enabled.

Adapt an Active Policy

If themessage forwarding policy already exists on the OM for UNIX or Linux system, complete the
following steps to edit this policy and add another message target manager to it:

1. Change to the work_respmgrs directory as follows:

cd /etc/opt/OV/share/conf/OpC/mgmt_sv/work_respmgrs/

Note: Policy template files can be found in /etc/opt/OV/share/conf/OpC/mgmt_sv/tmpl_
respmgrs/.

2. Edit the existing policy to which you want to add theOMi server as a target as follows:

vi <policy file name>

3. Add another message target manager as shown in the following policy text:

# none
RESPMGRCONFIGS
   RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
   SECONDARYMANAGERS
   ACTIONALLOWMANAGERS
   MSGTARGETRULES
      MSGTARGETRULE DESCRIPTION "Forward all messages rule"
         MSGTARGETRULECONDS
         MSGTARGETRULECOND DESCRIPTION "Forward all messages"
         MSGTARGETMANAGERS
            MSGTARGETMANAGER
            TIMETEMPLATE "$OPC_ALWAYS"
            OPCMGR IP 0.0.0.0 "<First Target Manager>"

            MSGTARGETMANAGER
            TIMETEMPLATE "$OPC_ALWAYS"
            OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"

Note: This policy forwards all messages to OMi. If you want to reduce the number of
messages to be sent, modify the text of the policy so that only a selected subset of
messages is sent to OMi. For details, see the OM documentation.

4. Replace <OMi fully qualified host name> in the text with the fully qualified hostname of the
Gateway Server system that should receive OMmessages (for example,
HPEGwSrv.example.com).
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In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway Server system (for example,
VirtualSrv.example.com).

5. Enter the following command to check for syntax errors in the new policy text:

/opt/OV/bin/OpC/opcmomchk -msgforw <policy file name>

6. After correcting any syntax errors, copy the policy to themsgforw policy file in the respmgrs
directory as follows:

cp <policy file name> /etc/opt/OV/share/conf/OpC/mgmt_sv/respmgrs/msgforw

7. Inform the server processes to reread the configuration as follows:

/opt/OV/bin/ovconfchg

Message forwarding from OM toOMi is now configured and enabled.
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Chapter 17: How to Validate Event
Synchronization
This chapter provides you with instructions on how to validate event synchronization and test the
connection betweenOM andOMi.

Note: Make sure that you configured OM to enable OMi users to use tools, actions, and
instruction text. You configure this in the Connected Servers manager in OMi. For details, see
"How to Create a Connection to anOM Server" on page 66.

Verify Message Forwarding from OM to OMi

To check if themessage forwarding policy for sendingmessages from OM toOMi is configured
correctly, follow these steps:

1. Make sure the OMi servers are running.

2. Make sure at least one openmessage interface policy is deployed on your OM system. For
instructions and details, see the OM documentation.

3. On theOM system, open a command or shell prompt and create a new message by executing the
following command:

o Windows:

opcmsg a=App o=Obj msg_text="Hello"

o UNIX or Linux:

/opt/OV/bin/OpC/opcmsg a=App o=Obj msg_text="Hello"

If you configured themessage forwarding policy correctly, themessage arrives at the OM server
and is forwarded to OMi. You can view the events with the OMi Event Browser.

Note: If themessage is sent multiple times, no new message is generated by OM. These
messages are regarded as duplicates and only themessage duplicate count is increased.

To generate a new message, modify themessage text. For example:

o Windows:

opcmsg a=App o=Obj msg_text="Hello_002"
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o UNIX or Linux:

/opt/OV/bin/OpC/opcmsg a=App o=Obj msg_text="Hello_002"

Synchronize OMi Events with OM Messages

To check if a change to an event in OMi that is already synchronized betweenOMi andOM is
resynchronized in OM, change the severity of an event as follows:

1. Make sure the OMi platform is running.

2. Log on to the OMi platform management console.

3. Select Applications > Operations Management.

4. In the Event Browser, select the event for which you want to change the severity. Choose the
event that was already synchronized in OM andOMi and change its severity, for example, from
minor to major.

5. Access the General tab of the Event Details pane.

6. From the Severity drop-down list, choose another severity (for example, major), and then click
Save.

7. In the OM event browser, verify the severity of this event andmake sure it was set to the new
severity value.
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Chapter 18: How to Set up Operations Manager
i in an Environment Managed by OM
To set upOMi in an environment managed by OM, follow these steps:

1. Before installing OMi, run the following command on all data processing servers and gateway
servers:

ovconfchg -ns sec.cm.client -set CERTIFICATE_SERVER <FQDN of primary DPS>

2. Install and configure OMi according to theOMi Installation and UpgradeGuide.

3. Integrate OM as described in "Workflow: Configuring Connections BetweenOperations Manager i
andOM" on page 60.

Optional. How to Set Up Forwarding Targets for
OM Agent Node Creation
To ensure that events are assigned to the correct CIs, the nodes in the OMi RTSM or UCMDB need to
be synchronized with the OM node bank(s). You can use theOM Agent Node Creation Forwarding
Targets infrastructure setting to forward topology data from operations agents monitored by OMi to a
specified OM for Linux orWindows server(s). After the topology information is forwarded from OMi, a
node is created in the OM for Linux orWindows server. The platform of the synchronized node is
displayed as other in OM for Linux and n/a in OM forWindows.

To set up a forwarding target for the creation of an agent node, edit theOM Agent Node Creation
Forwarding Targets infrastructure setting:

1. In OMi, navigate to

Administration > Setup and Maintenance > Infrastructure Settings

2. Select Applications and use the list to select theOperations Management context. Scroll down
toOperations Management - HPOM Topology Synchronization Settings.

3. Next to the OM Agent Node Creation Forwarding Targets setting, click  Edit Item.

4. Enter your target server in theValue field.
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If you want to enter more than one target server, separate them with a semi-colon.

5. Click ok to save.
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Chapter 19: OMi Field Mapping
The following table shows the correspondence between the fields of an OMi event and anOM
message.

OMi Event Attribute
OM Message

OM Message Attribute OM Custom Message
Attribute (CMA)

ID Message ID

Title Message Text

Description Description

Lifecycle State/State
(depending on space)

N/A

Solution Solution

Severity Severity

Priority Priority

Category MessageGroup

Subcategory SubCategory

Type Message Type

Related CI Hint RelatedCiHint
(incoming to OMi)

HPOM Service ID Service Name

Related CI N/A

Node N/A

Node Hint, DNS Name, IP Address,
Core ID

node NodeHint
(incoming to OMi)

Source CI Hint, DNS Name, IP
Address, Core ID

genNode SourceCiHint
(incoming to OMi)

Originating Server origin

Sending Server sender
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OMi Event Attribute
OM Message

OM Message Attribute OM Custom Message
Attribute (CMA)

Assigned User owner

Assigned Group N/A

C (Event Browser)

Because there is a parent event, the
current event will be shown as being a
symptom.

CauseEventId
(synchronized back to
OM)

C (Event Browser)

Because there is at least one child event,
the current event will be shown as being a
cause.

N/A

Custom Attributes CustomMessageAttributes

Time Created CreationTime

Time State Changed N/A

Time Received ReceivedTime

Duplicate Count NumberOfDuplicates

ETI Hint EtiHint
(incoming to OMi)

User Action Operator Initiated Action

Automatic Action Automatic Action

Application Application

Object Object

Key
(only in details)

MessageKey

Close Events with Key Pattern of 1.
MessageKeyRel

Original Data OriginalText

(This field is not displayed, but events that
have this attribute arrive as closed.)

logOnly

Match Information policy, conditionId
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OMi Event Attribute
OM Message

OM Message Attribute OM Custom Message
Attribute (CMA)

(unmatched)

Original ID
(only in details)

origId

Correlation Rule N/A

Source CI N/A

No Duplicate Suppression NoDuplicateSuppression
(incoming to OMi)

Event Type Indicator/ETI N/A

part of CI (after :) SubCiHint
(incoming to OMi)
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Chapter 20: Troubleshooting
This section contains troubleshooting information about OM integration-related issues.

Cleanup after switching OM to another OMi server

After reconnecting OM to another OMi server, for example after activating a disaster recovery
environment, you should delete the bufferedmessages on theOM system for the old OMi server. If the
messages are left in the forwarding buffer, theremay be some performance degradation as the system
regularly tries to deliver them without success. They also consume some disk space. It is not possible
to re-direct thesemessages to the new OMi server, and these cannot be synchronized.

Note: All messages currently in the buffer are deleted. It is not possible to distinguish between
different targets andmessages for other targets are also deleted.

To delete the forwarding buffer files on OM for Windows:

1. Stop the server processes: vpstat -3 -r STOP

2. Delete all files and folders contained within the following directories:

<OvDataDir>\shared\server\datafiles\bbc\snf\data

<OvDataDir>\shared\server\datafiles\bbc\snf\OvEpMessageActionServer

3. Restart the server processes: vpstat -3 -r START

To delete the forwarding buffer files on OM for UNIX:

1. Stop the server processes: ovc -kill

2. Delete all files and folders contained within the following directories:

/var/opt/OV/shared/server/datafiles/bbc/snf/data

/var/opt/OV/share/tmp/OpC/mgmt_sv/snf/opcforwm

3. Restart the server processes: ovc -start

Specifying the URL of a Load Balancer

If the OM server is connected to OMi by using a load balancer, the URL of the load balancer
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(http://<load balancer>:80) must be specified in the infrastructure setting:

Foundation > Platform Administration > Host Configuration > Default Virtual Gateway Server
for Data Collectors URL

Note: If you omit this setting, event synchronizationmight get confused as it is using the wrong
sender hostname (the physical gateway server in place of the virtual system name).
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Chapter 21: Operations Manager i - Service
Manager Integration Overview
This section describes the integration between HPE ServiceManager andOperations Manager i.

If your setup uses an external UCMBD, follow the steps provided in "OMi-SM Integration with
UCMDB" on page 166.

If not, follow the steps provided in "OMi-SM Integration with RTSM" on page 97.

Versions

In general, the information provided in this guide is for integrating OMi with SM 9.4x.

Caution: When integrating OMi with SM 9.40, make sure that one of the following patches are
applied:

l HPSM_00700 - ServiceManager 9.40.2001 p2 - Server for Linux

l HPSM_00701 - ServiceManager 9.40.2001 p2 - Server for Solaris

l HPSM_00702 - ServiceManager 9.40.2001 p2 - Server forWindows

l HPSM_00706 - ServiceManager 9.40.2001 p2 - OMi Integration

Integration Options

OMi-SM Integration Options with RTSM

The following figure shows the options for integrating OMi and SM when using the RTSM. For
detailed information, see "OMi-SM Integration with RTSM" on page 97.
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o CIs synchronization between SM and OMi. To enable operators of all systems to see the
sameCIs, important service, business application, and infrastructure CIs should be synchronized
between all systems. Synchronized CIs are a prerequisite for all other integration features. For
details, see "RTSM-ServiceManager Integration" on page 99.

o Incident forwarding between SM and OMi. OMi enables you to forward events from OMi to
SM. Forwarded events and subsequent event changes are synchronized back from SM toOMi.
You can also drill down from OMi events to SM incidents or from SM incidents to OMi events. For
details, see "Event Forwarding from OMi to SM (RTSM)" on page 109.

o Downtime forwarding from SM to OMi. You can create downtimes (also known as outages) in
OMi based on Requests for Changes in SM. This is done in two steps. First, scheduled downtime
CIs are created in OMi based on RFCs in SM. Then, a BSM downtime CI is created based on the
scheduled downtime. For details, see "Downtime Forwarding from ServiceManager to OMi
(RTSM)" on page 131.

o Downtime notification from OMi to SM. OMi can send downtime start and end events to SM to
notify operators when a downtime occurs. This provides additional information to the SM operator
in case of a downtime that was not driven by an RFC. For details, see "Sending downtime
notifications from OMi to SM (RTSM)" on page 140.

o View planned changes and incident details. This integration enables you to view planned
changes and incident details in the Changes and Incidents and Hierarchy components in OMi. For
details, see "View Changes and Incidents in OMi (RTSM)" on page 141.

o TheBusiness Impact Report integration enables ServiceManager operators to launch an impact
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report from an incident in the context of the incident's affected CI. This opens anOMi KPI over
time page, displaying the affected CI and impacted CIs and services, which allows the operator to
categorize and prioritize the incident accordingly. For details, see "Business Impact Report (BIR)
(RTSM)" on page 148.

OMi-SM Integration Options with UCMDB

The following figure shows the options for integrating OMi and SM when using a UCMDB. For detailed
information, see "OMi-SM Integration with UCMDB" on page 166.

l CIs synchronization between SM and UCMDB. To enable operators of all systems to see the
sameCIs, important service, business application, and infrastructure CIs should be synchronized
between all systems. Synchronized CIs are a prerequisite for all other integration features. With an
external UCMDB, CIs are synchronized from SM to the UCMDB system and vice versa (for
details, see "UCMDB-ServiceManager Integration" on page 169), and from the UCMDB system to
OMi and vice versa (for details, see "OMi-UCMDB Integration" on page 169). In this case, the
UCMDB acts as Global ID generator.

l Incident forwarding between SM and OMi. OMi enables you to forward events from OMi to SM.
Forwarded events and subsequent event changes are synchronized back from SM toOMi. You can
also drill down from OMi events to SM incidents or from SM incidents to OMi events. For details,
see "Event Forwarding from OMi to SM (UCMDB)" on page 179.

l Downtime forwarding from SM to OMi. You can create downtimes (also known as outages) in
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OMi based on Requests for Changes in SM. This is done in two steps. First, scheduled downtime
CIs are created in UCMDB based on RFCs in SM. Then, a BSM downtime CI is created in OMi
based on the scheduled downtime. For details, see "Downtime Forwarding from ServiceManager to
OMi (UCMDB)" on page 201.

l Downtime notification from OMi to SM. OMi can send downtime start and end events to SM to
notify operators when a downtime occurs. This provides additional information to the SM operator in
case of a downtime that was not driven by an RFC. For details, see "Sending downtime
notifications from OMi to SM (UCMDB)" on page 210.

l View planned changes and incident details. This integration enables you to view planned
changes and incident details in the Changes and Incidents and Hierarchy components in OMi. For
details, see "View Changes and Incidents in OMi (UCMDB)" on page 212.

l TheBusiness Impact Report integration enables ServiceManager operators to launch an impact
report from an incident in the context of the incident's affected CI. This opens anOMi KPI over time
page, displaying the affected CI and impacted CIs and services, which allows the operator to
categorize and prioritize the incident accordingly. For details, see "Business Impact Report (BIR)
(UCMDB)" on page 218.
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Chapter 22: OMi-SM Integration with RTSM
This section describes integrating OMi with ServiceManager in the case where the RTSM contained in
OMi is used as CMDB.

This section includes:

l "Data Flow Probe" below

l "Create User Accounts for the OMi-SM Integration (RTSM)" on the next page

l (prerequisite) "RTSM-ServiceManager Integration" on page 99

l "Enable LW-SSO for the OMi-SM Integration (RTSM)" on page 100

l "View Actual State in SM (RTSM)" on page 108

l "Event Forwarding from OMi to SM (RTSM)" on page 109

l "Downtime Forwarding from ServiceManager to OMi (RTSM)" on page 131

l "Sending downtime notifications from OMi to SM (RTSM)" on page 140

l "View Changes and Incidents in OMi (RTSM)" on page 141

l "Business Impact Report (BIR) (RTSM)" on page 148

Data Flow Probe

TheOMi-SM Integration uses a Data Flow Probe to exchange data. This DFP can be installed on one
of the OMi Gateway or Data Processing Server systems or on a separate system. HPE recommends
installing it on anOMi Gateway system as this avoids setting up an additional system.
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The Data Flow Probe is necessary for

l Populating the RTSMwith CIs & Relationships

l Pushing CIs & Relationships to SM

l Federating Incidents and Changes into RTSM

l Populating the RTSMwith downtimes

Create User Accounts for the OMi-SM Integration

(RTSM)

TheOMi-SM integration requires integration accounts to be set up for the two systems to access each
other.

1. In ServiceManager, create an operator record with system administration privileges, and give it a
descriptive name, like OMiSMIntegrUser.

To create a dedicated integration user account in SM:

a. Log on to SM as a system administrator.

b. Type contacts in the SM command line, and press ENTER.

c. Create a new contact record for the integration user account.

OMi Integrations Guide
Chapter 22: OMi-SM Integration with RTSM

HPE Operations Manager i (10.60) Page 98 of 272



i. In the Full Name field, type a full name. For example, RTSM.

ii. In theContact Name field, type a name. For example, RTSM.

iii. Click Add, and thenOK.

d. Type operator in the SM command line, and press ENTER.

e. In the Login Name field, type the user name of an existing system administrator account, and
click Search.

The system administrator account displays.

f. Create a new user account based on the existing one:

i. Change the Login Name to the integration account name you want (for example, rtsm).

ii. Type a Full Name. For example, RTSM.

iii. In theContact ID field, click the Fill button and select the contact record you have just
created.

iv. Click Add.

v. Select theSecurity tab, and change the password.

vi. Click OK.

This is the user account that the OMi server uses to access ServiceManager. It is used to forward
events, push CIs to, and retrieve incidents and RFCs from ServiceManager. Remember the user
name and password you specify here, as the OMi system will need them to access the Service
Manager target server in later steps.

2. On eachOMi server, create a user account with system administration privileges. This account is
used by SM to access the OMi system to retrieve the actual state information of a CI. Give it a
descriptive name, like SMOMiIntegrUser.

Remember the user name and password you specify here, as ServiceManager will need the
accounts to access the OMi server(s) in later steps.

RTSM-Service Manager Integration

Many of the integration features require that Configuration Items (CIs) exist in both ServiceManager
andOMi. To enable operators of both systems to see the sameCIs, they should be synchronized
between the two systems. For details about how to integrate OMi RTSMwith ServiceManager, see
theHPE ServiceManager Universal CMDB Integration Guide. This integration, which synchronizes
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important CIs, such as services, business applications and infrastructure CIs, is a prerequisite for all
other integration features.

Enable LW-SSO for the OMi-SM Integration (RTSM)

Lightweight Single Sign-On (LW-SSO) is optional but recommended for the OMi-SM Integration. You
have different LW-SSO configuration choices depending on your needs. The following describes how
LW-SSO can be used in the OMi-SM workflow.

LW-SSO options for the OMi-SM integration

When OMi creates an incident from an OMi event record

OMi creates an incident from anOMi event record by sending RESTful-based requests to Service
Manager. The incident ID is then stored in the event record.

LW-SSO is NOT needed in this process. A dedicated ServiceManager user account was specified
when configuring the ServiceManager integration in OMi. OMi uses this dedicated user account when
calling the ServiceManager RESTful Web Service to create the incident.

When an OMi user views the incident details

The user can log in to ServiceManager and view the incident details by using the incident ID stored in
the event record.

If the user wants to view the incident details by clicking the incident link from the event record, LW-
SSO can be used; otherwise a ServiceManager login prompt will appear.

LW-SSO is optional for this process. To enable LW-SSO for this process, configure LW-SSO in both
the ServiceManager server andWeb tier (because the server needs to trust theWeb tier), as well as in
OMi.

When Service Manager synchronizes the OMi incident status back to OMi

When a user has updated the OMi incident, ServiceManager calls the OMi server's RESTful Web
Service to update the incident changes to the OMi event record.
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LW-SSO is NOT needed in this process. A dedicated OMi user account was specified when the
Incident Exchange (OMi - SM) integration was set up in SMIS, and ServiceManager uses this user
account when calling the OMi server's RESTful Web Service to synchronize the incident status back
to the OMi event record.

When a user views the event details or the Business Impact Report from an OMi

incident

The user clicks theView OMi Event option or Launch Business Impact Report from the incident to
view the event details or Business Impact Report.

LW-SSO is optional for this process. If you enable LW-SSO in the ServiceManagerWeb tier and in
OMi, the OMi login prompt is bypassed.

Required user permissions

In order to be able to view events, a user needs to be assigned a role with sufficient permission to read
events. Tomanage permissions in OMi, select:

Administration > Users > Users, Groups, and Roles

Select a role or create a new one. In the Permissions section, go to theOperations Console category,
select Events and specify the actions users can perform onEvents assigned to user.

You can optionally grant the permission to view events not assigned to each user.

When CIs are synchronized between OMi/UCMDB and SM

LW-SSO is NOT needed in this process. Dedicated users are specified in the OMi-UCMDB, UCMDB-
SM andOMi-SM integration points.

Configuring LW-SSO for the OMi-SM integration

To use LW-SSO for the SM-OMi integration, LW-SSOmust be enable for both products. In SM, you
must enable LW-SSO in both the SM server and web tier.

Step 1: Configure LW-SSO in the SM server

ServiceManager servers, version 9.30 and later, support Lightweight Single Sign-On (LW-SSO). A
ServiceManager integration can pass an authentication token to ServiceManager and does not require
re-authentication. This simplifies the configuration of Single Sign-On for HPE solutions by removing the

OMi Integrations Guide
Chapter 22: OMi-SM Integration with RTSM

HPE Operations Manager i (10.60) Page 101 of 272



need to use Symphony Adapter (which proxies LW-SSO-based authentication with the Service
Manager Trusted Sign-On solution).

Enabling LW-SSO in the ServiceManager server enables web service integrations from other HPE
products (for example, Release Control) to bypass ServiceManager authentication if the product user
is already authenticated and a proper token is used; enabling LW-SSO in both the ServiceManager
server and web tier enables users to bypass the login prompts when launching the ServiceManager
web client from other HPE applications.

Note: Existing integrations that use the Symphony Adapter and Trusted Sign-On rather than this
new LW-SSOmechanism can continue to work.

To configure LW-SSO in the ServiceManager server:

1. Go to the <ServiceManager server installation path>/RUN folder, and open lwssofmconf.xml
in a text editor.

2. Make sure that the enableLWSSOFramework attribute is set to true (default).

3. Change the domain value example.com to the domain name of your ServiceManager server host.

Note: To use LW-SSO, your ServiceManager web tier and server must be deployed in the
same domain; therefore you should use the same domain name for the web tier and server. If
you fail to do so, users who log in from another application to the web tier can log in but may
be forcibly logged out after a while.

4. Set the initString value. This valueMUST be the samewith the LW-SSO setting of the other
HPE product you want to integrate with ServiceManager.

Note:
l LW-SSO version 2.5 is supported.

l Optionally, you can change attributes paddingModeName, keySize, encodingMode,
engineName, and cipherType. However, youmust make sure that they are samewith the
LW-SSO setting of the other HPE product that you want to integrate with ServiceManager.

l Do not change the other configurations, such as the content in tag <restURLs>, and the
attribute of tag <service>.

Example:

<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config xmlns="http://www.hpe.com/astsecurity/idmenablmentfw/lwsso/2.0">
<enableLWSSO enableLWSSOFramework="true"
enableCookieCreation="true" cookieCreationType="LWSSO" />
<web-service>
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<inbound>
<restURLs>

<url>.*7/ws.*</url>
<url>.*sc62server/ws.*</url>
<url>.*/ui.*</url>

</restURLs>
<service service-type="rest" >
<in-lwsso>

<lwssoValidation>
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher" engineName="AES"
paddingModeName="CBC" keySize="256" encodingMode="Base64Url"
initString="This is a shared secret passphrase"</crypto>

</lwssoValidation>
</in-lwsso>

</service>
</inbound>
<outbound/>

</web-service>
</lwsso-config>

Step 2: Configure LW-SSO in the SM Web Tier

If Lightweight Single Sign-On (LW-SSO) is enabled in the ServiceManagerWeb tier, integrations from
other HPE products will bypass ServiceManager authentication when launching the ServiceManager
Web client, provided that the HPE product user is already authenticated and a proper token is used.

Note:
l To enable users to launch theWeb client from another HPE product by using LW-SSO, you
must also enable LW-SSO in the ServiceManager server.

l Once you have enabled LW-SSO in the web tier, web client users should use the web tier
server's fully-qualified domain name (FQDN) in the login URL:
http://<myWebtierHostName>.<myDomain>:<port>/webtier-x.xx/index.do

The following procedure is provided as an example, assuming that the ServiceManagerWeb tier is
deployed on Tomcat.

To configure LW-SSO in the ServiceManagerWeb tier:

1. Open the <Tomcat>\webapps\< ServiceManager Web tier>\WEB-INF\web.xml file in a text
editor.

2. Modify the web.xml file as follows:
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a. Set the <serverHost> parameter to the fully-qualified domain name of the ServiceManager
server.

Note: This is required to enable LW-SSO from the web tier to the server.

b. Set the <serverPort> parameter to the communications port of the ServiceManager server.

c. Set the secureLogin and sslPort parameters.

l If you do not want to configure TLS between Tomcat and the browser, set
secureLogin to false.

l We recommend that you enable secure login in a production environment. Once
secureLogin is enabled, youmust configure TLS for Tomcat. For details, see the
Apache Tomcat documentation.

d. Change the value of context parameter isCustomAuthenticationUsed to false.

e. Remove the comment tags (<!-- and -->) enclosing the following elements to enable LW-SSO
authentication.

<!--
<filter>
<filter-name>LWSSO</filter-name>
<filter-class>com.hp.sw.bto.ast.security.lwsso.LWSSOFilter</filter-

class>
</filter>
-->

......
<!--
<filter-mapping>
<filter-name>LWSSO</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
-->

f. Save the web.xml file.

3. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEB-
INF\classes\lwssofmconf.xml file in a text editor.

4. Modify the lwssofmconf.xml file as follows:

a. Set the value of enableLWSSOFramework to true (default is false).

b. Set the <domain> parameter to the domain name of the server where you deploy your Service
ManagerWeb tier. For example, if yourWeb tier's fully qualified domain name is
mywebtier.domain.example.com, then the domain portion is domain.example.com.
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Note: To use LW-SSO, your ServiceManager web tier and server must be deployed in
the same domain; therefore you should use the same domain name for the web tier and
server. If you fail to do so, users who log in from another application to the web tier can
log in but may be forcibly logged out after a while.

c. Set the <initString> value to the password used to connect HPE applications through LW-
SSO (minimum length: 12 characters). For example, smintegrationlwsso. Make sure that
other HPE applications (for example, Release Control) connecting to ServiceManager
through LW-SSO share the same password in their LW-SSO configurations.

d. In the <multiDomain> element, set the trusted hosts connecting through LW-SSO. If the
ServiceManager web tier server and other application servers connecting through LW-SSO
are in the same domain, you can ignore the <multiDomain> element ; If the servers are in
multiple domains, for each server, youmust set the correct DNSDomain (domain name),
NetBiosName (server name), IP (IP address), and FQDN (fully-qualified domain name) values.
The following is an example.

<DNSDomain>example.com</DNSDomain>

<NetBiosName>myserver</NetBiosName>

<IP>1.23.456.789</IP>

<FQDN>myserver.example.com</FQDN>

Note: As of version 9.30, ServiceManager uses <multiDomain> instead of
<protectedDomains>, which is used in earlier versions. Themulti-domain functionality is
relevant only for UI LW-SSO (not for web services LW-SSO). This functionality is based
on the HTTP referrer. Therefore, LW-SSO supports links from one application to another
and does not support typing a URL in a browser window, except when both applications
are in the same domain.

e. Check the secureHTTPCookie value (default: true).

l If you set secureHTTPCookie to true (default), youmust also set secureLogin in the
web.xml file to true (default); if you set secureHTTPCookie to false, you can set
secureLogin to either true or false. In a production environment, you are
recommended to set both parameters to true.

l If you do not want to use TLS, set both secureHTTPCookie and secureLogin to
false.

Here is an example of lwssofmconf.xml:
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<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config
xmlns="http://www.hp.com/astsecurity/idmenablmentfw/lwsso/2.0">

<enableLWSSO
enableLWSSOFramework="true"
enableCookieCreation="true"
cookieCreationType="LWSSO"/>

<webui>
<validation>
<in-ui-lwsso>
<lwssoValidation id="ID000001">
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher"
engineName="AES" paddingModeName="CBC" keySize="256"
encodingMode="Base64Url"
initString="This is a shared secret passphrase"/>

</lwssoValidation>
</in-ui-lwsso>

<validationPoint
enabled="false"
refid="ID000001"
authenicationPointServer="http://server1.example.com:8080/bsf"/>

</validation>

<creation>
<lwssoCreationRef useHTTPOnly="true" secureHTTPCookie="true">
<lwssoValidationRef refid="ID000001"/>
<expirationPeriod>50</expirationPeriod>

</lwssoCreationRef>
</creation>

<logoutURLs>
<url>.*/goodbye.jsp.*</url>
<url>.*/cwc/logoutcleanup.jsp.*</url>

</logoutURLs>

<nonsecureURLs>
<url>.*/images/.*</url>
<url>.*/js/.*</url>
<url>.*/css/.*</url>
<url>.*/cwc/tree/.*</url>
<url>.*/sso_timeout.jsp.*</url>

</nonsecureURLs>
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<multiDomain>
<trustedHosts>

<DNSDomain>example.com</DNSDomain>
<DNSDomain>example1.com</DNSDomain>
<NetBiosName>myserver</NetBiosName>
<NetBiosName>myserver1</NetBiosName>
<IP>xxx.xxx.xxx.xxx</IP>
<IP>xxx.xxx.xxx.xxx</IP>
<FQDN>myserver.example.com</FQDN>
<FQDN>myserver1.example1.com</FQDN>

</trustedHosts>
</multiDomain>

</webui>

<lwsso-plugin type="Acegi">
<roleIntegration
rolePrefix="ROLE_"
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>

<groupIntegration
groupPrefix=""
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>

</lwsso-plugin>
</lwsso-config>

f. Save the lwssofmconf.xml file.

5. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEB-
INF\classes\application-context.xml in a text editor.

6. Modify the application-context.xml as follows:

a. Add lwSsoFilter to filterChainProxy:

/**=httpSessionContextIntegrationFilter,
lwSsoFilter,anonymousProcessingFilter

Note: If you need to enable web tier LW-SSO for integrations and also enable trusted
sign-on for your web client users, add lwSsoFilter followed by preAuthenticationFilter, as
shown in the following:
/**=httpSessionContextIntegrationFilter,
lwSsoFilter,preAuthenticationFilter,anonymousProcessingFilter.
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b. Uncomment bean lwSsoFilter:

<bean id="lwSsoFilter"
class="com.hp.ov.sm.client.webtier.lwsso.LwSsoPreAuthenticationFilter">

c. Save the application-context.xml file.

7. Repack the updated ServiceManager web tier files and replace the old web tier .war file
deployed in the <Tomcat>\webapps folder.

8. Restart Tomcat so that the configuration takes effect.

Step 3: Configure LW-SSO in OMi

l In OMi:

a. Navigate to AuthenticationManagement:

Administration > Users > Authentication Management

b. In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor panel.

c. In the Single Sign On Editor panel, select Lightweight.

d. Paste the Token Creation Key (initString) value that you copied above from JMX to get/set
Token Creation Key (initString) to the Token Creation String (initString).

e. Click Save to save your configuration.

For details on configuring LW-SSO, see theOMi Administration Guide.

View Actual State in SM (RTSM)

To display the Actual State information in the SM configuration item form, do the following:

1. Log on to SM as a system administrator.

2. Click System Administration > Base System Configuration > Miscellaneous > System
Information Record.

3. Click theActive Integrations tab.

4. Select theHP Universal CMDB option.

The form displays the UCMDB web service URL field.
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5. In the UCMDB web service URL field, type the URL to the Universal CMDB web service API.
The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

6. Specify the credentials for the user you created in "Create User Accounts for the OMi-SM
Integration (RTSM)" on page 98 to access the OMi server.

7. Click Save. SM displays themessage: Information record updated.

8. Log out of the SM system.

9. To verify that the setup worked, log back into the SM system with an administrator account. The
Actual State section will be available in CI records pushed from OMi.

Event Forwarding from OMi to SM (RTSM)

OMi enables you to forward events from OMi to ServiceManager, which then become incidents in
ServiceManager. Subsequent event/incident changes are synchronized between ServiceManager and
OMi. You can also drill down from OMi events to ServiceManager incidents and vice versa.

Follow the steps below to set up an incident exchange between ServiceManager andOMi.

This section includes:

l "Step 1: Configure the ServiceManager server as a connected server in OMi" below

l "Step 2: (optional) Configure an Event Forwarding Rule " on page 113

l "Step 3: Configure the OMi integration in ServiceManager" on page 114

l "Step 4: Configure Launch of ServiceManager Incident Details from OMi" on page 119

l "(optional) Step 5: Attribute Synchronization" on page 120

l "Step 6: Test the Event Forwarding and Cross Launches" on page 125

l "Advanced Configuration" on page 127

Step 1: Configure the Service Manager server as a

connected server in OMi

To synchronize events and event changes betweenOMi and ServiceManager incidents, configure
ServiceManager as a target connected server in the OMi Connected Servers manager.
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To configure the ServiceManager server as a target connected server, perform the following steps:

1. Navigate to the Connected Servers manager:

Administration > Setup and Maintenance > Connected Servers

2. In the central Connected Servers pane, click New and select External Event Processing.

Alternatively, you can click New in the External Event Processing area in the right pane.

The Create External Event Processing Server panel opens.

3. In the General section, enter a display label (a name for the target ServiceManager server), an
identifier (a unique internal name if you want to replace the automatically generated one), and,
optionally, a description of the connection being specified.

Note: The Identifier field is filled in automatically. For example, if you enter Service
Manager 1 as the display label for the target ServiceManager server, Service_Manager_1 is
automatically inserted in the Identifier field.

Make a note of the name of the new target server (in this example, Service_Manager_1). You
must provide it later as the user namewhen configuring the ServiceManager server to
communicate with the server hosting OMi.

4. In the Server Properties section, complete the following information:

a. Enter the fully qualified domain name of the ServiceManager target server.

b. From the drop-down list, select theService Manager System CI type.

c. Optional. Customize the way events and change notifications are delivered to this server by
using Advanced Delivery Options:

l Serial: Events and change notifications are delivered serially in the order in which they
were received.

l Serial per source: Default. Each originating server is provided with a dedicated outgoing
request delivery path. For each individual outgoing request delivery path, events and
change notifications are delivered serially in the order in which they were received. This
can increase the throughput for delivery of events and change notifications whenmany
events are received frommultiple originating servers, while maintaining the incoming order.

l Parallel: The configured number of outgoing request delivery paths is used when
forwarding events and change notifications. This can further increase the throughput for
delivery of events and change notifications. However, because the source of the event is
not considered, maintenance of the incoming order cannot be guaranteed.

5. In the Integration Type section, complete the following information:
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a. Select Call Script Adapter as the integration type.

b. From the Script name drop-down list, select the ServiceManager Groovy script adapter
sm:ServiceManagerAdapter.

c. Specify amaximum transaction time value (the time limit for the execution of the script). The
default value is 60 seconds.

6. In the Outgoing Connection section, enter the user credentials (user name and password) and the
port number required to access the ServiceManager target server and to forward events to that
server:

a. In the Username field, enter the user name for the integration user you set up in Service
Manager.

b. In the Password field, enter the password for the user you specified. Repeat the password for
verification.

c. In the Port field, specify the port configured on the ServiceManager side for the integration
with OMi.

To find the port number to enter:

l If you are using default ports in ServiceManager, select or clearUse secure HTTP as
appropriate, and then click Set default port. The port is set automatically.

Note: If you do not want to use secure HTTP, make sure that theUse secure HTTP
check box is cleared.

If the Use secure HTTP check box is selected, download and install a copy of the
target server’s TLS certificate by clicking import the certificate, and then clicking the
Connect and Import from Server or Import from File button, if the certificate is
available in a local file.

l If you need to find the port number, access the following file on your ServiceManager
system:

<Service Manager root directory>/HP/Service Manager
<version>/Server/RUN/sm.cfg

In the sm.cfg file, check for the sm -loadBalancer line and add the port entry at the end
of the line. The line looks similar to this:

sm -loadBalancer -httpPort:13080

Enter the appropriate value of the port used by ServiceManager in thePort field of the
Outgoing Connection section.
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d. Select theEnable synchronize and transfer control check box.

If the Enable synchronize and transfer control check box is selected, an OMi operator can
transfer ownership of the event to the target connected server by using the Transfer Control
option in the Event Browser context menu. If it is not selected, the Synchronize and Transfer
Control option is not available from the Event Browser context menu or from the list of
forwarding types for configuring forwarding rules.

7. In the Incoming Connection section, select theAccept event changes from external event
processing server check box, and then enter a password that the ServiceManager server
requires to connect to the server hosting OMi.

Note: Make a note of this password. Youmust provide it later when configuring the Service
Manager server to communicate with the server hosting OMi. This password is associated
with the user name (Service_Manager_1) you configured in ServiceManager.

If Enable synchronize and transfer control was previously selected, theAccept event
changes from external event processing server option is assumed and cannot be
disabled.

8. In the Event Drilldown section, complete the following information:

a. Enter the fully qualified domain name and port of the ServiceManager system into which you
want to perform the incident drill down. The default port value is automatically inserted and
can be restored by clickingSet default port.

Note: To enable incident drill down to ServiceManager, youmust install a web tier client
for your ServiceManager server according to your ServiceManager server installation or
configuration instructions.

In theEvent Drilldown section, configure the server where you installed the web tier
client along with the configured port used.

If you do not specify a server in the Event Drilldown section, it is assumed that the web
tier client is installed on the server used for forwarding events and event changes to SM,
and receiving event changes back from ServiceManager.

If nothing is configured in the Event Drilldown section, and the web tier client is not
installed on the ServiceManager server machine, the web browser will not be able to find
the requested URL.

b. Optional. Select theUse secure HTTP check box for secure communication.

9. In the Test Connection section, click Run Test to check that the specified connection
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attributes are correct. If an error message is displayed, correct the connection information, and
retest the connection.

10. Make sure that theActivate after save check box is selected if you want to enable the server
connection immediately.

11. Click Create. The target ServiceManager server appears in the list of connected servers.

12. If you have SM 9.34 or higher, perform the following additional steps:

a. Reopen the ServiceManager connected server that you configured in the previous steps. To
do so, double-click the connected server entry in the connected servers list.

b. Copy the ID of the connected server and save it. Youmust specify this ID as omi.mgr.id on
the ServiceManager system.

An example of a connected server ID is as follows:

ID: 22f42836-fd36-473e-afc9-a81290f4f73b

Step 2: (optional) Configure an Event Forwarding Rule

Once you have configured the ServiceManager server as a connected server in OMi, you can forward
events manually by using Transfer Control To from the Context Menu. If you want to automatically
forward events, you can configure an Event Forwarding Rule for the OMi server.

1. Open the Event Forwardingmanager:

Administration > Event Processing > Automation > Event Forwarding

2. In theEvent Forwarding Rules pane, click the  New Item button to open theCreate New
Event Forwarding Rules dialog box.

3. Enter a display name, and (optional) a description of the event forwarding rule being specified.

4. Select Active. A rule must be active in order for its status to be available in ServiceManager.

5. Select an event filter for the event forwarding rule from theEvents Filter list. The filter determines
which events to consider for forwarding.

Filters for Event Forwarding Rules can screen events based on the following date-related event
attributes which, for example, help you to ignore outdated events:

o TimeCreated

o TimeReceived
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o Time Lifecycle State Changed

4. If no appropriate filter is already configured, create a new filter as follows:

a. Click the  New Item button to open the Filter Configuration dialog box. You can choose
between New Simple Filter or New Advanced Filter.

b. In theDisplay Name field, enter a name for the new filter, in this example, FilterCritical.

Clear the check boxes for all severity levels except for the severity Critical.

Click OK.

c. You should see your new filter in the Select an Event Filter dialog box (select it, if it is not
already highlighted).

Click OK.

6. Under Target Servers, select the target server you configured in the previous step on connecting
servers. Click theAdd button next to the target servers selection field. You can now see the
connected server's details. In the Forwarding Type field, select theSynchronize and Transfer
Control forwarding type. Although other selections are technically possible, only Synchronize and
Transfer Control is supported by ServiceManager.

Step 3: Configure the OMi integration in Service Manager

ServiceManager can integrate with more than oneOMi server. To configuremore than one server, first
complete "Configure the Instance Count in the ServiceManager-OMi integration template" below
before adding integration instances. To proceed with the default of one server, skip to "Add an SMOMi
integration instance for eachOMi server" on the next page.

Configure the Instance Count in the Service Manager-OMi integration template

To integrate ServiceManager with more than oneOMi server, configure the Instance Count setting in
the SMOMi integration template, as described below.

1. Log on to ServiceManager as a system administrator.

2. Type db in the command line, and press Enter.

3. In the Table field, type SMISRegistry, and click Search.

The SMIS integration template form opens.
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4. Click Search.

A list of SMIS integration templates opens.

5. Select SMOMi from the list.

6. In the Instance Count field, change the value of 1 to the number of OMi servers that you want to
integrate with ServiceManager. For example, if you need twoOMi servers, change the value to 2.

7. Click Save.

Add an SMOMi integration instance for each OMi server

Once you have completed configuration in OMi, you are ready to add and enable a separate integration
instance in ServiceManager for eachOMi server.

To add and enable an Incident Exchange (OMi - SM) integration instance:

1. Log on to ServiceManager as a system administrator.

2. Click Tailoring > Integration Manager.

3. Click Add.

The Integration Template Selection wizard opens.

4. Select SMOMi from the Integration Template list.

Note: Ignore the Import Mapping check box, which has no effect on this integration.

5. Click Next.

6. Complete the integration instance information:

o Modify theName andVersion fields to the exact values you need.

o In the Interval Time (s) field, enter a value. For example: 600. If an OMi opened incident fails
to be synchronized back to OMi, ServiceManager will retry the failed task at the specified
interval (for example, 600 seconds).

o In theMax Retry Times field, enter a value. For example: 10. This is themaximum allowed
number of retries for each failed task.

o (Optional) In theSM Server field, specify a display name for the ServiceManager server host.
For example: my_Local_SM.

o (Optional) In theEndpoint Server field, specify a display name for the OMi server host. For
example: my_OMi_1.
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o (Optional) In the Log File Directory field, specify a directory where log files of the integration
will be stored. This must be a directory that already exists on the ServiceManager server host.

o (Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example:WARNING.

o (Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

7. Click Next. The Integration Instance Parameters page opens.

8. On theGeneral Parameters tab, complete the following fields as necessary:

Field Sample Value Description

omi.server.url http://<servername>:opr-
gateway/rest/synchronization/event/

This is the URL address of the
OMi server's RESTful web
service. Replace
<servername> with the fully
qualified domain name of your
OMi server.

http.conn.timeout 30 The HTTP connection timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds),
and 15 (seconds) is used
if this field is empty.

http.rec.timeout 30 The HTTP receive timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds),
and 15 (seconds) is used
if this field is empty.

http.send.timeout 30 The HTTP send timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds),
and 15 (seconds) is used
if this field is empty.

sm.mgr.id 55436DBE-F81E-4799-BA05-
65DE9404343B

The Universally Unique
Identifier (UUID)
automatically generated for
this instance of Service
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Field Sample Value Description

Manager.
Note: This field is
automatically completed
each time when you add
an SMOMi integration
instance. Do not change
it, otherwise the
integration will not work
properly.

omi.reference.prefix urn:x-hp:2009:opr: The prefix of the BDM
External Process Reference
field, which will be present in
incoming synchronization
requests from theOMi server.

Note: This field is
automatically completed
and has a fixed value. Do
not change it.

sm.reference.prefix urn:x-hp:2009:sm: The prefix of the BDM
External Process Reference
field, which will be present in
outgoing synchronization
requests from Service
Manager.
Note: This field is
automatically completed
and has a fixed value. Do
not change it.

omi.eventdetail.baseurl http://<servername>/opr-
console/opr-evt-details.jsp?eventId=

The basic URL address of the
event detail page in OMi.
Replace <servername> with
the fully qualified domain
name of your OMi server.

9. On theGeneral Parameters andSecure Parameters tabs, enter three parameter values that you
specified when configuring the ServiceManager server as a connected server in OMi. The
following table lists the parameters, whose values you can copy from your OMi server.

To copy the parameter values from OMi, follow these steps:

OMi Integrations Guide
Chapter 22: OMi-SM Integration with RTSM

HPE Operations Manager i (10.60) Page 117 of 272



a. Log in to OMi as a system administrator.

b. Navigate toAdministration > Setup and Maintenance > Connected Servers.

c. Locate your ServiceManager server configuration entry and double-click it.

d. In the General section, copy the ID string into the omi.mgr.id field in ServiceManager.

e. In the Incoming Connection section, copy the User name and Password to the username and
Password fields in ServiceManager, respectively.

Field
Sample
Value Description

omi.mgr.id
(on the
General
Parameters
tab)

f3832ff4-
a6b9-4228-
9fed-
b79105afa3e4

The Universally Unique Identifier (UUID) automatically
generated in OMi for the target ServiceManager server.

Note: This parameter was introduced to support multiple
OMi servers. ServiceManager uses the UUID to identify
from which OMi server an incident was opened. Be aware
that if you delete the connected server configuration for the
ServiceManager server in OMi and then recreate the same
configuration, OMi generates a new UUID. Youmust
reconfigure the integration instance by changing the old
UUID to the new one.

Tip: If you have only oneOMi server, you can simply
remove this parameter (remove both the parameter name
and value) from the integration instance.

username
omi.mgr.id
(on the
General
Parameters
tab)

SM_Server This is the user name that the ServiceManager server uses to
synchronize incident changes back to the OMi server.

Password
(on the
Secure
Parameters
tab)

SM_Server_
Password

This is the password that the ServiceManager server uses to
synchronize incident changes back to the OMi server.

10. Click Next twice, and then click Finish.

Note: Leave the Integration InstanceMapping and Integration Instance Fields settings blank.
This integration does not use these settings.
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ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

11. Enable the integration instance.

12. If you havemultiple OMi servers, repeat the steps above for the rest of your OMi servers.

Step 4: Configure Launch of Service Manager Incident

Details from OMi

If you want to be able to drill down to ServiceManager incidents from theOMi Event Browser, youmust
configure the ServiceManager web tier in the sm:ServiceManagerAdapter script in OMi.

1. Navigate to Connected Servers in OMi:

Administration > Setup and Maintenance > Connected Servers

Click Manage Scripts.

2. Select the sm:ServiceManagerAdapter script, and click theEdit Item button.

3. Click theScript tab and locate the following text in the Groovy script:

private static final String SM_WEB_TIER_NAME = 'webtier-9.30'

4. Change the value of webtier-9.30 to the value required to access the ServiceManager web tier
client.

The drill-downURL is made up like this:

http://<FQDN of Service Manager web tier server>/<web path to Service
Manager>/<URL query parameters>

In this instance, <FQDN of Service Manager web tier server> is the fully qualified DNS
name of the ServiceManager server where the web tier client is installed. This part of the URL is
added automatically (together with http:// or https://) according to the values that you
provided when you configured ServiceManager as a target connected server in the Connected
Servers manager. The address of the Event Drilldown section of the Connected Server makes up
the rest of the URL. For details, see the previous step on connecting servers.

An example of a drill-downURL:
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http://smserver.example.com/SM930/index.do?ctx=docEngine&file=probsummary&query
=number%3D%22IM10216%22&queryHash=bf52f465

In this example, youmust replace webtier-9.30with SM930. All the other parts of the URL are
configured automatically.

5. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version.

For details, see theOMi Administration Guide.

6. If you are using SM 9.34 or lower, set the values of the querysecurity parameter and the
querySecurityWeb parameter from the default values (true) to false in the SM web tier
configuration file web.xml.

For details about the querysecurity parameter and the querySecurityWeb parameter, see
ServiceManager Online Help.

(optional) Step 5: Attribute Synchronization

Attribute Synchronization Using Groovy Scripts

When the SM incident is initially created from anOMi event, event attributes aremapped to the
corresponding SM incident attribute. Out of the box, after the initial incident creation, whenever the
incident or event subsequently changes, only a subset of the changed event and incident attributes are
synchronized. The following describes how to customize the list of attributes to synchronize upon
change. If you want to change the out-of-the-box behavior regarding which attributes are updated, you
can specify this in the Groovy script used on theOMi side for synchronization or incident creation. In
the Groovy script, you can specify which fields are updated in SM, and which fields are updated in OMi.
You can also specify custom attributes in the Groovy script.

Bidirectional Synchronization of Attributes

Individual OMi event attributes can be synchronized from anOMi event to the corresponding SM
incident, whenever the event is changed in OMi. Similarly, individual SM incident attributes can be
synchronized from an SM incident to the corresponding event in OMi, every time the event is changed
in SM. To change the attributes that are synchronized from anOMi event to a corresponding SM
incident, change the attributes included in the SyncOPRPropertiesToSM list in the Groovy script. To
change the attributes that are synchronized from an SM incident to anOMi event, change the attributes
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included in the SyncSMPropertiesToOPR list in the Groovy script. By default, the state, solution, and
cause attributes are synchronized from OMi events to their corresponding SM incidents, and the
incident_status and solution attributes are synchronized from an SM incident to the corresponding
OMi event.

To enable synchronization of all attributes in both directions, you can set the SyncAllProperties
variable to true. In this case, all other variables will be ignored.

Example:

l private static final Set SyncOPRPropertiesToSM = ["state", "solution", "cause"]

l private static final Set SyncSMPropertiesToOPR = ["incident_status", "solution"]

The following table lists the OMi event attributes that can by synchronized with an SM incident, and the
matching SM incident attributes that can be synchronized with anOMi event:

OMi event attribute SM incident attribute

title name

description description

state incident_status

severity urgency

priority priority

solution solution

Unidirectional Synchronization of Attributes

The assigned_user, assigned_group, and cause event properties can be synchronized from anOMi
event to a corresponding SM incident. To synchronize these attributes, add them to the
SyncOPRPropertiesToSM list in the groovy script.

Example:

l private static final Set SyncOPRPropertiesToSM = ["assigned_user", "assigned_
group", "cause"]

Individual OMi event properties can be synchronized to a corresponding SM incident Activity Log.
Updates are not synchronized back from the SM incident Activity Log to the corresponding OMi event.
To change the properties that are synchronized, add the desired properties to the
SyncOPRPropertiesToSMActivityLog list in the Groovy script. By default, the title, description,
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state, severity, priority, annotation, duplicate_count, cause, symptom, assigned_user, and
assigned_group properties are synchronized.

Example:

l private static final Set SyncOPRPropertiesToSMActivityLog = ["title",
"description", "priority"]

The following list includes all properties that can by synchronized from OMi events to the SM incident
Activity Log:

l title

l description

l state

l severity

l priority

l solution

l annotation

l duplicate_count

l assigned_user

l assigned_group

l cause

l symptom

l control_transferred_to

l time_state_changed

Custom Mappings for Custom Attributes

You can define your ownmappings for custom attributes betweenOMi and SM. Thesemapping can be
either unidirectional, if the attributes are only contained in onemap, or bidirectional, if the attributes are
contained in bothmaps. To create custommappings for custom attributes, you can edit the
MapSM2OPRCustomAttribute and MapOPR2SMCustomAttribute lists in the Groovy script. Thesemaps
are empty by default.

Example:
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l private static final Map <String, String> MapSM2OPRCustomAttribute =
[“MySMAttribute” : “MyOMiCustomAttribute”]

l private static final Map <String, String> MapOPR2SMCustomAttribute = [ 
“MyOtherOMiCustomAttribute” : “MyOtherSMAttribute”, “MyThirdOMiCA”, “activity_
log”]

Mapping OPR Lifecycle States to BDM Lifecycle States

Individual OPR event state and SM incident status changes may be selected for synchronization. Out
of the box, only the "closed" state is synchronized in both directions. To change this behavior, add the
desired states to the appropriate list, SyncOPRStatesToSM or SyncSMStatusToOPR.

Examples:

l private static final Set SyncOPRStatesToSM = ["closed", "in_progress",
"resolved"]

l private static final Set SyncSMStatusToOPR = ["closed", "resolved"]

In the example, the OPR event lifecycle states closed, in_progress, and resolved are synchronized
to the SM incident status, and SM incident statuses closed and resolved are synchronized to the
OPR event state.

Note: The special state "*" denotes all states, so to synchronize all OPR event states to the SM
incident status property, specify the following:

private static final Set SyncOPRStatesToSM = ["*"]

Additionally, twomaps are used to specify themapping of the OPR event lifecycle state to the BDM
incident status. Themaps are named MapOPR2SMStatus and MapSM2OPRState. Out of the box, all
possible states have amapping.

Examples:

l private static final Map MapOPR2SMStatus = ["open": "open", "in_progress":
"work-in-progress", "resolved": "resolved", "closed": "closed"]

l private static final Map MapSM2OPRState = ["accepted": "open", "assigned":
"open", "open": "open", "reopened": "open",

"pending-change": "in_progress", "pending-customer": "in_progress", "pending-
other": "in_progress",
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"pending-vendor": "in_progress", "referred": "in_progress", "suspended": "in_
progress",

"work-in-progress": "in_progress", "rejected": "resolved", "replaced-problem":
"resolved",

"resolved": "resolved", "cancelled": "resolved", "closed": "closed"]

Tips for customizing Groovy Scripts

This section provides some tips about customizing Groovy scripts. It contains a few selected
examples of what you can customize. To see further items that can bemodified, see the configuration
section of a Groovy script.

In the configuration section of the Groovy script, you can define andmodify the attributes that are to be
synchronized betweenOMi and SM. The configuration section of the Groovy script also contains the
default valuemappings for lifecycle state, severity, and priority. You can alsomodify these, and it is
possible to define themappings for in-going and out-going requests differently.

More advanced configuration can be done in other parts of the Groovy script if required.

The beginning and the end of the configuration section of the Groovy script is marked as follows:

//

//*BEGIN Configuration: Customization of properties for synchronization*

//

...

...

//

// *END Configuration: Customization of properties for synchronization*

//

Note: Modifications to Groovy scripts are not overwritten by patches and hotfixes. Your
customized version of a script will remain after an update or a patch. If you want to use the newer
version of a script, make a copy of your version, revert back to the predefined version, and then
reapply your changes.

Themapping from OMi to SM is compliant to BDM 1.1 incident web service specifications. The
mapping of the BDM 1.1 incident web service to SM is specified in SM in the BDMMappingManager.
For more information about the BDMMappingManager, see ServiceManager Online Help.
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Avoiding Errors with Large TQL Queries

If the Groovy script executes a TQL query that produces a large number of results, an error message
appears informing you about the TQL query result exceeding the size limit. As a consequence, the
integration event is not sent. It is possible, however, to increase this limit by modifying the value of the
tql.compound.link.max.visited.objects setting.

Note: To check the default value of the tql.compound.link.max.visited.objects setting,
from the JMX console, select UCMDB:service=Settings Services, and then locate the
showSettingsByCategorymethod and enter TQL Settings as the category name.

Tomodify the value of the tql.compound.link.max.visited.objects setting, follow these steps:

1. From the JMX console, select UCMDB:service=Settings Services.

2. Click setSettingValue.

3. Enter tql.compound.link.max.visited.objects as the name of the setting you want to modify
and a new value for it.

Caution: Increasing the value of the tql.compound.link.max.visited.objects setting also
increases the load on the RTSM. Therefore, make sure to carefully consider how much to increase
this value.

Syntax Errors

The ServiceManagerAdapterGroovy script uses the ApacheWink client to communicate with
ServiceManager. It therefore will throw a ClientWebExceptionwhen there is an HTTP error status
returned by ServiceManager.

If you get a syntax error when customizing your Groovy scripts, you will get an event in the event
browser with a detailed description of the error. In addition, youmay view the opr-event-sync-
adapter.log log file for information about how to resolve the error. You can find this log file at the
following location:

<Gateway Server root directory>/log/opr-scripting-host/opr-event-sync-adapter.log

Step 6: Test the Event Forwarding and Cross Launches

To test the event forwarding, forward an event manually to SM and then verify that the event is
forwarded to SM as expected, and that the cross launches work in both directions.
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1. Open anOMi Event Browser.

2. Select an event and select Transfer Control To in the Context Menu. Select the SM target
system.

3. Select the Forwarding tab.

4. In the External Id field, you should see a valid SM incident ID after a few seconds.

5. Verify that the incident appears in the Incident Details in ServiceManager by using the cross
launch (see next step).

If the event drill-down connection is not configured, verify the forwarding by using the following:

a. In the Forwarding tab in the OMi Event Browser, copy or note the incident ID from the External
Id field.

b. In the ServiceManager user interface, navigate to:

Incident Management > Search Incidents

c. Paste or enter the incident ID in the Incident Id field.

d. Click theSearch button. This takes you to the incident in the Incident Details.

6. Test the cross launch from OMi to SM:

Click the hyperlink created with the incident ID. A browser window opens, which takes you
directly to the incident in the Incident Details in ServiceManager.

7. Test the cross launch from SM toOMi:

In the Incident Details in ServiceManager, click More and then select View OMi Event. A
browser window opens, which takes you directly to the event in the Event Browser in OMi.

Note: TheView OMi Event option displays only when the omi.mgr.id parameter in the
corresponding SM-OMi integration instance is set correctly.

8. Close the incident in ServiceManager.

9. Verify that the change in the state of the incident (it is now closed) is synchronized back to OMi.
Youmay not be able to see the event that was closed in SM in the active Event Browser, but it
should now be in the Closed Events Browser.
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Advanced Configuration

Configure forwarding of affected business services from OMi to SM

ServiceManager versions 9.40 and higher support the display of multiple affected business services
associated with an event in OMi. By default, when an event is created in OMi that affects more than
one business service CI, all affected services are automatically forwarded to SM. Themost critical
service is displayed on the "Primary Service" tab in SM, and all other affected services are displayed
on the "Impacted Services" tab.

If you only want to forward themost critical affected service associated with an event from OMi to SM,
you can change the ForwardAllAffectedBusinessServices flag in the sm:ServiceManagerAdapter
script to false.

1. Navigate toConnected Servers in OMi:

Administration > Setup and Maintenance > Connected Servers

Click Manage Scripts.

2. Select the sm:ServiceManagerAdapter script, and click theEdit Item button.

3. Click theScript tab and search for ForwardAllAffectedBusinessServices. Change the value to
false.

4. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version. For details, see theOMi Administration Guide.

Configure automatic closure for OMi incidents in SM

Incidents created from OMi events will be automatically closed when the corresponding OMi event is
closed. You can also configure SM incidents created from OMi events to be automatically closed after
a predefined amount of time since they were last updated (or resolved if they have not been updated
after being resolved).

The workflow is as follows:

1. An incident is opened from OMi.

2. If theSchedule Condition is met, the system creates a schedule record for the incident. The
schedule record will expire at a future time based on theCalc Expression.
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3. A user updates the incident and saves the changes.

4. TheReset alerts if expression on theAlerts tab of the probsummary object definition is
evaluated. If it evaluates to true, the Expiration time of the schedule record is updated based on
the Calc Expression. By default, the expiration time of the schedule record is updated only when
the incident has a category of incident.

5. When the schedule record expires, theAlert Condition is evaluated. If it evaluates to true, the
incident is automatically closed.

To enable automatic closure for OMi incidents:

1. Configure the global settings in the Incident Management Environment record.
a. In SM versions lower than 9.40, click System Administration > Ongoing Maintenance >

Environment Records > Incident Management Environment.

In SM versions 9.40 and higher, click Incident Management > Administration >
Environment.

b. Change the following settings as necessary.

Field Value

Close Incident
Automatically?

This option disables or enables the automatic closure of OMi incidents
at the global level.
l If this option is not selected, no incidents will be automatically
closed.

l If this option is selected, incidents will be automatically closed
under specified conditions.

Default: Not selected

Closure Code This value will be copied to theClosure Code field of incidents when
they are automatically closed.
Default: Automatically Closed

Solution This description will be appended to the end of theSolution field of
incidents when they are automatically closed.
Default: This incident which belongs to OMi has been closed
automatically.

c. Click Save.

d. Restart the ServiceManager server.

Note: If you havemade any changes to any of the configuration options in the Incident
Management Environment record, the ServiceManager server must be restarted for the
changes to take effect.
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2. Configure the alert definition that determines when an incident should be closed.

Note: The alert and problem processes must be running to enable the successful closure of
OMi incidents.

a. Click Tailoring > Document Engine > Alerts.

b. In the Alert Name field, enter: OMI Auto-Close.

c. Click Search. TheOMiAuto-Close alert definition detail form opens.

Caution: These fields in the alert definition are used to control automatic closure of OMi
incidents. You can change the default values of these fields. However, youmust be
aware of the risk that automatic closure of OMi incidents will not work properly if the
Schedule Condition andAlert Condition fields are not configured correctly.

Field Value

Schedule
Condition

This expression is used to determine if an incident should be scheduled for
automatic closure.
Default: jscall("SMOMi.isAutoCloseAndResolved").

An incident is scheduled for automatic closure when the following conditions
aremet.

l TheClose Incident Automatically? option in the Incident Management
Environment record is selected.

l In the incident record, theDo not close this incident automatically
option is not selected.

l The incident has a status of Resolved.

Alert
Condition

This expression is evaluated when an incident is about to be automatically
closed. If it evaluates to true, the incident is closed.
Default: jscall("SMOMi.isAutoCloseEnabled").

An incident is closed when the following conditions aremet.

l TheClose Incident Automatically? option in the Incident Management
Environment record is selected.

l In the incident record, theDo not close this incident automatically
option is not selected.

Calc
Expression

This expression is used to determine how much time will elapse before an
incident is automatically closed.

Default: $L.alert.time=update.time in $L.file+'7 00:00:00'.

The default valuemeans the amount of time elapsed is equal to seven days
since the incident was last updated.
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3. Configure alert information in the probsummary object.
TheOMi autoclose alert definition is configured to only be used by OMi incidents. The closure time
is reset each time the incident is updated. If the closure time is reached without the incident being
updated then ServiceManager will automatically close the incident.

a. Click Tailoring > Document Engine > Objects.

b. In the File name field, enter probsummary and press ENTER. The probsummary object
definition is displayed.

c. Select theAlerts tab.

TheReset alerts if expression is used to reset the automatic closure time of OMi incidents.

Default: category in $L.file="incident" and not null(1 in
external.process.reference in $L.file).

Configure TLS for the Incident Exchange integration

WhenOMi is configured to accept https connections only, youmust configure TLS for the integration. If
you do not do so, changes on an incident that is created from OMi cannot be synchronized back to OMi.

Note: The following steps describe how you do so by using the built-in keytool in Service
Manager, and the file paths are forWindows only. Be sure to change the file paths accordingly if
your ServiceManager system is running on Unix.

To configure TLS for the integration, follow these steps:

1. Import the OMi root certificate to the ServiceManager server trusted keystore.

The following is an example of the command line:

<SM Install path>\server\RUN\jre\bin\keytool -import -alias myCA -file <.pem
file of your BSM root certificate> -keystore <SM Install
path>\Server\RUN\jre\lib\security\cacerts -storepass <changeit>

Note: Where: changeit is the default password of the trusted keystore. Change it to your own
password if you have changed it.

2. Add the following parameters to the ServiceManager server configuration file (<SM install
path>\Server\RUN\sm.ini):

truststoreFile:<SM install path>\Server\RUN\jre\lib\security\cacerts
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truststorePass:<changeit>

3. Restart the ServiceManager Server service.

Downtime Forwarding from Service Manager to OMi

(RTSM)

You can create downtimes (also known as outages) in OMi based on Requests for Changes (RFCs) in
SM. This is done in two steps. First, scheduled downtime CIs are created in OMi based on RFCs in
SM. Then, a BSM downtime CI is created based on the scheduled downtime.

You can also send downtime start and end information from OMi to SM to notify operators of when a
downtime occurs, especially if the downtime was not driven by an RFC in SM. For more information on
this integration, see "Sending downtime notifications from OMi to SM (RTSM)" on page 140

Notes:

1. For Changes/Tasks that have final approval phases defined in ServiceManager Integration
Suite (SMIS), the downtimes will be synchronized after the Changes/Tasks get final
approval.

2. Only downtimes that end at a future time will be synchronized.

3. Select theConfiguration Item(s) Down checkbox when scheduling downtimes in
Changes/Tasks.

4. The SLA scheduler needs to be started in theSystem Status form.

Step 1: Add an SMBSM_DOWNTIME integration instance

in SM

To set up the integration from ServiceManager to OMi, youmust add an instance of this integration in
the ServiceManager Integration Suite (SMIS). Note that additional setup is required on theOMi side for
integration from OMi to ServiceManager.

To add the SMBSM_DOWNTIME instance:
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1. Click Tailoring > Integration Manager. Integration InstanceManager opens.

2. Click Add. The Integration Template Selection wizard opens.

3. Select SMBSM_DOWNTIME from the Integration Template list. Ignore the Import Mapping
check box, which has no effect on this integration.

4. Click Next. The Integration Instance Information page opens.

5. Do the following:

o Modify theName andVersion fields to the exact values you need.

o In the Interval Time(s) field, enter a value based on your business needs in regard to downtime
exchange frequency. Note that a short interval time can be safe because the next scheduled
task will not start until the previous task is completed and the interval time passed.

o In theMax Retry Times field, enter a value. This is themaximum allowed number of retries (for
example, 10) for each failed task.

o In the Log File Directory field, specify a directory where log files of the integration will be
stored. This must be a directory that already exists on the ServiceManager server. By default,
loggingmessage is output to sm.log.

o (Optional) In theSM Server field, specify a display name for the ServiceManager server host.
For example: my_local_SM.

o (Optional) In theEndpoint Server field, specify a display name for the OMi server host. For
example: my_BSM_1.

o (Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example: WARNING.

o (Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

6. Click Next. The Integration Instance Parameters page opens.

7. On theGeneral Parameters tab, complete the following fields as necessary:

Name Category Value Description

WithdrawDowntime General true/false Set this value to true: When authorized users
aremanually changing the phase of a change
record which has 'valid' outage, a window will
open and provide choices of withdrawing the
outage.

Set this value to false: The pop-up window is
disabled. This operationmay cause some
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Name Category Value Description

unapproved planned downtimes be
synchronized to OMi.

By default, this value is set to true.

Category or
workflow (Process
Designer) name of
changes

Change The final
approval
phase for
changes

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

Category or
workflow (Process
Designer) name of
tasks

Task The final
approval
phase for
tasks

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

sm.host General <sm server
name >

Set the ServiceManager server host name or
DNS name to compose the External Process
Reference and the Reference Number of
Scheduled Downtime CI in UCMDB.

Note:Do not include a colon in this field.
Otherwise, the logic will be broken.

sm.reference.prefix General urn:x-
hp:2009:sm

Set the prefix to compose the External
Process Reference of Scheduled Downtime
CI in UCMDB.

Note: This field has a fixed value. Do not
change it.

Notes:

a. Type category or workflow name of change/task in theName column. This value is case-
sensitive and it must match the record in ServiceManager database.

b. Set the value to Change for changes in theCategory column. Similarly, set the value to
Task for tasks.

c. Type the final approval phase in theValue column. This value is case-sensitive and it
must match the record in ServiceManager database. You can separatemultiple phases
by semicolons, whichmust be the English character.

d. Detailed information will be displayed in the integration log when the following errors
occur:
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l User input of categories/phases for the changes/tasks is not correct.

l The category and phase pair does not exist in the database.

e. For ChangeManagement categories which do not have approval phase, the downtime
integration will treat its downtime information as final approved once created. You do not
need to define any phases in SMIS parameters.

f. For the category or workflow name of the changes and the tasks, the integration will
ignore all the final phases defined for the redundant category or workflow.

8. Click Next twice and then click Finish. Leave the Integration InstanceMapping and Integration
Instance Fields settings blank. This integration does not use these settings.

ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

9. Enable the integration instance. SMIS will validate all the final phases you filled in the Integration
Instance Parameters page and print warningmessages if there are errors.

Step 2: Tailor Service Manager to handle phase change

In the ServiceManager ChangeManagement module, authorized users canmanually change the
phase of a change record. If the phase is changed to the one prior to the final approval phase in the
SMBSM_DOWNTIME instance, the system will check if there are existing planned downtimes that
have been set to Ready. If such downtimes exist, a window will open and provide two options for the
corresponding planned downtimes:

l Click Yes to withdraw the corresponding planned downtimes from the RTSM. The changes or tasks
need to be approved again to synchronize with the RTSM at another time.

l Click No. There will be no change to the planned downtimes even if the actual status of the
changes or tasks are not approved.

Note: To disable the pop-up window when withdrawing the planned downtimes, youmust set the
WithdrawDowntime parameter to false in the SMBSM_DOWNTIME instance. This operation
may cause some unapproved planned downtimes to be synchronized to OMi.

With Process Designer (PD) Content Pack 2 applied in ServiceManager, you can tailor the process to
transit changes or tasks from one phase that is after the final approval phase in the SMBSM_
DOWNTIME instance to another that is prior to the final approval phase. To withdraw the related
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planned downtime for this kind of transition, youmust add a rule set for the transition in the Closed Loop
Incident Process (CLIP) solution. Follow these steps:

1. Go to the target workflow that needs tailoring.

2. Select the transition that moves a phase from before the final approval phase to after the final
approval phase.

3. In the Rule Sets section, click Add and select the clip.downtime.withdraw rule set.

4. Click OK to save the workflow.

Step 3: Set up downtime sync jobs in OMi

As part of CI synchronization, you have already set up an integration point between SM andOMi. In
this step, you add downtime synchronization jobs, so that scheduled downtime CIs are created in OMi
based on Requests for Change in SM.

To add the downtime synchronization jobs:

1. Log in to your OMi system as an administrator.

2. Edit the existing integration point that connects to your ServiceManager server.

3. Click Administration > RTSM Administration> Data Flow Management > Integration
Studio. OMi displays a list of integration points.

4. Select the existing SM integration point. Make sure that CIs have already been synchronized
between SM andOMi.

5. Create two integration jobs in the integration point on thePopulation tab:

a. Create a new job including the SM CLIP Down Time Population job definition. Under
Scheduler Definition, select theScheduler enabled checkbox and set the Repeat Interval
to 1Minute. Click OK to save the job.

b. Create another new job including the SM CI Connection Downtime CI job definition. Under
Scheduler Definition, select theScheduler enabled checkbox and set the Repeat Interval
to 1Minute. Click OK to save the job.

Pay attention to the running order. The CLIP Down Time Population jobmust be run first. You
can set the two jobs as schedule-based and set the schedule interval according to your needs.

Note: If no related CIs exist in RTSMwhen creating relationships, the population will fail or
succeed with a warning. To disable the warning, remove the downtime CI that does not have
related CIs in RTSM.

OMi Integrations Guide
Chapter 22: OMi-SM Integration with RTSM

HPE Operations Manager i (10.60) Page 135 of 272



Step 4: Set up creation of BSM Downtime CIs

In this step, BSM Downtime CIs are created based on Scheduled Downtime CIs.

Important: 

l Following the initial integration, a large amount of datamay be communicated from SM toOMi. It is
highly recommended that you perform this procedure during off-hours, to prevent negative impact on
system performance.

To create BSM Downtime CIs:

1. Create a new Integration Point or, if existing, edit theSM Scheduled Downtime Integration Into
BSM Integration Point:

a. Do the following on your OMi system.

Go to:

Administration > RTSM Administration > Data Flow Management > Integration Studio

b. Click New Integration Point orEdit, enter a name and description of your choice, and select
the adapterSM Scheduled Downtime Integration Into BSM from the ServiceManager
folder.

If you have upgraded from an older version of OMi to OMi 10.10, youmay still see the old
"BSM Downtime Adapter", or youmay see the "SM Scheduled Downtime Integration Into
BSM" adapter in the Third Party Products folder (not in the ServiceManager folder). In this
case, youmust upgrade your adapter by doing the following:

i. Open the PackageManager.

ii. Deploy the package: /opt/hp/BSM/odb/conf/factory_
packages/BSMDowntimeAdapter.zip on the data processing server.

iii. You should now find theSM Scheduled Downtime Integration Into BSM adapter in
the ServiceManager folder.

c. Enter the following information for the adapter: OMi GW or Load Balancer/Reverse Proxy
FDQN and port (80/443), communication protocol (http/https), and the context root (if you
have a non-default context root).

d. Specify the credentials for the OMi system. The specified user must have administrative
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rights in the RTSM. Choose generic protocol as protocol.

e. Click OK, then click theSave button above the list of the integration points.

2. You can use theStatistics tab in the lower pane to track the number of downtimes that are created
or updated. By default, the integration job runs every minute. If a job has failed, you can open the
Query Status tab and double-click the failed job to seemore details on the error.

If there is an authentication error, verify the OMi credentials entered for the integration point.

If you receive an unclear error message with error code, this generally indicates a communication
problem. Check the communication with OMi.

A failed job will be repeated until the problem is fixed.

Step 5: Verify the SM-OMi downtime synchronization

setup

When you have set up the Downtime integration, you can perform the following tasks to see if you have
successfully set up your downtime synchronization.

Task 1. Open a new change of a category that has the

final approval phase defined in SMIS

1. Click Change Management > Create New Change.

2. Select Hardware for example.

3. In the Affected CI field, choose a CI that has been synchronized. For example: adv-afr-desk-
101.

4. Set Scheduled Downtime Start and Scheduled Downtime End to a future time.

5. Select theConfiguration Item(s) Down checkbox.

6. Set other required fields.

7. Click Validation Accepted. If you are prompted to fill in more required fields, supply the required
information and click Validation Accepted again.

8. Click Request Authorization.

9. Click Save&Exit the change.
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Task 2. Approve the change at the final approval phase

1. Click Change Management > Task Queue.

2. Search for the task that was created in Task 1 and click Close to close the task.

3. Click Change Management > Search Change and search for the change opened in Task 1.

4. Move the Change to the Change Approval phase by selectingRequest Authorization.

5. Log on to ServiceManager with user account Change.Approver.

6. Select Approval Inbox and search for the change created in Task 1.

7. Approve the change.

Task 3. Create new format for the intClipDownTime table

1. Open the SM Windows client.

Note: This step can only be performed in the SM Windows client.

2. Enter fd into the search field to open the Forms Designer and click New.

3. Create a new format for the intClipDownTime table by using the FormWizard.

4. Add all fields to this format.

Task 4. Check the corresponding intClipDownTime

record

1. From DatabaseManager, open the format of the intClipDownTime table.

2. Click Search to see the record created for this downtime.

3. Check the External Status field:

External Status values Description

NULL The downtime is waiting for final approval, or the scheduler has not
proceeded this record yet.
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External Status values Description

0 (Canceled) The downtime is canceled before being implemented.

1 (Ready) The downtime has been approved and is ready to be synchronized to
UCMDB or BSM (RTSM).

2 (Withdrawn) The downtime is approved firstly and then the approval is retracted
(withdrawn).

Notes:

a. Only downtime records with External Status 1 can be synchronized.

b. If the External Status is not 1, wait some time for background schedulers SLA and
SMBSM_DOWNTIME to process this record.

Task 5. Populate downtime from Service Manager to

UCMDB

1. From UCMDB, run the CLIP Down Time Population job and the CI To Down Time CI With
Connection job in a fixed order.

2. Search for the adv-afr-desk-101CI in UCMDB. Check that a corresponding Scheduled
Downtime CI is created, and a relationship between the Scheduled Downtime CI and the affected
CI is created.

Task 6. Test if BSM Downtime CIs have been created

1. In OMi, go toAdministration > Service Health > Downtime Management.

2. Check if a corresponding Downtime was created.
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Sending downtime notifications from OMi to SM

(RTSM)

OMi can send downtime start and end events to SM to notify operators of when a downtime occurs.
This provides additional information to the SM operator in case of a downtime that was not driven by an
RFC.

To create downtimes in OMi based on RFCs in SM, see "Downtime Forwarding from ServiceManager
to OMi (RTSM)" on page 131.

Step 1: Send OMi Downtime Events to SM

To enable OMi to send downtime start and end events to SM, follow these steps:

1. Access the following location in OMi:

Administration > Setup and Maintenance > Infrastructure Settings > Foundations >
Downtime

2. Change the value of theDowntime Send Event parameter to true.

3. Restart your OMi services on all Gateway Servers and Data Processing Servers.

This procedure generates events in OMi. After performing it, make sure you edit and enable the
Automatically forward "downtime started" and "downtime ended" events to Trouble Ticket
System event forwarding rule to forward downtime-start and downtime-end events to the SM server
that should be specified in the alias connected server called "Trouble Ticket System". For details on
event forwarding and connected servers, see theOMi Administration Guide.

Downtime events use the following formats:

l Downtime Start

Event field OMi Downtime

Severity Normal

Category Downtime Notification

Title Downtime for <CI Type><Affected CI Name>started at <Downtime Start Time>
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Event field OMi Downtime

Key <OMi Downtime ID>:<Affected CI ID>:downtime-start

SubmitCloseKey False

OutageStartTime <Downtime Start Time>

OutageEndTime <Downtime End Time>

CiName <Affected CI Name>

CiId <Affected CI Global ID>

CiHint GUCMDB:<Affected CI Global ID>|UCMDB:<Affected CI ID>

HostHint GUCMDB:<Related Host Global ID>|UCMDB:<Related Host ID>

EtiHint downtime:start

l Downtime End

Event field OMi Downtime

Severity Normal

Category Downtime Notification

Title Downtime for <CI Type><Affected CI Name> ended at < Downtime End Time>

Key <OMi Downtime ID>:<Affected CI ID>:downtime-stop

SubmitCloseKey true

CloseKeyPattern <OMi Downtime ID>:<Affected CI ID>:downtime-start

EtiHint downtime:end

LogOnly true

View Changes and Incidents in OMi (RTSM)

This integration enables you to view planned changes and incident details in the Changes and Incidents
and Hierarchy components in OMi.

This chapter includes the following:
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l "Prerequisite" below

l "Step 1: Configure the ServiceManager Adapter Time Zone" below

l "Step 2: Create an Integration Point in OMi" on the next page

l "Step 3: Edit Integration TQLs " on page 144

l "Step 4: Verify View changes and incidents" on page 145

l "How to Customize the Changes and Incidents Component" on page 145

Prerequisite

This integration requires that CIs are synchronized between the RTSM and SM. For information on CI
synchronization, see "Operations Manager i - ServiceManager Integration Overview" on page 93.

This integration requires an administrator user account for OMi to connect to SM. This user account
must already exist in both OMi and SM. For details on creating required user accounts, see "Create
User Accounts for the OMi-SM Integration (RTSM)" on page 98

Step 1: Configure the Service Manager Adapter Time

Zone

Configure the time zone so Incidents and Planned Changes have the correct time definitions:

1. In SM, select Navigation pane > Menu navigation > System Administration > Base System
Configuration > Miscellaneous > System Information Record. Open theData Info tab.

2. In theDate Info tab, look up the value for the Time Zone.

3. In OMi, select Administration > RTSM Administration > Data Flow Management > Adapter
Management.

4. In theResourceswindow, openServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/serviceDeskConfiguration.xml

Find the row that includes the following string:

<globalConnectorConfig><![CDATA[<global_configuration><date_pattern>MM/dd/yy
HH:mm:ss</date_pattern><time_zone>US/MOUNTAIN</time_zone>
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Check the date and time format, as well as a time zone. Note that the date is case-sensitive.
Change either SM or the xml file so that they bothmatch each other's settings.

Note: Specify a time zone from the Java time zone list that matches the time zone used in
SM (for example, America/New York).

5. If you changed the time zone on SM, restart the SM server; if you changed the time zone onOMi,
you do not need to restart the OMi server.)

Step 2: Create an Integration Point in OMi

To create an integration point, follow these steps:

1. In OMi, select Administration > RTSM Administration > Data Flow Management >
Integration Studio.

2. In the Integration Point pane, select Create New Integration Point or choose an existing
integration point to edit. The Create New Integration Point dialog box opens. Enter the following:

Name
Recommended
Value Description

Integration Name SM Integration The name you give to the integration point.

Adapter <user defined> Select Software Products > ServiceManager >
Service Manager 9.xx.

This adapter, which supports CI/ relationship
Data Push from RTSM to ServiceManager, and
Population and Federation from Service
Manager to RTSM.

Is Integration Activated selected Select this check box to create an active
integration point.

Hostname/IP <user defined> The name of the SM server.

Port <user defined> The port through which you access SM.

Credentials ID <user defined> Click Generic Protocol, click theAdd button
to add the integration user account you created
in "Create User Accounts for the OMi-SM
Integration (RTSM)" on page 98 and then select
it.
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Name
Recommended
Value Description

Probe Name (for
ServiceManagerAdapter9-
x only)

<user defined> Select the probe that you installed for this
integration.

Note: It is recommended to click the Test Connection button to verify that the details
entered are working before continuing.

3. In the Integration Point pane, click the Integration Point you just created, and click the
Federation tab in the right pane.

4. In theSupported and Selected CI Types area, verify that Incident andRequestForChange are
selected.

Step 3: Edit Integration TQLs

In this step, edit the integration TQLs so that they use the Integration Point created in the previous step.

1. In OMi, select Administration > RTSM Administration > Modeling > Modeling Studio.

2. On theResources tab, select Resource Type: Queries. Open theConsole folder.

3. Open the TQL: CollectRequestForChangeWithImpacts.

4. In theQuery Definition pane, right click one of the objects of CI Type: RequestForChange.

5. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.

6. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.

7. Open the TQL: CollectRequestForChangeWithoutImpacts.

8. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.

9. Open the TQL: CollectTicketsWithImpacts.

10. In theQuery Definition pane, right click one of the objects of CI Type: Incident.

11. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.

12. Repeat steps 10 and 11 for all objects of CI Type: Incident.

13. Open the TQL: CollectTicketsWithoutImpacts.
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14. Repeat steps 10 and 11 for all objects of CI Type: Incident.

15. Save all TQLs.

Step 4: Verify View changes and incidents

To verify that you can view changes and incidents in OMi, make sure that you have an incident in SM
that is related to a CI in the OMi RTSM. To do so, send a test event related to a CI that has been
synchronized betweenOMi and SM.

1. Send an event, for example, by using the following command:

submitEvent -t testViewIncidents -rch <hintForExistingCI>

2. Select the event in the OMi Event Browser and select Transfer Control To in the Context Menu.
Select the SM target system.

3. Open the 360° View and select a view containing the related CI.

4. Select the CI, and verify that the Incident Count is at least 1. Click Incidents to show the
Changes in Incidents window, and verify that the incident is displayed in the Incidents section.

By default, the Changes and Incidents component displays data for the previous week. You can
change this setting to previous week, day, or hour (up to the current time) by using the Configure
Component button.

How to Customize the Changes and Incidents Component

By default, incidents and requests for change are displayed for the following CI types: Business
Service, Siebel Application, Business Application, and Node. If you want to view change and incident
information for other CITs, perform the following procedure:

1. Open theModeling Studio:

Administration > RTSM Administration > Modeling > Modeling Studio

Copy one of the TQLs within theConsole folder, and save your copy with a new name. These
default TQLs perform the following:
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TQL name Description

CollectTicketsWithImpacts Retrieves SM incidents for the selected CI, and
for its child CIs which have an Impact
relationship.

CollectTicketsWithoutImpacts Retrieves SM incidents for the selected CI.

CollectRequestForChangeWithImpacts Retrieves SM requests for change, for the
selected CI, and for its child CIs which have an
Impact relationship.

CollectRequestForChangeWithoutImpacts Retrieves SM requests for change, for the
selected CI.

2. Edit the new TQL as needed. You can add CITs as described in "Naming Constraints for New
Request for Change TQLs" below.

3. Open Infrastructure Settings:

Administration > Setup and Maintenance > Infrastructure Settings

a. Select Applications.

b. Select Service Health Application.

c. In theService Health Application - Hierarchy (360) properties area, enter the name of the
new TQL you created in the corresponding infrastructure setting.

Note: By default, these infrastructure settings contain the default TQL names. If you enter a
TQL name that does not exist, the default value will be used instead.

After youmodify the infrastructure setting, the new TQL will be used, and the Changes and Incidents
component will show this information for the CITs you defined.

Naming Constraints for New Request for Change TQLs

The following naming constraints must be followed in the request for changewithout impact TQL (see
the TQL example below, on the right side of the image):

l The request for change CI typemust start with directPlannedChange.

l The CI type related to the request for changemust start with trigger.

The following naming constraints must be followed in the request for changewith impact TQL (see the
TQL example below, on the left side of the image):
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l impacterPlannedChange represents the request for change CI type.

l The CI type related to the request for changemust start with impacter.

l triggerITUniverse represents the "impacted" child CIs.

Examples of request for change TQLs:

Naming Constraints for New Incident TQLs

The following naming constraints must be followed in the incidents without impact TQL (see the TQL
example below, on the right side of the image):

l The incident CI typemust start with directITIncident.

l The CI type related to the incident must start with trigger.

The following naming constraints must be followed in the incidents with impact TQL (see the TQL
example below, on the left side of the image):

l impacterITIncident represents the incident CI type.

l The CI type related to the incident must start with impacter.

l triggerITUniverse represents the "impacted" child CIs.
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Examples of incident TQLs:

Business Impact Report (BIR) (RTSM)

OMi includes a report that you can use to help evaluate the impact of incidents on your business. For
example, if a host CI has critical status, you can use the report to display the status of the Business
Service CIs to which the host CI is attached.

Incident Management users can launch an impact report from an incident in context with the incident's
affected configuration item (CI). Service Desk Agents can validate the updated status of the business
impact to categorize and prioritize the incident accordingly.

Note:
l This integration requires that CIs are synchronized between both ServiceManager andOMi.

l Only one instance of this integration is allowed.

Step 1: Add a Business Impact Report Integration in SM

To use the ServiceManager to BIR integration, youmust add and enable an instance of this integration
in IntegrationManager.

To add and enable a ServiceManager to BIR integration instance:
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1. Click Tailoring > Integration Manager. Integration InstanceManager opens.

2. Click Add. The Integration Template Selection wizard opens.

3. Select SMBIR from the Integration Template list. Ignore the Import Mapping check box, which
has no effect on this integration.

Note: Only one instance of this integration is allowed. If an instance of this integration
already exists in IntegrationManager, theSMBIR template is unavailable. You have to delete
the existing integration instance before you can add a new one.

4. Click Next. The Integration Instance Information page opens.

5. Update the following fields:

Note: Only Name andVersion are required fields. This integration does not use the Interval
Time (s) andMax Retry Times fields as it is UI-based.

Field Value

Name (Required) The name of the integration instance.

Default: SMBIR

Version (Required) The version of the integration template.

Default: 1.0

SM Server The name of the ServiceManager server machine.

Endpoint
Server

The name of the OMi Server machine.

Log Level Select one from: DEBUG, INFO (default), WARNING, ERROR, andOFF.

Log File
Directory

A directory on the ServiceManager Server machine in which log files will be
stored.

Description If you want, modify the default description of the instance.

Run at
system
startup

Select this check box only if you want this instance to be automatically enabled
when the ServiceManager Server is started.

6. Click Next. The Integration Instance Parameters page opens.

7. On theGeneral Parameters tab, replace "BSM_host" in the baseurl parameter with the
hostname of the real OMi server.

8. Click Next twice and then click Finish. Leave the Integration InstanceMapping and Integration
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Instance Fields settings blank. This integration does not use these settings.

ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

9. Enable the integration instance.

Step 2: Launch a Business Impact Report from an

Incident

To launch a Business Impact Report from an incident:

1. Log on to the ServiceManagerWeb client.

2. From Incident Management, search for an incident record and open it.

3. Click More and then select Launch Business Impact Report. TheOMi Business Impact
window opens, showing the KPI over time data for the related CI and related business services.

Customizing the Service Manager Integration

The ServiceManagerAdapter groovy script is provided for Event Forwarding to ServiceManager. You
can customize this script for your installations.

To customize the ServiceManagerAdapter groovy script, open the Scripts manager ( ), select the

sm:ServiceManagerAdapter script and open it for editing ( ). The Edit Script window opens. The

contents of the script are displayed in theScript tab.

Tip: Copying the script text into a text editor of your choice. When you have finished editing, copy
the edited text back to the Edit Script window and save the script.

Near the beginning of the script, there are two sections used tomodify the default behavior of the OMi
event synchronization with ServiceManager.

To access

Administration > Setup and Maintenance > Connected Servers

Click the button.
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Configuring the ServiceManagerAdapter Script

This section controls which event and incident properties are synchronized to and from Service
Manager, and is contained within the following comments:

l BEGIN Configuration: Customization of properties for synchronization

l END Configuration: Customization of properties for synchronization

The ServiceManagerAdapter script can be configured section contains constants, 6 "maps" and "8"
sets to allow configuring the synchronization of the properties. Each is described below:

Service Manager Drilldown Constant

The first variable that can be adjusted is SM_WEB_TIER_NAME. Set this value to the base name of the
web application deployed in the Tomcat container on the ServiceManager system. This web
application is used for drilling down into ServiceManager. The name is used in the URL path for the drill
down. It must match the base name of the web application (".war" is removed). The default is shown
below:

private static final String SM_WEB_TIER_NAME = 'webtier-9.30'

OMi Administrator User

The BSM_ADMINISTRATOR_LOGIN_NAME variable is used to contain the name of the OMi Administrator
user. By default this is set to admin.

For the events that are forwarded automatically by a forwarding rule, the _is_recorded_by attribute is
set to the user specified in the BSM_ADMINISTRATOR_LOGIN_NAME variable.

For the events that are forwardedmanually, the _recorded_by attribute is set to the user that initiated
the forward request.

private static final String BSM_ADMINISTRATOR_LOGIN_NAME = 'admin'

Enumeration Value Maps

Maps are defined tomap enumerated values of the event properties to values on ServiceManager
incident properties. Thesemaps, in general, may not be customized, but they provide a list of possible
values that can be specified in the sets described below. For details on eachmap, view the actual
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values defined in the script.

l MapOPR2SMStatus: Maps the event state to the ServiceManager incident status

l MapSM2OPRState: Maps the ServiceManager incident status to the event state

l MapOPR2SMUrgency: Maps the event severity to the ServiceManager incident urgency

l MapSM2OPRSeverity: Maps the ServiceManager incident urgency to the event severity

l MapOPR2SMPriority: Maps the event priority to the ServiceManager incident priority

l MapSM2OPRPriority: Maps the ServiceManager incident priority to the event priority

Custom Property Maps

The followingmaps allow a user to map any top-level event property to any top-level ServiceManager
incident property.

l MapOPR2SMCustomAttribute: Maps the specified custom attributes to a ServiceManager
incident property for synchronization.

Add a CA name to themap along with a ServiceManager incident property name (XML tag name).

Target ServiceManager Incident property name of "activity_log" will append the CA change to the
ServiceManager incident activity log.

Note: Only top-level ServiceManager incident properties are supported in this map.

l MapSM2OPRCustomAttribute: Maps the specified ServiceManager incident properties to an
event custom attribute for synchronization.

Add a ServiceManager incident property name to themap along with an event custom attribute
name.

Note: Only top-level ServiceManager incident properties are supported in this map.

Examples:

The following synchronizes the event custom attribute MyCustomCA to the ServiceManager
incident activity_log and the custom attribute MyCustomCA1 to the ServiceManager incident
property SMCustomAttribute.

private static final Map<String, String> MapOPR2SMCustomAttribute =
["MyCustomCA" : "activity_log", "MyCustomCA1" : "SMCustomAttribute"]
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The following synchronizes the ServiceManager incident property incident_status to the custom
attribute SMIncidentStatus.

private static final Map<String, String> MapSM2OPRCustomAttribute = ["incident_
status" : "SMIncidentStatus"]

Synchronization Change Sets

The following sets define which properties and enumerated values are synchronized whenever a
change occurs in the OMi event or ServiceManager incident. The properties synchronized upon a
change as standard aremarked in bold. For each list, the value of "*" can be specified. In this case, all
possible properties or enumerated values are synchronized for the specified list.

Note: When the ServiceManager incident is created, all possible event properties and
enumerated values are set in the ServiceManager incident. The following sets aremainly used for
synchronization of changes.

SyncOPRPropertiesToSM

Event properties to synchronize to a corresponding ServiceManager Incident property on change:

l title

l description

l state

l severity

l priority

l solution

l assigned_user

l assigned_group

SyncOPRPropertiesToSMActivityLog

Event properties to synchronize to a corresponding ServiceManager Incident activity log on change:

l title

l description
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l state

l severity

l priority

l solution

l annotation

l duplicate_count

l custom_attribute

l cause

l symptom

l control_transferred_to

l assigned_user

l assigned_group

SyncSMPropertiesToOPR

ServiceManager Incident properties to synchronize to a corresponding event property on change:

l name

l description

l incident_status

l urgency

l priority

l solution

SyncOPRStatesToSM

Event states to synchronize to the ServiceManager incident status on change:

Note: statemust be included in SyncOPRPropertiesToSM or this list is ignored.

l open

l in_progress

l in_progress
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l resolved

l closed

SyncOPRSeveritiesToSM

Event severities to synchronize to the ServiceManager incident urgency on change:

Note: severitymust be included in SyncOPRPropertiesToSM or this list is ignored.

l critical

l major

l minor

l warning

l normal

l unknown

SyncSMStatusToOPR

ServiceManager incident status to synchronize to the event states on change:

Note: statusmust be included in SyncSMPropertiesToOPR or this list is ignored.

l accepted

l assigned

l open

l reopened

l pending-change

l pending-customer

l pending-other

l pending-vendor

l referred

l suspended

l work-in-progress

l rejected
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l replaced-problem

l resolved

l cancelled

l closed

SyncSMUrgenciesToOPR

ServiceManager incident urgencies to synchronize to the event severities on change:

Note: urgencymust be included in SyncSMPropertiesToOPR or this list is ignored.

Acceptable values are 1-4.

SyncSMPrioritiesToOPR

ServiceManager incident priorities to synchronize to the event priorities on change:

Note: prioritymust be included in SyncSMPropertiesToOPR or this list is ignored.

Acceptable values are 1-4.

Examples:

The following example synchronizes the OMi title, state and description to the ServiceManager
incident whenever the corresponding property is changed in the OMi event.

private static final Set SyncOPRPropertiesToSM = ["title", "state", "description"]

The following example will synchronize the OMi states resolved and closed to the ServiceManager
incident whenever the corresponding property is changed in the OMi event.

private static final Set SyncOPRStatesToSM = ["resolved", "closed"]

Note: The properties that are synchronized to the ServiceManager activity log are concatenated
together for each change and then appended to the ServiceManager incident activity log.

Localization

This section is provided to enable localizing some of the text that is displayed in the:
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l The Event Browser Forwarding tab (not available for an Event Channel deployment)

l ServiceManager incident activity log

This sections is contained within the following comments:

l BEGIN Localization: Customization of text values for language localization

l END Localization: Customization of text values for language localization

The following sections describe the text that can be localized.

Forwarding tab

The ServiceManager incident properties urgency and priority are of type integer. In order to display a
moremeaningful value in the Forwarding tab, maps are provided to display a string. These strings may
be localized for display in the browser.

l Service Manager Urgency values

The text value will be displayed on the Forwarding tab.

Note: This text may be localized for the desired locale.

privatestaticfinal Map SMUrgency = ["1": "1 - Critical", "2": "2 - High", "3":
"3 - Average", "4": "4 - Low"]

l Service Manager Priority values

The text value will be displayed on the Forwarding tab.

Note: This text may be localized for the desired locale.

privatestaticfinal Map SMPriority = ["1": "1 - Critical", "2": "2 - High", "3":
"3 - Average", "4": "4 - Low"]

Service Manager Incident Activity Log

Synchronization from OMi to ServiceManager appends various text to the ServiceManager incident
activity log. This text may be localized as follows.

l General Locale Setting: Usedmainly in formatting of dates. May be changed, for example to
Locale.JAPAN. See Java Locale class documentation for all possible values.

private static final Locale LOCALE = Locale.getDefault()
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l Annotation date format: See JavaSimpleDateFormat class documentation for details on the
syntax. Script default is below.

private static final String ANNOTATION_DATE_FORMAT = "yyyy.MM.dd HH:mm:ss z"

l Description: In ServiceManager the incident description is a required attribute. In case it is not set
in OMi this value is taken. An empty string is NOT allowed.

private static final String EMPTY_DESCRIPTION_OVERRIDE = "<none>"

l Log Text: The following text is prefixed to the appropriate event property when synchronizing it to an
ServiceManager Incident activity log.

NOTE: This text may be localized for the desired locale. Defaults are as shown below.

private static final String ACTIVITY_LOG_TITLE = "[Title]\n"

private static final String ACTIVITY_LOG_TITLE_CHANGE = "Event title changed to:
"

private static final String ACTIVITY_LOG_STATE = "[State]\n"

private static final String ACTIVITY_LOG_STATE_CHANGE = "Event state changed to:
"

private static final String ACTIVITY_LOG_DESCRIPTION = "[Description]\n"

private static final String ACTIVITY_LOG_DESCRIPTION_CHANGE = "Event description
changed to: "

private static final String ACTIVITY_LOG_SOLUTION = "[Solution]\n"

private static final String ACTIVITY_LOG_SOLUTION_CHANGE = "Event solution
changed to: "

private static final String ACTIVITY_LOG_ASSIGNED_USER = "[Assigned User]\n"

private static final String ACTIVITY_LOG_ASSIGNED_USER_CHANGE = "Event assigned
user changed to: "

private static final String ACTIVITY_LOG_ASSIGNED_GROUP = "[Assigned Group]\n"

private static final String ACTIVITY_LOG_ASSIGNED_GROUP_CHANGE = "Event assigned
group changed to: "

private static final String ACTIVITY_LOG_SEVERITY = "[Severity]\n"

private static final String ACTIVITY_LOG_SEVERITY_CHANGE = "Event severity
changed to: "
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private static final String ACTIVITY_LOG_PRIORITY = "[Priority]\n"

private static final String ACTIVITY_LOG_PRIORITY_CHANGE = "Event priority
changed to: "

private static final String ACTIVITY_LOG_CONTROL_TRANSFERRED_TO = "[Control
Transferred To]\n"

private static final String ACTIVITY_LOG_CONTROL_TRANSFERRED_TO_CHANGED = "Event
control transfer state changed to: "

private static final String ACTIVITY_LOG_ANNOTATION = "[Annotation]\n"

private static final String ACTIVITY_LOG_CA = "[Custom Attribute]\n"

private static final String ACTIVITY_LOG_CAUSE = "[Cause] "

private static final String ACTIVITY_LOG_OMI_CAUSE = "[OMi Cause] "

private static final String ACTIVITY_LOG_OMI_SYMPTOM = "[OMi Symptom] "

private static final String ACTIVITY_LOG_DUPLICATE_COUNT = "[Duplicate Count] "

private static final String ACTIVITY_LOG_PREVIOUS = "previous "

private static final String ACTIVITY_LOG_CURRENT = "current "

Mapping Table: OMi Event to BDM Incident Property

The standard integration synchronizes the following OMi Event properties to ServiceManager Incident
properties:

OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

- - - global_id id - There is no
mapping and
no
synchronizatio
n for global_
id between an
OMi event and
a Service
Manager
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

incident.

ID - id external_
process_
reference

external.proces
s.
reference

- Set only on
Service
Manager
incident
creation.

- External ID control_
transferre
d_to
external_id

referenc
e_number

number Incident ID Set only on
Service
Manager
incident
creation.

Title - title name brief.descriptio
n

Title Set on incident
creation.
Standard
configuration:
only the OMi
title changes
are
synchronized
to the Service
Manager
incident
activity log. If
the event title
exceeds 256
characters, or
contains a
newline
character, it is
truncated and
the entire title
is prepended
to the
description.

Description - description descriptio
n

action Descriptio
n

Can be a
combination of
the OMi event
title and
description.
See title
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

comments for
details.
Standard
configuration:
synchronized
in both
directions.

Solution - solution solution Resolution Solution Standard
configuration:
synchronized
in both
directions.

Lifecycle
State

- state incident_
status

problem.status Status Set on incident
creation.
Standard
configuration:
only 'closed'
state is
synchronized.

Severity Severity severity urgency severity Urgency Set on incident
creation.
Standard
configuration:
all value
changes are
synchronized.

Priority Priority priority priority priority.code Priority Set on incident
creation.
Standard
configuration:
all value
changes are
synchronized.

Assigned
User

- assigned_
user
login_
name

is_
requeste
d_by
party
display_
label

contact.name Contact By default not
synchronized.
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

- Assigned
User

- has_
assigned
party
display_
label

assignee.name Assignee OMi queries
the Service
Manager
Incident Web
Service in real
time for
display in
Forwarding
Tab only. No
synchronizatio
n between the
OMi event and
the Service
Manager
incident.

- - control_
transferre
d_to
initiated_
by

is_
recorded_
by
party
display_
label

opened.by Opened
By

By default not
synchronized.

Assigned
Group

Assigned
Group

assigned_
group
name

has_
assigne
d_group
functiona
l_group
display_
label

assignment Assignme
nt Group

OMi queries
the Service
Manager
Incident Web
Service in real
time for
display on the
Forwarding
tab only. No
synchronizatio
n between the
OMi event and
the Service
Manager
incident.

Category - category category sub_category Area Category is
set by OMi
only on
Service
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

Manager
incident
creation, but is
by default
ignored in
Service
Manager.

Subcategor
y

- sub_
category

sub_
category

product_type Subarea Subcategory
is set by OMi
only on
Service
Manager
incident
creation, but is
by default
ignored in
Service
Manager.

Related CI - related_ci is_
registere
d_for

logical.name Affected
CI

Affected CI is
set by OMi
only on
Service
Manager
incident
creation.

Annotation
s

- annotatio
n_list

activity_
log
descriptio
n

update.action Activity
Log

Synchronized
from OMi to
Service
Manager only.
OOTB
synchronizatio
n enabled.

Custom
Attributes

- custom_
attribute_
list

activity_
log
descriptio
n

update.action Activity
Log

Can be
configured for
synchronizatio
n to a specific
Service
Manager
incident
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

property, or
the activity
log. For
Service
Manager
activity log,
synchronizatio
n is from OMi
to Service
Manager only.
Standard
configuration:
synchronizatio
n disabled.

Cause - cause->
control_
transferre
d_to
external_id

is_
caused_
by
-master_
referenc
e_number

Links the two
SM Incidents

Related
Records

If the cause
event has
been
synchronized
to Service
Manager, the
two Service
Manager
Incidents are
related,
otherwise
information
about the OMi
cause is
appended to
the Service
Manager
incident
activity log.
Standard
configuration:
synchronizatio
n enabled.

Symptoms - symptom_
list

activity_
log
descriptio
n

update.action Activity
Log

Synchronizati
on is from OMi
to Service
Manager only.
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

Standard
configuration:
synchronizatio
n enabled.

Duplicate
Count

- duplicate_
count

activity_
log
descriptio
n

update.action Activity
Log

Synchronizati
on is from OMi
to Service
Manager only.
Standard
configuration:
synchronizatio
n enabled.
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Chapter 23: OMi-SM Integration with UCMDB
This section describes the integration of ServiceManager with OMi in the case of an external UCMDB.

This section includes:

l "Data Flow Probes" on the next page

l "Create User Accounts for the OMi-SM Integration (UCMDB)" on page 168

l "UCMDB-ServiceManager Integration" on page 169 (prerequisite for all other integration options)

l "OMi-UCMDB Integration" on page 169 (prerequisite for all other integration options)

l "Enable LW-SSO for the OMi-SM Integration (UCMDB)" on page 170

l "View Actual State in SM (UCMDB)" on page 178

l "Event Forwarding from OMi to SM (UCMDB)" on page 179

l "Downtime Forwarding from ServiceManager to OMi (UCMDB)" on page 201

l "Sending downtime notifications from OMi to SM (UCMDB)" on page 210

l "View Changes and Incidents in OMi (UCMDB)" on page 212

l "Business Impact Report (BIR) (UCMDB)" on page 218
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Data Flow Probes

Figure: Setup OMi with a UCMDB and two Data Flow Probes

The DFP1 is necessary for

l Topology synchronization (CIs) between UCMDB andOMi

l Topology synchronization (CIs) between UCMDB and ServiceManager

DFP2 is necessary for

l Topology data push from OMi to UCMDB

l Federation of incidents and changes from SM into OMi
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Create User Accounts for the OMi-SM Integration

(UCMDB)

TheOMi-SM integration requires integration accounts to be set up for the three systems to access
each other.

1. In ServiceManager, create an operator record with system administration privileges, and give it a
descriptive name, like UCMDBSMIntegrUser.

To create a dedicated integration user account in SM:

a. Log on to SM as a system administrator.

b. Type contacts in the SM command line, and press ENTER.

c. Create a new contact record for the integration user account.

i. In the Full Name field, type a full name. For example, UCMDB.

ii. In theContact Name field, type a name. For example, UCMDB.

iii. Click Add, and thenOK.

d. Type operator in the SM command line, and press ENTER.

e. In the Login Name field, type the user name of an existing system administrator account, and
click Search.

The system administrator account displays.

f. Create a new user account based on the existing one:

i. Change the Login Name to the integration account name you want (for example,
UCMDB).

ii. Type a Full Name. For example, RTSM.

iii. In theContact ID field, click the Fill button and select the contact record you have just
created.

iv. Click Add.

v. Select theSecurity tab, and change the password.

vi. Click OK.
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This is the user account that the OMi server uses to access ServiceManager. It is used to forward
events and retrieve incidents and RFCs from ServiceManager. Remember the user name and
password you specify here, as the UCMDB system will need them to access the Service
Manager target server in later steps.

2. On eachOMi server, create a user account with system administration privileges. This account is
used by SM to access the OMi system to retrieve the actual state information of a CI. Give it a
descriptive name, like SMOMiIntegrUser.

Remember the user name and password you specify here, as ServiceManager will need the
accounts to access the OMi server(s) in later steps.

3. In OMi, create a user account with the system administration privileges for the UCMDB-OMi
integration. Give it a descriptive name, like UCMDBOMiIntegrUser. Remember the user name and
password you specify here, as the UCMDB system will need the account details to access the
OMi server in later steps.

4. In UCMDB, create a user account with system administration privileges for the OMi-UCMDB
integration. Give it a descriptive name, like OMiUCMDBIntegrUser. Remember the user name and
password you specify here, as OMi will need the account details to access the UCMDB server in
later steps.

5. In UCMDB, create a user account with system administration privileges for the SM-UCMDB
integration. Give it a descriptive name, like SMUCMDBIntegrUser. Remember the user name and
password you specify here, as SM will need the account to access the UCMDB server in later
steps.

UCMDB-Service Manager Integration

For details about how to integrate UCMDB with ServiceManager, see theHPE ServiceManager
Universal CMDB Integration Guide. This integration, and the OMi-UCMDB integration, which
synchronize important CIs, such as services, business applications and infrastructure CIs, are
prerequisites for all other integration features.

OMi-UCMDB Integration

For details about how to integrate UCMDB with OMi, see Universal CMDB Online Help and theRTSM
Best Practices document.
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Enable LW-SSO for the OMi-SM Integration

(UCMDB)

Lightweight Single Sign-On (LW-SSO) is optional but recommended for the OMi-SM Integration. You
have different LW-SSO configuration choices depending on your needs. The following describes how
LW-SSO can be used in the OMi-SM workflow.

LW-SSO options for the OMi-SM integration

When OMi creates an incident from an OMi event record

OMi creates an incident from anOMi event record by sending RESTful-based requests to Service
Manager. The incident ID is then stored in the event record.

LW-SSO is NOT needed in this process. A dedicated ServiceManager user account was specified
when configuring the ServiceManager integration in OMi. OMi uses this dedicated user account when
calling the ServiceManager RESTful Web Service to create the incident.

When an OMi user views the incident details

The user can log in to ServiceManager and view the incident details by using the incident ID stored in
the event record.

If the user wants to view the incident details by clicking the incident link from the event record, LW-
SSO can be used; otherwise a ServiceManager login prompt will appear.

LW-SSO is optional for this process. To enable LW-SSO for this process, configure LW-SSO in both
the ServiceManager server andWeb tier (because the server needs to trust theWeb tier), as well as in
OMi.

When Service Manager synchronizes the OMi incident status back to OMi

When a user has updated the OMi incident, ServiceManager calls the OMi server's RESTful Web
Service to update the incident changes to the OMi event record.
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LW-SSO is NOT needed in this process. A dedicated OMi user account was specified when the
Incident Exchange (OMi - SM) integration was set up in SMIS, and ServiceManager uses this user
account when calling the OMi server's RESTful Web Service to synchronize the incident status back
to the OMi event record.

When a user views the event details or the Business Impact Report from an OMi

incident

The user clicks theView OMi Event option or Launch Business Impact Report from the incident to
view the event details or Business Impact Report.

LW-SSO is optional for this process. If you enable LW-SSO in the ServiceManagerWeb tier and in
OMi, the OMi login prompt is bypassed.

Required user permissions

In order to be able to view events, a user needs to be assigned a role with sufficient permission to read
events. Tomanage permissions in OMi, select:

Administration > Users > Users, Groups, and Roles

Select a role or create a new one. In the Permissions section, go to theOperations Console category,
select Events and specify the actions users can perform onEvents assigned to user.

You can optionally grant the permission to view events not assigned to each user.

When CIs are synchronized between OMi/UCMDB and SM

LW-SSO is NOT needed in this process. Dedicated users are specified in the OMi-UCMDB, UCMDB-
SM andOMi-SM integration points.

Configuring LW-SSO for the OMi-SM integration

To use LW-SSO for the SM-OMi integration, LW-SSOmust be enable for both products. In SM, you
must enable LW-SSO in both the SM server and web tier.

Step 1: Configure LW-SSO in the SM server

ServiceManager servers, version 9.30 and later, support Lightweight Single Sign-On (LW-SSO). A
ServiceManager integration can pass an authentication token to ServiceManager and does not require
re-authentication. This simplifies the configuration of Single Sign-On for HPE solutions by removing the
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need to use Symphony Adapter (which proxies LW-SSO-based authentication with the Service
Manager Trusted Sign-On solution).

Enabling LW-SSO in the ServiceManager server enables web service integrations from other HPE
products (for example, Release Control) to bypass ServiceManager authentication if the product user
is already authenticated and a proper token is used; enabling LW-SSO in both the ServiceManager
server and web tier enables users to bypass the login prompts when launching the ServiceManager
web client from other HPE applications.

Note: Existing integrations that use the Symphony Adapter and Trusted Sign-On rather than this
new LW-SSOmechanism can continue to work.

To configure LW-SSO in the ServiceManager server:

1. Go to the <ServiceManager server installation path>/RUN folder, and open lwssofmconf.xml
in a text editor.

2. Make sure that the enableLWSSOFramework attribute is set to true (default).

3. Change the domain value example.com to the domain name of your ServiceManager server host.

Note: To use LW-SSO, your ServiceManager web tier and server must be deployed in the
same domain; therefore you should use the same domain name for the web tier and server. If
you fail to do so, users who log in from another application to the web tier can log in but may
be forcibly logged out after a while.

4. Set the initString value. This valueMUST be the samewith the LW-SSO setting of the other
HPE product you want to integrate with ServiceManager.

Note:
l LW-SSO version 2.5 is supported.

l Optionally, you can change attributes paddingModeName, keySize, encodingMode,
engineName, and cipherType. However, youmust make sure that they are samewith the
LW-SSO setting of the other HPE product that you want to integrate with ServiceManager.

l Do not change the other configurations, such as the content in tag <restURLs>, and the
attribute of tag <service>.

Example:

<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config xmlns="http://www.hpe.com/astsecurity/idmenablmentfw/lwsso/2.0">
<enableLWSSO enableLWSSOFramework="true"
enableCookieCreation="true" cookieCreationType="LWSSO" />
<web-service>
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<inbound>
<restURLs>

<url>.*7/ws.*</url>
<url>.*sc62server/ws.*</url>
<url>.*/ui.*</url>

</restURLs>
<service service-type="rest" >
<in-lwsso>

<lwssoValidation>
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher" engineName="AES"
paddingModeName="CBC" keySize="256" encodingMode="Base64Url"
initString="This is a shared secret passphrase"</crypto>

</lwssoValidation>
</in-lwsso>

</service>
</inbound>
<outbound/>

</web-service>
</lwsso-config>

Step 2: Configure LW-SSO in the SM Web Tier

If Lightweight Single Sign-On (LW-SSO) is enabled in the ServiceManagerWeb tier, integrations from
other HPE products will bypass ServiceManager authentication when launching the ServiceManager
Web client, provided that the HPE product user is already authenticated and a proper token is used.

Note:
l To enable users to launch theWeb client from another HPE product by using LW-SSO, you
must also enable LW-SSO in the ServiceManager server.

l Once you have enabled LW-SSO in the web tier, web client users should use the web tier
server's fully-qualified domain name (FQDN) in the login URL:
http://<myWebtierHostName>.<myDomain>:<port>/webtier-x.xx/index.do

The following procedure is provided as an example, assuming that the ServiceManagerWeb tier is
deployed on Tomcat.

To configure LW-SSO in the ServiceManagerWeb tier:

1. Open the <Tomcat>\webapps\< ServiceManager Web tier>\WEB-INF\web.xml file in a text
editor.

2. Modify the web.xml file as follows:
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a. Set the <serverHost> parameter to the fully-qualified domain name of the ServiceManager
server.

Note: This is required to enable LW-SSO from the web tier to the server.

b. Set the <serverPort> parameter to the communications port of the ServiceManager server.

c. Set the secureLogin and sslPort parameters.

l If you do not want to configure TLS between Tomcat and the browser, set
secureLogin to false.

l We recommend that you enable secure login in a production environment. Once
secureLogin is enabled, youmust configure TLS for Tomcat. For details, see the
Apache Tomcat documentation.

d. Change the value of context parameter isCustomAuthenticationUsed to false.

e. Remove the comment tags (<!-- and -->) enclosing the following elements to enable LW-SSO
authentication.

<!--
<filter>
<filter-name>LWSSO</filter-name>
<filter-class>com.hp.sw.bto.ast.security.lwsso.LWSSOFilter</filter-

class>
</filter>
-->

......
<!--
<filter-mapping>
<filter-name>LWSSO</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
-->

f. Save the web.xml file.

3. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEB-
INF\classes\lwssofmconf.xml file in a text editor.

4. Modify the lwssofmconf.xml file as follows:

a. Set the value of enableLWSSOFramework to true (default is false).

b. Set the <domain> parameter to the domain name of the server where you deploy your Service
ManagerWeb tier. For example, if yourWeb tier's fully qualified domain name is
mywebtier.domain.example.com, then the domain portion is domain.example.com.
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Note: To use LW-SSO, your ServiceManager web tier and server must be deployed in
the same domain; therefore you should use the same domain name for the web tier and
server. If you fail to do so, users who log in from another application to the web tier can
log in but may be forcibly logged out after a while.

c. Set the <initString> value to the password used to connect HPE applications through LW-
SSO (minimum length: 12 characters). For example, smintegrationlwsso. Make sure that
other HPE applications (for example, Release Control) connecting to ServiceManager
through LW-SSO share the same password in their LW-SSO configurations.

d. In the <multiDomain> element, set the trusted hosts connecting through LW-SSO. If the
ServiceManager web tier server and other application servers connecting through LW-SSO
are in the same domain, you can ignore the <multiDomain> element ; If the servers are in
multiple domains, for each server, youmust set the correct DNSDomain (domain name),
NetBiosName (server name), IP (IP address), and FQDN (fully-qualified domain name) values.
The following is an example.

<DNSDomain>example.com</DNSDomain>

<NetBiosName>myserver</NetBiosName>

<IP>1.23.456.789</IP>

<FQDN>myserver.example.com</FQDN>

Note: As of version 9.30, ServiceManager uses <multiDomain> instead of
<protectedDomains>, which is used in earlier versions. Themulti-domain functionality is
relevant only for UI LW-SSO (not for web services LW-SSO). This functionality is based
on the HTTP referrer. Therefore, LW-SSO supports links from one application to another
and does not support typing a URL in a browser window, except when both applications
are in the same domain.

e. Check the secureHTTPCookie value (default: true).

l If you set secureHTTPCookie to true (default), youmust also set secureLogin in the
web.xml file to true (default); if you set secureHTTPCookie to false, you can set
secureLogin to either true or false. In a production environment, you are
recommended to set both parameters to true.

l If you do not want to use TLS, set both secureHTTPCookie and secureLogin to
false.

Here is an example of lwssofmconf.xml:
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<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config
xmlns="http://www.hp.com/astsecurity/idmenablmentfw/lwsso/2.0">

<enableLWSSO
enableLWSSOFramework="true"
enableCookieCreation="true"
cookieCreationType="LWSSO"/>

<webui>
<validation>
<in-ui-lwsso>
<lwssoValidation id="ID000001">
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher"
engineName="AES" paddingModeName="CBC" keySize="256"
encodingMode="Base64Url"
initString="This is a shared secret passphrase"/>

</lwssoValidation>
</in-ui-lwsso>

<validationPoint
enabled="false"
refid="ID000001"
authenicationPointServer="http://server1.example.com:8080/bsf"/>

</validation>

<creation>
<lwssoCreationRef useHTTPOnly="true" secureHTTPCookie="true">
<lwssoValidationRef refid="ID000001"/>
<expirationPeriod>50</expirationPeriod>

</lwssoCreationRef>
</creation>

<logoutURLs>
<url>.*/goodbye.jsp.*</url>
<url>.*/cwc/logoutcleanup.jsp.*</url>

</logoutURLs>

<nonsecureURLs>
<url>.*/images/.*</url>
<url>.*/js/.*</url>
<url>.*/css/.*</url>
<url>.*/cwc/tree/.*</url>
<url>.*/sso_timeout.jsp.*</url>

</nonsecureURLs>
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<multiDomain>
<trustedHosts>

<DNSDomain>example.com</DNSDomain>
<DNSDomain>example1.com</DNSDomain>
<NetBiosName>myserver</NetBiosName>
<NetBiosName>myserver1</NetBiosName>
<IP>xxx.xxx.xxx.xxx</IP>
<IP>xxx.xxx.xxx.xxx</IP>
<FQDN>myserver.example.com</FQDN>
<FQDN>myserver1.example1.com</FQDN>

</trustedHosts>
</multiDomain>

</webui>

<lwsso-plugin type="Acegi">
<roleIntegration
rolePrefix="ROLE_"
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>

<groupIntegration
groupPrefix=""
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>

</lwsso-plugin>
</lwsso-config>

f. Save the lwssofmconf.xml file.

5. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEB-
INF\classes\application-context.xml in a text editor.

6. Modify the application-context.xml as follows:

a. Add lwSsoFilter to filterChainProxy:

/**=httpSessionContextIntegrationFilter,
lwSsoFilter,anonymousProcessingFilter

Note: If you need to enable web tier LW-SSO for integrations and also enable trusted
sign-on for your web client users, add lwSsoFilter followed by preAuthenticationFilter, as
shown in the following:
/**=httpSessionContextIntegrationFilter,
lwSsoFilter,preAuthenticationFilter,anonymousProcessingFilter.
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b. Uncomment bean lwSsoFilter:

<bean id="lwSsoFilter"
class="com.hp.ov.sm.client.webtier.lwsso.LwSsoPreAuthenticationFilter">

c. Save the application-context.xml file.

7. Repack the updated ServiceManager web tier files and replace the old web tier .war file
deployed in the <Tomcat>\webapps folder.

8. Restart Tomcat so that the configuration takes effect.

Step 3: Configure LW-SSO in OMi

l In OMi:

a. Navigate to AuthenticationManagement:

Administration > Users > Authentication Management

b. In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor panel.

c. In the Single Sign On Editor panel, select Lightweight.

d. Paste the Token Creation Key (initString) value that you copied above from JMX to get/set
Token Creation Key (initString) to the Token Creation String (initString).

e. Click Save to save your configuration.

For details on configuring LW-SSO, see theOMi Administration Guide.

View Actual State in SM (UCMDB)

To display the Actual State information in the SM configuration item form, do the following:

1. Log on to SM as a system administrator.

2. Click System Administration > Base System Configuration > Miscellaneous > System
Information Record.

3. Click theActive Integrations tab.

4. Select theHP Universal CMDB option.

The form displays the UCMDB web service URL field.

OMi Integrations Guide
Chapter 23: OMi-SM Integration with UCMDB

HPE Operations Manager i (10.60) Page 178 of 272



5. In the UCMDB web service URL field, type the URL to the Universal CMDB web service API.
The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

6. In theUserId andPassword fields, type the user credentials that are required tomanage CIs on
the UCMDB system.

Replace <UCMDB server name> with the host name of your UCMDB server, and replace <port>
with the port used by your UCMDB server web service.

7. Click Save. SM displays themessage: Information record updated.

8. Log out of the SM system.

9. To verify that the setup worked, log back into the SM system with an administrator account. The
Actual State section will be available in CI records pushed from OMi.

Event Forwarding from OMi to SM (UCMDB)

OMi enables you to forward events from OMi to ServiceManager, which then become incidents in
ServiceManager. Subsequent event/incident changes are synchronized between ServiceManager and
OMi. You can also drill down from OMi events to ServiceManager incidents and vice versa.

Follow the steps below to set up an incident exchange between ServiceManager andOMi.

This section includes:

l "Step 1: Configure the ServiceManager server as a connected server in OMi" on the next page

l "Step 2: (optional) Configure an Event Forwarding Rule " on page 183

l "Step 3: Configure the OMi integration in ServiceManager" on page 184

l "Step 4: Configure Launch of ServiceManager Incident Details from OMi" on page 189

l "(optional) Step 5: Attribute Synchronization" on page 190

l "Step 6: Test the Event Forwarding and Cross Launches" on page 196

l "Advanced Configuration" on page 197
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Step 1: Configure the Service Manager server as a

connected server in OMi

To synchronize events and event changes betweenOMi and ServiceManager incidents, configure
ServiceManager as a target connected server in the OMi Connected Servers manager.

To configure the ServiceManager server as a target connected server, perform the following steps:

1. Navigate to the Connected Servers manager:

Administration > Setup and Maintenance > Connected Servers

2. In the central Connected Servers pane, click New and select External Event Processing.

Alternatively, you can click New in the External Event Processing area in the right pane.

The Create External Event Processing Server panel opens.

3. In the General section, enter a display label (a name for the target ServiceManager server), an
identifier (a unique internal name if you want to replace the automatically generated one), and,
optionally, a description of the connection being specified.

Note: The Identifier field is filled in automatically. For example, if you enter Service
Manager 1 as the display label for the target ServiceManager server, Service_Manager_1 is
automatically inserted in the Identifier field.

Make a note of the name of the new target server (in this example, Service_Manager_1). You
must provide it later as the user namewhen configuring the ServiceManager server to
communicate with the server hosting OMi.

4. In the Server Properties section, complete the following information:

a. Enter the fully qualified domain name of the ServiceManager target server.

b. From the drop-down list, select theService Manager System CI type.

c. Optional. Customize the way events and change notifications are delivered to this server by
using Advanced Delivery Options:

l Serial: Events and change notifications are delivered serially in the order in which they
were received.

l Serial per source: Default. Each originating server is provided with a dedicated outgoing
request delivery path. For each individual outgoing request delivery path, events and
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change notifications are delivered serially in the order in which they were received. This
can increase the throughput for delivery of events and change notifications whenmany
events are received frommultiple originating servers, while maintaining the incoming order.

l Parallel: The configured number of outgoing request delivery paths is used when
forwarding events and change notifications. This can further increase the throughput for
delivery of events and change notifications. However, because the source of the event is
not considered, maintenance of the incoming order cannot be guaranteed.

5. In the Integration Type section, complete the following information:

a. Select Call Script Adapter as the integration type.

b. From the Script name drop-down list, select the ServiceManager Groovy script adapter
sm:ServiceManagerAdapter.

c. Specify amaximum transaction time value (the time limit for the execution of the script). The
default value is 60 seconds.

6. In the Outgoing Connection section, enter the user credentials (user name and password) and the
port number required to access the ServiceManager target server and to forward events to that
server:

a. In the Username field, enter the user name for the integration user you set up in Service
Manager.

b. In the Password field, enter the password for the user you specified. Repeat the password for
verification.

c. In the Port field, specify the port configured on the ServiceManager side for the integration
with OMi.

To find the port number to enter:

l If you are using default ports in ServiceManager, select or clearUse secure HTTP as
appropriate, and then click Set default port. The port is set automatically.

Note: If you do not want to use secure HTTP, make sure that theUse secure HTTP
check box is cleared.

If the Use secure HTTP check box is selected, download and install a copy of the
target server’s TLS certificate by clicking import the certificate, and then clicking the
Connect and Import from Server or Import from File button, if the certificate is
available in a local file.

l If you need to find the port number, access the following file on your ServiceManager
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system:

<Service Manager root directory>/HP/Service Manager
<version>/Server/RUN/sm.cfg

In the sm.cfg file, check for the sm -loadBalancer line and add the port entry at the end
of the line. The line looks similar to this:

sm -loadBalancer -httpPort:13080

Enter the appropriate value of the port used by ServiceManager in thePort field of the
Outgoing Connection section.

d. Select theEnable synchronize and transfer control check box.

If the Enable synchronize and transfer control check box is selected, an OMi operator can
transfer ownership of the event to the target connected server by using the Transfer Control
option in the Event Browser context menu. If it is not selected, the Synchronize and Transfer
Control option is not available from the Event Browser context menu or from the list of
forwarding types for configuring forwarding rules.

7. In the Incoming Connection section, select theAccept event changes from external event
processing server check box, and then enter a password that the ServiceManager server
requires to connect to the server hosting OMi.

Note: Make a note of this password. Youmust provide it later when configuring the Service
Manager server to communicate with the server hosting OMi. This password is associated
with the user name (Service_Manager_1) you configured in ServiceManager.

If Enable synchronize and transfer control was previously selected, theAccept event
changes from external event processing server option is assumed and cannot be
disabled.

8. In the Event Drilldown section, complete the following information:

a. Enter the fully qualified domain name and port of the ServiceManager system into which you
want to perform the incident drill down. The default port value is automatically inserted and
can be restored by clickingSet default port.

Note: To enable incident drill down to ServiceManager, youmust install a web tier client
for your ServiceManager server according to your ServiceManager server installation or
configuration instructions.

In theEvent Drilldown section, configure the server where you installed the web tier
client along with the configured port used.
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If you do not specify a server in the Event Drilldown section, it is assumed that the web
tier client is installed on the server used for forwarding events and event changes to SM,
and receiving event changes back from ServiceManager.

If nothing is configured in the Event Drilldown section, and the web tier client is not
installed on the ServiceManager server machine, the web browser will not be able to find
the requested URL.

b. Optional. Select theUse secure HTTP check box for secure communication.

9. In the Test Connection section, click Run Test to check that the specified connection
attributes are correct. If an error message is displayed, correct the connection information, and
retest the connection.

10. Make sure that theActivate after save check box is selected if you want to enable the server
connection immediately.

11. Click Create. The target ServiceManager server appears in the list of connected servers.

12. If you have SM 9.34 or higher, perform the following additional steps:

a. Reopen the ServiceManager connected server that you configured in the previous steps. To
do so, double-click the connected server entry in the connected servers list.

b. Copy the ID of the connected server and save it. Youmust specify this ID as omi.mgr.id on
the ServiceManager system.

An example of a connected server ID is as follows:

ID: 22f42836-fd36-473e-afc9-a81290f4f73b

Step 2: (optional) Configure an Event Forwarding Rule

Once you have configured the ServiceManager server as a connected server in OMi, you can forward
events manually by using Transfer Control To from the Context Menu. If you want to automatically
forward events, you can configure an Event Forwarding Rule for the OMi server.

1. Open the Event Forwardingmanager:

Administration > Event Processing > Automation > Event Forwarding

2. In theEvent Forwarding Rules pane, click the  New Item button to open theCreate New
Event Forwarding Rules dialog box.
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3. Enter a display name, and (optional) a description of the event forwarding rule being specified.

4. Select Active. A rule must be active in order for its status to be available in ServiceManager.

5. Select an event filter for the event forwarding rule from theEvents Filter list. The filter determines
which events to consider for forwarding.

Filters for Event Forwarding Rules can screen events based on the following date-related event
attributes which, for example, help you to ignore outdated events:

o TimeCreated

o TimeReceived

o Time Lifecycle State Changed

4. If no appropriate filter is already configured, create a new filter as follows:

a. Click the  New Item button to open the Filter Configuration dialog box. You can choose
between New Simple Filter or New Advanced Filter.

b. In theDisplay Name field, enter a name for the new filter, in this example, FilterCritical.

Clear the check boxes for all severity levels except for the severity Critical.

Click OK.

c. You should see your new filter in the Select an Event Filter dialog box (select it, if it is not
already highlighted).

Click OK.

6. Under Target Servers, select the target server you configured in the previous step on connecting
servers. Click theAdd button next to the target servers selection field. You can now see the
connected server's details. In the Forwarding Type field, select theSynchronize and Transfer
Control forwarding type. Although other selections are technically possible, only Synchronize and
Transfer Control is supported by ServiceManager.

Step 3: Configure the OMi integration in Service Manager

ServiceManager can integrate with more than oneOMi server. To configuremore than one server, first
complete "Configure the Instance Count in the ServiceManager-OMi integration template" on the next
page before adding integration instances. To proceed with the default of one server, skip to "Add an
SMOMi integration instance for eachOMi server" on the next page.
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Configure the Instance Count in the Service Manager-OMi integration template

To integrate ServiceManager with more than oneOMi server, configure the Instance Count setting in
the SMOMi integration template, as described below.

1. Log on to ServiceManager as a system administrator.

2. Type db in the command line, and press Enter.

3. In the Table field, type SMISRegistry, and click Search.

The SMIS integration template form opens.

4. Click Search.

A list of SMIS integration templates opens.

5. Select SMOMi from the list.

6. In the Instance Count field, change the value of 1 to the number of OMi servers that you want to
integrate with ServiceManager. For example, if you need twoOMi servers, change the value to 2.

7. Click Save.

Add an SMOMi integration instance for each OMi server

Once you have completed configuration in OMi, you are ready to add and enable a separate integration
instance in ServiceManager for eachOMi server.

To add and enable an Incident Exchange (OMi - SM) integration instance:

1. Log on to ServiceManager as a system administrator.

2. Click Tailoring > Integration Manager.

3. Click Add.

The Integration Template Selection wizard opens.

4. Select SMOMi from the Integration Template list.

Note: Ignore the Import Mapping check box, which has no effect on this integration.

5. Click Next.

6. Complete the integration instance information:

OMi Integrations Guide
Chapter 23: OMi-SM Integration with UCMDB

HPE Operations Manager i (10.60) Page 185 of 272



o Modify theName andVersion fields to the exact values you need.

o In the Interval Time (s) field, enter a value. For example: 600. If an OMi opened incident fails
to be synchronized back to OMi, ServiceManager will retry the failed task at the specified
interval (for example, 600 seconds).

o In theMax Retry Times field, enter a value. For example: 10. This is themaximum allowed
number of retries for each failed task.

o (Optional) In theSM Server field, specify a display name for the ServiceManager server host.
For example: my_Local_SM.

o (Optional) In theEndpoint Server field, specify a display name for the OMi server host. For
example: my_OMi_1.

o (Optional) In the Log File Directory field, specify a directory where log files of the integration
will be stored. This must be a directory that already exists on the ServiceManager server host.

o (Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example:WARNING.

o (Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

7. Click Next. The Integration Instance Parameters page opens.

8. On theGeneral Parameters tab, complete the following fields as necessary:

Field Sample Value Description

omi.server.url http://<servername>:opr-
gateway/rest/synchronization/event/

This is the URL address of the
OMi server's RESTful web
service. Replace
<servername> with the fully
qualified domain name of your
OMi server.

http.conn.timeout 30 The HTTP connection timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds),
and 15 (seconds) is used
if this field is empty.

http.rec.timeout 30 The HTTP receive timeout
setting in seconds.
Note: The out-of-box
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Field Sample Value Description

value is 30 (seconds),
and 15 (seconds) is used
if this field is empty.

http.send.timeout 30 The HTTP send timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds),
and 15 (seconds) is used
if this field is empty.

sm.mgr.id 55436DBE-F81E-4799-BA05-
65DE9404343B

The Universally Unique
Identifier (UUID)
automatically generated for
this instance of Service
Manager.
Note: This field is
automatically completed
each time when you add
an SMOMi integration
instance. Do not change
it, otherwise the
integration will not work
properly.

omi.reference.prefix urn:x-hp:2009:opr: The prefix of the BDM
External Process Reference
field, which will be present in
incoming synchronization
requests from theOMi server.

Note: This field is
automatically completed
and has a fixed value. Do
not change it.

sm.reference.prefix urn:x-hp:2009:sm: The prefix of the BDM
External Process Reference
field, which will be present in
outgoing synchronization
requests from Service
Manager.
Note: This field is
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Field Sample Value Description

automatically completed
and has a fixed value. Do
not change it.

omi.eventdetail.baseurl http://<servername>/opr-
console/opr-evt-details.jsp?eventId=

The basic URL address of the
event detail page in OMi.
Replace <servername> with
the fully qualified domain
name of your OMi server.

9. On theGeneral Parameters andSecure Parameters tabs, enter three parameter values that you
specified when configuring the ServiceManager server as a connected server in OMi. The
following table lists the parameters, whose values you can copy from your OMi server.

To copy the parameter values from OMi, follow these steps:

a. Log in to OMi as a system administrator.

b. Navigate toAdministration > Setup and Maintenance > Connected Servers.

c. Locate your ServiceManager server configuration entry and double-click it.

d. In the General section, copy the ID string into the omi.mgr.id field in ServiceManager.

e. In the Incoming Connection section, copy the User name and Password to the username and
Password fields in ServiceManager, respectively.

Field
Sample
Value Description

omi.mgr.id
(on the
General
Parameters
tab)

f3832ff4-
a6b9-4228-
9fed-
b79105afa3e4

The Universally Unique Identifier (UUID) automatically
generated in OMi for the target ServiceManager server.

Note: This parameter was introduced to support multiple
OMi servers. ServiceManager uses the UUID to identify
from which OMi server an incident was opened. Be aware
that if you delete the connected server configuration for the
ServiceManager server in OMi and then recreate the same
configuration, OMi generates a new UUID. Youmust
reconfigure the integration instance by changing the old
UUID to the new one.

Tip: If you have only oneOMi server, you can simply
remove this parameter (remove both the parameter name
and value) from the integration instance.
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Field
Sample
Value Description

username
omi.mgr.id
(on the
General
Parameters
tab)

SM_Server This is the user name that the ServiceManager server uses to
synchronize incident changes back to the OMi server.

Password
(on the
Secure
Parameters
tab)

SM_Server_
Password

This is the password that the ServiceManager server uses to
synchronize incident changes back to the OMi server.

10. Click Next twice, and then click Finish.

Note: Leave the Integration InstanceMapping and Integration Instance Fields settings blank.
This integration does not use these settings.

ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

11. Enable the integration instance.

12. If you havemultiple OMi servers, repeat the steps above for the rest of your OMi servers.

Step 4: Configure Launch of Service Manager Incident

Details from OMi

If you want to be able to drill down to ServiceManager incidents from theOMi Event Browser, youmust
configure the ServiceManager web tier in the sm:ServiceManagerAdapter script in OMi.

1. Navigate to Connected Servers in OMi:

Administration > Setup and Maintenance > Connected Servers

Click Manage Scripts.

2. Select the sm:ServiceManagerAdapter script, and click theEdit Item button.

3. Click theScript tab and locate the following text in the Groovy script:

OMi Integrations Guide
Chapter 23: OMi-SM Integration with UCMDB

HPE Operations Manager i (10.60) Page 189 of 272



private static final String SM_WEB_TIER_NAME = 'webtier-9.30'

4. Change the value of webtier-9.30 to the value required to access the ServiceManager web tier
client.

The drill-downURL is made up like this:

http://<FQDN of Service Manager web tier server>/<web path to Service
Manager>/<URL query parameters>

In this instance, <FQDN of Service Manager web tier server> is the fully qualified DNS
name of the ServiceManager server where the web tier client is installed. This part of the URL is
added automatically (together with http:// or https://) according to the values that you
provided when you configured ServiceManager as a target connected server in the Connected
Servers manager. The address of the Event Drilldown section of the Connected Server makes up
the rest of the URL. For details, see the previous step on connecting servers.

An example of a drill-downURL:

http://smserver.example.com/SM930/index.do?ctx=docEngine&file=probsummary&query
=number%3D%22IM10216%22&queryHash=bf52f465

In this example, youmust replace webtier-9.30with SM930. All the other parts of the URL are
configured automatically.

5. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version.

For details, see theOMi Administration Guide.

6. If you are using SM 9.34 or lower, set the values of the querysecurity parameter and the
querySecurityWeb parameter from the default values (true) to false in the SM web tier
configuration file web.xml.

For details about the querysecurity parameter and the querySecurityWeb parameter, see
ServiceManager Online Help.

(optional) Step 5: Attribute Synchronization

Attribute Synchronization Using Groovy Scripts

When the SM incident is initially created from anOMi event, event attributes aremapped to the
corresponding SM incident attribute. Out of the box, after the initial incident creation, whenever the

OMi Integrations Guide
Chapter 23: OMi-SM Integration with UCMDB

HPE Operations Manager i (10.60) Page 190 of 272



incident or event subsequently changes, only a subset of the changed event and incident attributes are
synchronized. The following describes how to customize the list of attributes to synchronize upon
change. If you want to change the out-of-the-box behavior regarding which attributes are updated, you
can specify this in the Groovy script used on theOMi side for synchronization or incident creation. In
the Groovy script, you can specify which fields are updated in SM, and which fields are updated in OMi.
You can also specify custom attributes in the Groovy script.

Bidirectional Synchronization of Attributes

Individual OMi event attributes can be synchronized from anOMi event to the corresponding SM
incident, whenever the event is changed in OMi. Similarly, individual SM incident attributes can be
synchronized from an SM incident to the corresponding event in OMi, every time the event is changed
in SM. To change the attributes that are synchronized from anOMi event to a corresponding SM
incident, change the attributes included in the SyncOPRPropertiesToSM list in the Groovy script. To
change the attributes that are synchronized from an SM incident to anOMi event, change the attributes
included in the SyncSMPropertiesToOPR list in the Groovy script. By default, the state, solution, and
cause attributes are synchronized from OMi events to their corresponding SM incidents, and the
incident_status and solution attributes are synchronized from an SM incident to the corresponding
OMi event.

To enable synchronization of all attributes in both directions, you can set the SyncAllProperties
variable to true. In this case, all other variables will be ignored.

Example:

l private static final Set SyncOPRPropertiesToSM = ["state", "solution", "cause"]

l private static final Set SyncSMPropertiesToOPR = ["incident_status", "solution"]

The following table lists the OMi event attributes that can by synchronized with an SM incident, and the
matching SM incident attributes that can be synchronized with anOMi event:

OMi event attribute SM incident attribute

title name

description description

state incident_status

severity urgency

priority priority

solution solution
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Unidirectional Synchronization of Attributes

The assigned_user, assigned_group, and cause event properties can be synchronized from anOMi
event to a corresponding SM incident. To synchronize these attributes, add them to the
SyncOPRPropertiesToSM list in the groovy script.

Example:

l private static final Set SyncOPRPropertiesToSM = ["assigned_user", "assigned_
group", "cause"]

Individual OMi event properties can be synchronized to a corresponding SM incident Activity Log.
Updates are not synchronized back from the SM incident Activity Log to the corresponding OMi event.
To change the properties that are synchronized, add the desired properties to the
SyncOPRPropertiesToSMActivityLog list in the Groovy script. By default, the title, description,
state, severity, priority, annotation, duplicate_count, cause, symptom, assigned_user, and
assigned_group properties are synchronized.

Example:

l private static final Set SyncOPRPropertiesToSMActivityLog = ["title",
"description", "priority"]

The following list includes all properties that can by synchronized from OMi events to the SM incident
Activity Log:

l title

l description

l state

l severity

l priority

l solution

l annotation

l duplicate_count

l assigned_user

l assigned_group

l cause

l symptom
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l control_transferred_to

l time_state_changed

Custom Mappings for Custom Attributes

You can define your ownmappings for custom attributes betweenOMi and SM. Thesemapping can be
either unidirectional, if the attributes are only contained in onemap, or bidirectional, if the attributes are
contained in bothmaps. To create custommappings for custom attributes, you can edit the
MapSM2OPRCustomAttribute and MapOPR2SMCustomAttribute lists in the Groovy script. Thesemaps
are empty by default.

Example:

l private static final Map <String, String> MapSM2OPRCustomAttribute =
[“MySMAttribute” : “MyOMiCustomAttribute”]

l private static final Map <String, String> MapOPR2SMCustomAttribute = [ 
“MyOtherOMiCustomAttribute” : “MyOtherSMAttribute”, “MyThirdOMiCA”, “activity_
log”]

Mapping OPR Lifecycle States to BDM Lifecycle States

Individual OPR event state and SM incident status changes may be selected for synchronization. Out
of the box, only the "closed" state is synchronized in both directions. To change this behavior, add the
desired states to the appropriate list, SyncOPRStatesToSM or SyncSMStatusToOPR.

Examples:

l private static final Set SyncOPRStatesToSM = ["closed", "in_progress",
"resolved"]

l private static final Set SyncSMStatusToOPR = ["closed", "resolved"]

In the example, the OPR event lifecycle states closed, in_progress, and resolved are synchronized
to the SM incident status, and SM incident statuses closed and resolved are synchronized to the
OPR event state.

Note: The special state "*" denotes all states, so to synchronize all OPR event states to the SM
incident status property, specify the following:

private static final Set SyncOPRStatesToSM = ["*"]
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Additionally, twomaps are used to specify themapping of the OPR event lifecycle state to the BDM
incident status. Themaps are named MapOPR2SMStatus and MapSM2OPRState. Out of the box, all
possible states have amapping.

Examples:

l private static final Map MapOPR2SMStatus = ["open": "open", "in_progress":
"work-in-progress", "resolved": "resolved", "closed": "closed"]

l private static final Map MapSM2OPRState = ["accepted": "open", "assigned":
"open", "open": "open", "reopened": "open",

"pending-change": "in_progress", "pending-customer": "in_progress", "pending-
other": "in_progress",

"pending-vendor": "in_progress", "referred": "in_progress", "suspended": "in_
progress",

"work-in-progress": "in_progress", "rejected": "resolved", "replaced-problem":
"resolved",

"resolved": "resolved", "cancelled": "resolved", "closed": "closed"]

Tips for customizing Groovy Scripts

This section provides some tips about customizing Groovy scripts. It contains a few selected
examples of what you can customize. To see further items that can bemodified, see the configuration
section of a Groovy script.

In the configuration section of the Groovy script, you can define andmodify the attributes that are to be
synchronized betweenOMi and SM. The configuration section of the Groovy script also contains the
default valuemappings for lifecycle state, severity, and priority. You can alsomodify these, and it is
possible to define themappings for in-going and out-going requests differently.

More advanced configuration can be done in other parts of the Groovy script if required.

The beginning and the end of the configuration section of the Groovy script is marked as follows:

//

//*BEGIN Configuration: Customization of properties for synchronization*

//

...

...
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//

// *END Configuration: Customization of properties for synchronization*

//

Note: Modifications to Groovy scripts are not overwritten by patches and hotfixes. Your
customized version of a script will remain after an update or a patch. If you want to use the newer
version of a script, make a copy of your version, revert back to the predefined version, and then
reapply your changes.

Themapping from OMi to SM is compliant to BDM 1.1 incident web service specifications. The
mapping of the BDM 1.1 incident web service to SM is specified in SM in the BDMMappingManager.
For more information about the BDMMappingManager, see ServiceManager Online Help.

Avoiding Errors with Large TQL Queries

If the Groovy script executes a TQL query that produces a large number of results, an error message
appears informing you about the TQL query result exceeding the size limit. As a consequence, the
integration event is not sent. It is possible, however, to increase this limit by modifying the value of the
tql.compound.link.max.visited.objects setting.

Note: To check the default value of the tql.compound.link.max.visited.objects setting,
from the JMX console, select UCMDB:service=Settings Services, and then locate the
showSettingsByCategorymethod and enter TQL Settings as the category name.

Tomodify the value of the tql.compound.link.max.visited.objects setting, follow these steps:

1. From the JMX console, select UCMDB:service=Settings Services.

2. Click setSettingValue.

3. Enter tql.compound.link.max.visited.objects as the name of the setting you want to modify
and a new value for it.

Caution: Increasing the value of the tql.compound.link.max.visited.objects setting also
increases the load on the RTSM. Therefore, make sure to carefully consider how much to increase
this value.

Syntax Errors

The ServiceManagerAdapterGroovy script uses the ApacheWink client to communicate with
ServiceManager. It therefore will throw a ClientWebExceptionwhen there is an HTTP error status
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returned by ServiceManager.

If you get a syntax error when customizing your Groovy scripts, you will get an event in the event
browser with a detailed description of the error. In addition, youmay view the opr-event-sync-
adapter.log log file for information about how to resolve the error. You can find this log file at the
following location:

<Gateway Server root directory>/log/opr-scripting-host/opr-event-sync-adapter.log

Step 6: Test the Event Forwarding and Cross Launches

To test the event forwarding, forward an event manually to SM and then verify that the event is
forwarded to SM as expected, and that the cross launches work in both directions.

1. Open anOMi Event Browser.

2. Select an event and select Transfer Control To in the Context Menu. Select the SM target
system.

3. Select the Forwarding tab.

4. In the External Id field, you should see a valid SM incident ID after a few seconds.

5. Verify that the incident appears in the Incident Details in ServiceManager by using the cross
launch (see next step).

If the event drill-down connection is not configured, verify the forwarding by using the following:

a. In the Forwarding tab in the OMi Event Browser, copy or note the incident ID from the External
Id field.

b. In the ServiceManager user interface, navigate to:

Incident Management > Search Incidents

c. Paste or enter the incident ID in the Incident Id field.

d. Click theSearch button. This takes you to the incident in the Incident Details.

6. Test the cross launch from OMi to SM:

Click the hyperlink created with the incident ID. A browser window opens, which takes you
directly to the incident in the Incident Details in ServiceManager.

7. Test the cross launch from SM toOMi:
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In the Incident Details in ServiceManager, click More and then select View OMi Event. A
browser window opens, which takes you directly to the event in the Event Browser in OMi.

Note: TheView OMi Event option displays only when the omi.mgr.id parameter in the
corresponding SM-OMi integration instance is set correctly.

8. Close the incident in ServiceManager.

9. Verify that the change in the state of the incident (it is now closed) is synchronized back to OMi.
Youmay not be able to see the event that was closed in SM in the active Event Browser, but it
should now be in the Closed Events Browser.

Advanced Configuration

Configure forwarding of affected business services from OMi to SM

ServiceManager versions 9.40 and higher support the display of multiple affected business services
associated with an event in OMi. By default, when an event is created in OMi that affects more than
one business service CI, all affected services are automatically forwarded to SM. Themost critical
service is displayed on the "Primary Service" tab in SM, and all other affected services are displayed
on the "Impacted Services" tab.

If you only want to forward themost critical affected service associated with an event from OMi to SM,
you can change the ForwardAllAffectedBusinessServices flag in the sm:ServiceManagerAdapter
script to false.

1. Navigate toConnected Servers in OMi:

Administration > Setup and Maintenance > Connected Servers

Click Manage Scripts.

2. Select the sm:ServiceManagerAdapter script, and click theEdit Item button.

3. Click theScript tab and search for ForwardAllAffectedBusinessServices. Change the value to
false.

4. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version. For details, see theOMi Administration Guide.
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Configure automatic closure for OMi incidents in SM

Incidents created from OMi events will be automatically closed when the corresponding OMi event is
closed. You can also configure SM incidents created from OMi events to be automatically closed after
a predefined amount of time since they were last updated (or resolved if they have not been updated
after being resolved).

The workflow is as follows:

1. An incident is opened from OMi.

2. If theSchedule Condition is met, the system creates a schedule record for the incident. The
schedule record will expire at a future time based on theCalc Expression.

3. A user updates the incident and saves the changes.

4. TheReset alerts if expression on theAlerts tab of the probsummary object definition is
evaluated. If it evaluates to true, the Expiration time of the schedule record is updated based on
the Calc Expression. By default, the expiration time of the schedule record is updated only when
the incident has a category of incident.

5. When the schedule record expires, theAlert Condition is evaluated. If it evaluates to true, the
incident is automatically closed.

To enable automatic closure for OMi incidents:

1. Configure the global settings in the Incident Management Environment record.
a. In SM versions lower than 9.40, click System Administration > Ongoing Maintenance >

Environment Records > Incident Management Environment.

In SM versions 9.40 and higher, click Incident Management > Administration >
Environment.

b. Change the following settings as necessary.

Field Value

Close Incident
Automatically?

This option disables or enables the automatic closure of OMi incidents
at the global level.
l If this option is not selected, no incidents will be automatically
closed.

l If this option is selected, incidents will be automatically closed
under specified conditions.

Default: Not selected
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Field Value

Closure Code This value will be copied to theClosure Code field of incidents when
they are automatically closed.
Default: Automatically Closed

Solution This description will be appended to the end of theSolution field of
incidents when they are automatically closed.
Default: This incident which belongs to OMi has been closed
automatically.

c. Click Save.

d. Restart the ServiceManager server.

Note: If you havemade any changes to any of the configuration options in the Incident
Management Environment record, the ServiceManager server must be restarted for the
changes to take effect.

2. Configure the alert definition that determines when an incident should be closed.

Note: The alert and problem processes must be running to enable the successful closure of
OMi incidents.

a. Click Tailoring > Document Engine > Alerts.

b. In the Alert Name field, enter: OMI Auto-Close.

c. Click Search. TheOMiAuto-Close alert definition detail form opens.

Caution: These fields in the alert definition are used to control automatic closure of OMi
incidents. You can change the default values of these fields. However, youmust be
aware of the risk that automatic closure of OMi incidents will not work properly if the
Schedule Condition andAlert Condition fields are not configured correctly.

Field Value

Schedule
Condition

This expression is used to determine if an incident should be scheduled for
automatic closure.
Default: jscall("SMOMi.isAutoCloseAndResolved").

An incident is scheduled for automatic closure when the following conditions
aremet.

l TheClose Incident Automatically? option in the Incident Management
Environment record is selected.

l In the incident record, theDo not close this incident automatically
option is not selected.
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Field Value

l The incident has a status of Resolved.

Alert
Condition

This expression is evaluated when an incident is about to be automatically
closed. If it evaluates to true, the incident is closed.
Default: jscall("SMOMi.isAutoCloseEnabled").

An incident is closed when the following conditions aremet.

l TheClose Incident Automatically? option in the Incident Management
Environment record is selected.

l In the incident record, theDo not close this incident automatically
option is not selected.

Calc
Expression

This expression is used to determine how much time will elapse before an
incident is automatically closed.

Default: $L.alert.time=update.time in $L.file+'7 00:00:00'.

The default valuemeans the amount of time elapsed is equal to seven days
since the incident was last updated.

3. Configure alert information in the probsummary object.
TheOMi autoclose alert definition is configured to only be used by OMi incidents. The closure time
is reset each time the incident is updated. If the closure time is reached without the incident being
updated then ServiceManager will automatically close the incident.

a. Click Tailoring > Document Engine > Objects.

b. In the File name field, enter probsummary and press ENTER. The probsummary object
definition is displayed.

c. Select theAlerts tab.

TheReset alerts if expression is used to reset the automatic closure time of OMi incidents.

Default: category in $L.file="incident" and not null(1 in
external.process.reference in $L.file).

Configure TLS for the Incident Exchange integration

WhenOMi is configured to accept https connections only, youmust configure TLS for the integration. If
you do not do so, changes on an incident that is created from OMi cannot be synchronized back to OMi.

Note: The following steps describe how you do so by using the built-in keytool in Service
Manager, and the file paths are forWindows only. Be sure to change the file paths accordingly if
your ServiceManager system is running on Unix.
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To configure TLS for the integration, follow these steps:

1. Import the OMi root certificate to the ServiceManager server trusted keystore.

The following is an example of the command line:

<SM Install path>\server\RUN\jre\bin\keytool -import -alias myCA -file <.pem
file of your BSM root certificate> -keystore <SM Install
path>\Server\RUN\jre\lib\security\cacerts -storepass <changeit>

Note: Where: changeit is the default password of the trusted keystore. Change it to your own
password if you have changed it.

2. Add the following parameters to the ServiceManager server configuration file (<SM install
path>\Server\RUN\sm.ini):

truststoreFile:<SM install path>\Server\RUN\jre\lib\security\cacerts

truststorePass:<changeit>

3. Restart the ServiceManager Server service.

Downtime Forwarding from Service Manager to OMi

(UCMDB)

You can create downtimes (also known as outages) in OMi based on Requests for Changes (RFCs) in
SM. This is done in two steps. First, scheduled downtime CIs are created in the UCMDB based on
RFCs in SM. Then, a BSM downtime CI is created in OMi based on the scheduled downtime.

You can also send downtime start and end information from OMi to SM to notify operators of when a
downtime occurs, especially if the downtime was not driven by an RFC in SM. For more information on
this integration, see "Sending downtime notifications from OMi to SM (UCMDB)" on page 210

Notes:

1. For Changes/Tasks that have final approval phases defined in ServiceManager Integration
Suite (SMIS), the downtimes will be synchronized after the Changes/Tasks get final
approval.

2. Only downtimes that end at a future time will be synchronized.

3. Select theConfiguration Item(s) Down checkbox when scheduling downtimes in
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Changes/Tasks.

4. The SLA scheduler needs to be started in theSystem Status form.

Step 1: Add an SMBSM_DOWNTIME integration instance

in SM

To set up the integration from ServiceManager to OMi, youmust add an instance of this integration in
the ServiceManager Integration Suite (SMIS). Note that additional setup is required on theOMi side for
integration from OMi to ServiceManager.

To add the SMBSM_DOWNTIME instance:

1. Click Tailoring > Integration Manager. Integration InstanceManager opens.

2. Click Add. The Integration Template Selection wizard opens.

3. Select SMBSM_DOWNTIME from the Integration Template list. Ignore the Import Mapping
check box, which has no effect on this integration.

4. Click Next. The Integration Instance Information page opens.

5. Do the following:

o Modify theName andVersion fields to the exact values you need.

o In the Interval Time(s) field, enter a value based on your business needs in regard to downtime
exchange frequency. Note that a short interval time can be safe because the next scheduled
task will not start until the previous task is completed and the interval time passed.

o In theMax Retry Times field, enter a value. This is themaximum allowed number of retries (for
example, 10) for each failed task.

o In the Log File Directory field, specify a directory where log files of the integration will be
stored. This must be a directory that already exists on the ServiceManager server. By default,
loggingmessage is output to sm.log.

o (Optional) In theSM Server field, specify a display name for the ServiceManager server host.
For example: my_local_SM.

o (Optional) In theEndpoint Server field, specify a display name for the OMi server host. For
example: my_BSM_1.

o (Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example: WARNING.
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o (Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

6. Click Next. The Integration Instance Parameters page opens.

7. On theGeneral Parameters tab, complete the following fields as necessary:

Name Category Value Description

WithdrawDowntime General true/false Set this value to true: When authorized users
aremanually changing the phase of a change
record which has 'valid' outage, a window will
open and provide choices of withdrawing the
outage.

Set this value to false: The pop-up window is
disabled. This operationmay cause some
unapproved planned downtimes be
synchronized to OMi.

By default, this value is set to true.

Category or
workflow (Process
Designer) name of
changes

Change The final
approval
phase for
changes

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

Category or
workflow (Process
Designer) name of
tasks

Task The final
approval
phase for
tasks

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

sm.host General <sm server
name >

Set the ServiceManager server host name or
DNS name to compose the External Process
Reference and the Reference Number of
Scheduled Downtime CI in UCMDB.

Note:Do not include a colon in this field.
Otherwise, the logic will be broken.

sm.reference.prefix General urn:x-
hp:2009:sm

Set the prefix to compose the External
Process Reference of Scheduled Downtime
CI in UCMDB.

Note: This field has a fixed value. Do not
change it.
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Notes:

a. Type category or workflow name of change/task in theName column. This value is case-
sensitive and it must match the record in ServiceManager database.

b. Set the value to Change for changes in theCategory column. Similarly, set the value to
Task for tasks.

c. Type the final approval phase in theValue column. This value is case-sensitive and it
must match the record in ServiceManager database. You can separatemultiple phases
by semicolons, whichmust be the English character.

d. Detailed information will be displayed in the integration log when the following errors
occur:

l User input of categories/phases for the changes/tasks is not correct.

l The category and phase pair does not exist in the database.

e. For ChangeManagement categories which do not have approval phase, the downtime
integration will treat its downtime information as final approved once created. You do not
need to define any phases in SMIS parameters.

f. For the category or workflow name of the changes and the tasks, the integration will
ignore all the final phases defined for the redundant category or workflow.

8. Click Next twice and then click Finish. Leave the Integration InstanceMapping and Integration
Instance Fields settings blank. This integration does not use these settings.

ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

9. Enable the integration instance. SMIS will validate all the final phases you filled in the Integration
Instance Parameters page and print warningmessages if there are errors.

Step 2: Tailor Service Manager to handle phase change

In the ServiceManager ChangeManagement module, authorized users canmanually change the
phase of a change record. If the phase is changed to the one prior to the final approval phase in the
SMBSM_DOWNTIME instance, the system will check if there are existing planned downtimes that
have been set to Ready. If such downtimes exist, a window will open and provide two options for the
corresponding planned downtimes:
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l Click Yes to withdraw the corresponding planned downtimes from UCMDB. The changes or tasks
need to be approved again to synchronize with UCMDB at another time.

l Click No. There will be no change to the planned downtimes even if the actual status of the
changes or tasks are not approved.

Note: To disable the pop-up window when withdrawing the planned downtimes, youmust set the
WithdrawDowntime parameter to false in the SMBSM_DOWNTIME instance. This operation
may cause some unapproved planned downtimes to be synchronized to OMi.

With Process Designer (PD) Content Pack 2 applied in ServiceManager, you can tailor the process to
transit changes or tasks from one phase that is after the final approval phase in the SMBSM_
DOWNTIME instance to another that is prior to the final approval phase. To withdraw the related
planned downtime for this kind of transition, youmust add a rule set for the transition in the Closed Loop
Incident Process (CLIP) solution. Follow these steps:

1. Go to the target workflow that needs tailoring.

2. Select the transition that moves a phase from before the final approval phase to after the final
approval phase.

3. In the Rule Sets section, click Add and select the clip.downtime.withdraw rule set.

4. Click OK to save the workflow.

Step 3: Set up downtime sync jobs in UCMDB

As part of CI synchronization, you have already set up an integration point between SM andUCMDB.
In this step, you add downtime synchronization jobs, so that scheduled downtime CIs are created in
UCMDB based on Requests for Change in SM.

To add the downtime synchronization jobs:

1. Log in to your UCMDB system as an administrator.

2. Edit the existing integration point that connects to your ServiceManager server.

3. Click Managers > Data Flow Management > Integration Studio. UCMDB displays a list of
integration points.

4. Select the existing SM integration point. Make sure that CIs have already been synchronized
between SM andUCMDB.

5. Create two integration jobs in the integration point on thePopulation tab:

OMi Integrations Guide
Chapter 23: OMi-SM Integration with UCMDB

HPE Operations Manager i (10.60) Page 205 of 272



a. Create a new job including the SM CLIP Down Time Population job definition. Under
Scheduler Definition, select theScheduler enabled checkbox and set the Repeat Interval
to 1Minute. Click OK to save the job.

b. Create another new job including the SM CI Connection Downtime CI job definition. Under
Scheduler Definition, select theScheduler enabled checkbox and set the Repeat Interval
to 1Minute. Click OK to save the job.

Pay attention to the running order. The CLIP Down Time Population jobmust be run first. You
can set the two jobs as schedule-based and set the schedule interval according to your needs.

Note: If no related CIs exist in UCMDB when creating relationships, the population will fail or
succeed with a warning. To disable the warning, remove the downtime CI that does not have
related CIs in UCMDB.

Step 4: Set up creation of BSM Downtime CIs

In this step, BSM Downtime CIs are created based on Scheduled Downtime CIs.

To enable downtimes defined in SM to be sent to OMi, youmust install the DFP2 in the OMi
deployment.

Important: 

l Following the initial integration, a large amount of datamay be communicated from SM toOMi. It is
highly recommended that you perform this procedure during off-hours, to prevent negative impact on
system performance.

To create BSM Downtime CIs:

1. Create a new Integration Point or, if existing, edit theSM Scheduled Downtime Integration Into
BSM Integration Point:

a. Do the following on your UCMDB:

Go to:

Managers> Data Flow Management > Integration Studio

b. Click New Integration Point orEdit, enter a name and description of your choice, and select
the adapterSM Scheduled Downtime Integration Into BSM from the ServiceManager
folder.
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If you have upgraded from an older version of OMi to OMi 10.10, youmay still see the old
"BSM Downtime Adapter", or youmay see the "SM Scheduled Downtime Integration Into
BSM" adapter in the Third Party Products folder (not in the ServiceManager folder). In this
case, youmust upgrade your adapter by doing the following:

i. Open the PackageManager.

ii. Deploy the package: /opt/hp/BSM/odb/conf/factory_
packages/BSMDowntimeAdapter.zip on the data processing server.

iii. You should now find theSM Scheduled Downtime Integration Into BSM adapter in
the ServiceManager folder.

c. Enter the following information for the adapter: OMi GW or Load Balancer/Reverse Proxy
FDQN and port (80/443), communication protocol (http/https), and the context root (if you
have a non-default context root).

d. Specify the credentials for the user you created in "Create User Accounts for the OMi-SM
Integration (UCMDB)" on page 168 to access the OMi system. Choose generic protocol as
protocol.

e. Click OK, then click theSave button above the list of the integration points.

2. You can use theStatistics tab in the lower pane to track the number of downtimes that are created
or updated. By default, the integration job runs every minute. If a job has failed, you can open the
Query Status tab and double-click the failed job to seemore details on the error.

If there is an authentication error, verify the OMi credentials entered for the integration point.

If you receive an unclear error message with error code, this generally indicates a communication
problem. Check the communication with OMi.

A failed job will be repeated until the problem is fixed.

Step 5: Verify the SM-OMi downtime synchronization

setup

When you have set up the Downtime integration, you can perform the following tasks to see if you have
successfully set up your downtime synchronization.
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Task 1. Open a new change of a category that has the

final approval phase defined in SMIS

1. Click Change Management > Create New Change.

2. Select Hardware for example.

3. In the Affected CI field, choose a CI that has been synchronized. For example: adv-afr-desk-
101.

4. Set Scheduled Downtime Start and Scheduled Downtime End to a future time.

5. Select theConfiguration Item(s) Down checkbox.

6. Set other required fields.

7. Click Validation Accepted. If you are prompted to fill in more required fields, supply the required
information and click Validation Accepted again.

8. Click Request Authorization.

9. Click Save&Exit the change.

Task 2. Approve the change at the final approval phase

1. Click Change Management > Task Queue.

2. Search for the task that was created in Task 1 and click Close to close the task.

3. Click Change Management > Search Change and search for the change opened in Task 1.

4. Move the Change to the Change Approval phase by selectingRequest Authorization.

5. Log on to ServiceManager with user account Change.Approver.

6. Select Approval Inbox and search for the change created in Task 1.

7. Approve the change.
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Task 3. Create new format for the intClipDownTime table

1. Open the SM Windows client.

Note: This step can only be performed in the SM Windows client.

2. Enter fd into the search field to open the Forms Designer and click New.

3. Create a new format for the intClipDownTime table by using the FormWizard.

4. Add all fields to this format.

Task 4. Check the corresponding intClipDownTime

record

1. From DatabaseManager, open the format of the intClipDownTime table.

2. Click Search to see the record created for this downtime.

3. Check the External Status field:

External Status values Description

NULL The downtime is waiting for final approval, or the scheduler has not
proceeded this record yet.

0 (Canceled) The downtime is canceled before being implemented.

1 (Ready) The downtime has been approved and is ready to be synchronized to
UCMDB or BSM (RTSM).

2 (Withdrawn) The downtime is approved firstly and then the approval is retracted
(withdrawn).

Notes:

a. Only downtime records with External Status 1 can be synchronized.

b. If the External Status is not 1, wait some time for background schedulers SLA and
SMBSM_DOWNTIME to process this record.
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Task 5. Populate downtime from Service Manager to

UCMDB

1. From UCMDB, run the CLIP Down Time Population job and the CI To Down Time CI With
Connection job in a fixed order.

2. Search for the adv-afr-desk-101CI in UCMDB. Check that a corresponding Scheduled
Downtime CI is created, and a relationship between the Scheduled Downtime CI and the affected
CI is created.

Task 6. Test if BSM Downtime CIs have been created

1. In OMi, go toAdministration > Service Health > Downtime Management.

2. Check if a corresponding Downtime was created.

Sending downtime notifications from OMi to SM

(UCMDB)

OMi can send downtime start and end events to SM to notify operators of when a downtime occurs.
This provides additional information to the SM operator in case of a downtime that was not driven by an
RFC.

To create downtimes in OMi based on RFCs in SM, see "Downtime Forwarding from ServiceManager
to OMi (UCMDB)" on page 201.

Step 1: Send OMi Downtime Events to SM

To enable OMi to send downtime start and end events to SM, follow these steps:
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1. Access the following location in OMi:

Administration > Setup and Maintenance > Infrastructure Settings > Foundations >
Downtime

2. Change the value of theDowntime Send Event parameter to true.

3. Restart your OMi services on all Gateway Servers and Data Processing Servers.

This procedure generates events in OMi. After performing it, make sure you edit and enable the
Automatically forward "downtime started" and "downtime ended" events to Trouble Ticket
System event forwarding rule to forward downtime-start and downtime-end events to the SM server
that should be specified in the alias connected server called "Trouble Ticket System". For details on
event forwarding and connected servers, see theOMi Administration Guide.

Downtime events use the following formats:

l Downtime Start

Event field OMi Downtime

Severity Normal

Category Downtime Notification

Title Downtime for <CI Type><Affected CI Name>started at <Downtime Start Time>

Key <OMi Downtime ID>:<Affected CI ID>:downtime-start

SubmitCloseKey False

OutageStartTime <Downtime Start Time>

OutageEndTime <Downtime End Time>

CiName <Affected CI Name>

CiId <Affected CI Global ID>

CiHint GUCMDB:<Affected CI Global ID>|UCMDB:<Affected CI ID>

HostHint GUCMDB:<Related Host Global ID>|UCMDB:<Related Host ID>

EtiHint downtime:start

l Downtime End
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Event field OMi Downtime

Severity Normal

Category Downtime Notification

Title Downtime for <CI Type><Affected CI Name> ended at < Downtime End Time>

Key <OMi Downtime ID>:<Affected CI ID>:downtime-stop

SubmitCloseKey true

CloseKeyPattern <OMi Downtime ID>:<Affected CI ID>:downtime-start

EtiHint downtime:end

LogOnly true

View Changes and Incidents in OMi (UCMDB)

This integration enables you to view planned changes and incident details in the Changes and Incidents
and Hierarchy components in OMi.

This chapter includes the following:

l "Prerequisite" below

l "Step 1: Configure the ServiceManager Adapter Time Zone" on the next page

l "Step 2: Create an Integration Point in OMi" on the next page

l "Step 3: Edit Integration TQLs " on page 214

l "Step 4: Verify View changes and incidents" on page 215

l "How to Customize the Changes and Incidents Component" on page 216

Prerequisite

This integration requires that CIs are synchronized between UCMDB and SM. For information on CI
synchronization, see "Operations Manager i - ServiceManager Integration Overview" on page 93.

Out-of-the-box, OMi provides queries that are used to retrieve changes and incidents from SM. These
queries need to bemanually deployed to your UCMDB. On theOMi data processing server, go to
<OMi_Home>/odb/conf/factory_packages and find the Console.zip package. Copy the package to
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the local directory on your UCMDB system and use the UCMDB PackageManager to deploy the
console.zip package to the UCMDB.

This integration requires an administrator user account for OMi to connect to SM. This user account
must already exist in both OMi and SM. For details on creating required user accounts, see "Create
User Accounts for the OMi-SM Integration (UCMDB)" on page 168

Step 1: Configure the Service Manager Adapter Time

Zone

Configure the time zone so Incidents and Planned Changes have the correct time definitions:

1. In SM, select Navigation pane > Menu navigation > System Administration > Base System
Configuration > Miscellaneous > System Information Record. Open theData Info tab.

2. In theDate Info tab, look up the value for the Time Zone.

3. In OMi, select Administration > RTSM Administration > Data Flow Management > Adapter
Management.

4. In theResourceswindow, openServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/serviceDeskConfiguration.xml

Find the row that includes the following string:

<globalConnectorConfig><![CDATA[<global_configuration><date_pattern>MM/dd/yy
HH:mm:ss</date_pattern><time_zone>US/MOUNTAIN</time_zone>

Check the date and time format, as well as a time zone. Note that the date is case-sensitive.
Change either SM or the xml file so that they bothmatch each other's settings.

Note: Specify a time zone from the Java time zone list that matches the time zone used in
SM (for example, America/New York).

5. If you changed the time zone on SM, restart the SM server; if you changed the time zone onOMi,
you do not need to restart the OMi server.)

Step 2: Create an Integration Point in OMi

To create an integration point, follow these steps:
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1. In OMi, select Administration > RTSM Administration > Data Flow Management >
Integration Studio.

2. In the Integration Point pane, select Create New Integration Point or choose an existing
integration point to edit. The Create New Integration Point dialog box opens. Enter the following:

Name
Recommended
Value Description

Integration Name SM Integration The name you give to the integration point.

Adapter <user defined> Select Software Products > ServiceManager >
Service Manager 9.xx.

This adapter, which supports CI/ relationship
Data Push from RTSM to ServiceManager, and
Population and Federation from Service
Manager to RTSM.

Is Integration Activated selected Select this check box to create an active
integration point.

Hostname/IP <user defined> The name of the SM server.

Port <user defined> The port through which you access SM.

Credentials ID <user defined> Click Generic Protocol, click theAdd button
to add the integration user account you created
in "Create User Accounts for the OMi-SM
Integration (UCMDB)" on page 168 and then
select it.

Probe Name (for
ServiceManagerAdapter9-
x only)

<user defined> Select the probe that you installed for this
integration.

Note: It is recommended to click the Test Connection button to verify that the details
entered are working before continuing.

3. In the Integration Point pane, click the Integration Point you just created, and click the
Federation tab in the right pane.

4. In theSupported and Selected CI Types area, verify that Incident andRequestForChange are
selected.

Step 3: Edit Integration TQLs

In this step, edit the integration TQLs so that they use the Integration Point created in the previous step.
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1. In OMi, select Administration > RTSM Administration > Modeling > Modeling Studio.

2. On theResources tab, select Resource Type: Queries. Open theConsole folder.

3. Open the TQL: CollectRequestForChangeWithImpacts.

4. In theQuery Definition pane, right click one of the objects of CI Type: RequestForChange.

5. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.

6. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.

7. Open the TQL: CollectRequestForChangeWithoutImpacts.

8. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.

9. Open the TQL: CollectTicketsWithImpacts.

10. In theQuery Definition pane, right click one of the objects of CI Type: Incident.

11. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.

12. Repeat steps 10 and 11 for all objects of CI Type: Incident.

13. Open the TQL: CollectTicketsWithoutImpacts.

14. Repeat steps 10 and 11 for all objects of CI Type: Incident.

15. Save all TQLs.

Step 4: Verify View changes and incidents

To verify that you can view changes and incidents in OMi, make sure that you have an incident in SM
that is related to a CI in the OMi RTSM. To do so, send a test event related to a CI that has been
synchronized betweenOMi and SM.

1. Send an event, for example, by using the following command:

submitEvent -t testViewIncidents -rch <hintForExistingCI>

2. Select the event in the OMi Event Browser and select Transfer Control To in the Context Menu.
Select the SM target system.

3. Open the 360° View and select a view containing the related CI.

4. Select the CI, and verify that the Incident Count is at least 1. Click Incidents to show the
Changes in Incidents window, and verify that the incident is displayed in the Incidents section.
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By default, the Changes and Incidents component displays data for the previous week. You can
change this setting to previous week, day, or hour (up to the current time) by using the Configure
Component button.

How to Customize the Changes and Incidents Component

By default, incidents and requests for change are displayed for the following CI types: Business
Service, Siebel Application, Business Application, and Node. If you want to view change and incident
information for other CITs, perform the following procedure:

1. Open theModeling Studio:

Administration > RTSM Administration > Modeling > Modeling Studio

Copy one of the TQLs within theConsole folder, and save your copy with a new name. These
default TQLs perform the following:

TQL name Description

CollectTicketsWithImpacts Retrieves SM incidents for the selected CI, and
for its child CIs which have an Impact
relationship.

CollectTicketsWithoutImpacts Retrieves SM incidents for the selected CI.

CollectRequestForChangeWithImpacts Retrieves SM requests for change, for the
selected CI, and for its child CIs which have an
Impact relationship.

CollectRequestForChangeWithoutImpacts Retrieves SM requests for change, for the
selected CI.

2. Edit the new TQL as needed. You can add CITs as described in "Naming Constraints for New
Request for Change TQLs" on the next page.

3. Open Infrastructure Settings:

Administration > Setup and Maintenance > Infrastructure Settings

a. Select Applications.

b. Select Service Health Application.

c. In theService Health Application - Hierarchy (360) properties area, enter the name of the
new TQL you created in the corresponding infrastructure setting.
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Note: By default, these infrastructure settings contain the default TQL names. If you enter a
TQL name that does not exist, the default value will be used instead.

After youmodify the infrastructure setting, the new TQL will be used, and the Changes and Incidents
component will show this information for the CITs you defined.

Naming Constraints for New Request for Change TQLs

The following naming constraints must be followed in the request for changewithout impact TQL (see
the TQL example below, on the right side of the image):

l The request for change CI typemust start with directPlannedChange.

l The CI type related to the request for changemust start with trigger.

The following naming constraints must be followed in the request for changewith impact TQL (see the
TQL example below, on the left side of the image):

l impacterPlannedChange represents the request for change CI type.

l The CI type related to the request for changemust start with impacter.

l triggerITUniverse represents the "impacted" child CIs.

Examples of request for change TQLs:
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Naming Constraints for New Incident TQLs

The following naming constraints must be followed in the incidents without impact TQL (see the TQL
example below, on the right side of the image):

l The incident CI typemust start with directITIncident.

l The CI type related to the incident must start with trigger.

The following naming constraints must be followed in the incidents with impact TQL (see the TQL
example below, on the left side of the image):

l impacterITIncident represents the incident CI type.

l The CI type related to the incident must start with impacter.

l triggerITUniverse represents the "impacted" child CIs.

Examples of incident TQLs:

Business Impact Report (BIR) (UCMDB)

OMi includes a report that you can use to help evaluate the impact of incidents on your business. For
example, if a host CI has critical status, you can use the report to display the status of the Business
Service CIs to which the host CI is attached.
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Incident Management users can launch an impact report from an incident in context with the incident's
affected configuration item (CI). Service Desk Agents can validate the updated status of the business
impact to categorize and prioritize the incident accordingly.

Note:
l This integration requires that CIs are synchronized between both ServiceManager andOMi.

l Only one instance of this integration is allowed.

Step 1: Add a Business Impact Report Integration in SM

To use the ServiceManager to BIR integration, youmust add and enable an instance of this integration
in IntegrationManager.

To add and enable a ServiceManager to BIR integration instance:

1. Click Tailoring > Integration Manager. Integration InstanceManager opens.

2. Click Add. The Integration Template Selection wizard opens.

3. Select SMBIR from the Integration Template list. Ignore the Import Mapping check box, which
has no effect on this integration.

Note: Only one instance of this integration is allowed. If an instance of this integration
already exists in IntegrationManager, theSMBIR template is unavailable. You have to delete
the existing integration instance before you can add a new one.

4. Click Next. The Integration Instance Information page opens.

5. Update the following fields:

Note: Only Name andVersion are required fields. This integration does not use the Interval
Time (s) andMax Retry Times fields as it is UI-based.

Field Value

Name (Required) The name of the integration instance.

Default: SMBIR

Version (Required) The version of the integration template.

Default: 1.0

SM Server The name of the ServiceManager server machine.
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Field Value

Endpoint
Server

The name of the OMi Server machine.

Log Level Select one from: DEBUG, INFO (default), WARNING, ERROR, andOFF.

Log File
Directory

A directory on the ServiceManager Server machine in which log files will be
stored.

Description If you want, modify the default description of the instance.

Run at
system
startup

Select this check box only if you want this instance to be automatically enabled
when the ServiceManager Server is started.

6. Click Next. The Integration Instance Parameters page opens.

7. On theGeneral Parameters tab, replace "BSM_host" in the baseurl parameter with the
hostname of the real OMi server.

8. Click Next twice and then click Finish. Leave the Integration InstanceMapping and Integration
Instance Fields settings blank. This integration does not use these settings.

ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

9. Enable the integration instance.

Step 2: Launch a Business Impact Report from an

Incident

To launch a Business Impact Report from an incident:

1. Log on to the ServiceManagerWeb client.

2. From Incident Management, search for an incident record and open it.

3. Click More and then select Launch Business Impact Report. TheOMi Business Impact
window opens, showing the KPI over time data for the related CI and related business services.
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Customizing the Service Manager Integration

The ServiceManagerAdapter groovy script is provided for Event Forwarding to ServiceManager. You
can customize this script for your installations.

To customize the ServiceManagerAdapter groovy script, open the Scripts manager ( ), select the

sm:ServiceManagerAdapter script and open it for editing ( ). The Edit Script window opens. The

contents of the script are displayed in theScript tab.

Tip: Copying the script text into a text editor of your choice. When you have finished editing, copy
the edited text back to the Edit Script window and save the script.

Near the beginning of the script, there are two sections used tomodify the default behavior of the OMi
event synchronization with ServiceManager.

To access

Administration > Setup and Maintenance > Connected Servers

Click the button.

Configuring the ServiceManagerAdapter Script

This section controls which event and incident properties are synchronized to and from Service
Manager, and is contained within the following comments:

l BEGIN Configuration: Customization of properties for synchronization

l END Configuration: Customization of properties for synchronization

The ServiceManagerAdapter script can be configured section contains constants, 6 "maps" and "8"
sets to allow configuring the synchronization of the properties. Each is described below:

Service Manager Drilldown Constant

The first variable that can be adjusted is SM_WEB_TIER_NAME. Set this value to the base name of the
web application deployed in the Tomcat container on the ServiceManager system. This web
application is used for drilling down into ServiceManager. The name is used in the URL path for the drill
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down. It must match the base name of the web application (".war" is removed). The default is shown
below:

private static final String SM_WEB_TIER_NAME = 'webtier-9.30'

OMi Administrator User

The BSM_ADMINISTRATOR_LOGIN_NAME variable is used to contain the name of the OMi Administrator
user. By default this is set to admin.

For the events that are forwarded automatically by a forwarding rule, the _is_recorded_by attribute is
set to the user specified in the BSM_ADMINISTRATOR_LOGIN_NAME variable.

For the events that are forwardedmanually, the _recorded_by attribute is set to the user that initiated
the forward request.

private static final String BSM_ADMINISTRATOR_LOGIN_NAME = 'admin'

Enumeration Value Maps

Maps are defined tomap enumerated values of the event properties to values on ServiceManager
incident properties. Thesemaps, in general, may not be customized, but they provide a list of possible
values that can be specified in the sets described below. For details on eachmap, view the actual
values defined in the script.

l MapOPR2SMStatus: Maps the event state to the ServiceManager incident status

l MapSM2OPRState: Maps the ServiceManager incident status to the event state

l MapOPR2SMUrgency: Maps the event severity to the ServiceManager incident urgency

l MapSM2OPRSeverity: Maps the ServiceManager incident urgency to the event severity

l MapOPR2SMPriority: Maps the event priority to the ServiceManager incident priority

l MapSM2OPRPriority: Maps the ServiceManager incident priority to the event priority

Custom Property Maps

The followingmaps allow a user to map any top-level event property to any top-level ServiceManager
incident property.

l MapOPR2SMCustomAttribute: Maps the specified custom attributes to a ServiceManager
incident property for synchronization.
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Add a CA name to themap along with a ServiceManager incident property name (XML tag name).

Target ServiceManager Incident property name of "activity_log" will append the CA change to the
ServiceManager incident activity log.

Note: Only top-level ServiceManager incident properties are supported in this map.

l MapSM2OPRCustomAttribute: Maps the specified ServiceManager incident properties to an
event custom attribute for synchronization.

Add a ServiceManager incident property name to themap along with an event custom attribute
name.

Note: Only top-level ServiceManager incident properties are supported in this map.

Examples:

The following synchronizes the event custom attribute MyCustomCA to the ServiceManager
incident activity_log and the custom attribute MyCustomCA1 to the ServiceManager incident
property SMCustomAttribute.

private static final Map<String, String> MapOPR2SMCustomAttribute =
["MyCustomCA" : "activity_log", "MyCustomCA1" : "SMCustomAttribute"]

The following synchronizes the ServiceManager incident property incident_status to the custom
attribute SMIncidentStatus.

private static final Map<String, String> MapSM2OPRCustomAttribute = ["incident_
status" : "SMIncidentStatus"]

Synchronization Change Sets

The following sets define which properties and enumerated values are synchronized whenever a
change occurs in the OMi event or ServiceManager incident. The properties synchronized upon a
change as standard aremarked in bold. For each list, the value of "*" can be specified. In this case, all
possible properties or enumerated values are synchronized for the specified list.

Note: When the ServiceManager incident is created, all possible event properties and
enumerated values are set in the ServiceManager incident. The following sets aremainly used for
synchronization of changes.
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SyncOPRPropertiesToSM

Event properties to synchronize to a corresponding ServiceManager Incident property on change:

l title

l description

l state

l severity

l priority

l solution

l assigned_user

l assigned_group

SyncOPRPropertiesToSMActivityLog

Event properties to synchronize to a corresponding ServiceManager Incident activity log on change:

l title

l description

l state

l severity

l priority

l solution

l annotation

l duplicate_count

l custom_attribute

l cause

l symptom

l control_transferred_to

l assigned_user

l assigned_group
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SyncSMPropertiesToOPR

ServiceManager Incident properties to synchronize to a corresponding event property on change:

l name

l description

l incident_status

l urgency

l priority

l solution

SyncOPRStatesToSM

Event states to synchronize to the ServiceManager incident status on change:

Note: statemust be included in SyncOPRPropertiesToSM or this list is ignored.

l open

l in_progress

l in_progress

l resolved

l closed

SyncOPRSeveritiesToSM

Event severities to synchronize to the ServiceManager incident urgency on change:

Note: severitymust be included in SyncOPRPropertiesToSM or this list is ignored.

l critical

l major

l minor

l warning

l normal

l unknown
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SyncSMStatusToOPR

ServiceManager incident status to synchronize to the event states on change:

Note: statusmust be included in SyncSMPropertiesToOPR or this list is ignored.

l accepted

l assigned

l open

l reopened

l pending-change

l pending-customer

l pending-other

l pending-vendor

l referred

l suspended

l work-in-progress

l rejected

l replaced-problem

l resolved

l cancelled

l closed

SyncSMUrgenciesToOPR

ServiceManager incident urgencies to synchronize to the event severities on change:

Note: urgencymust be included in SyncSMPropertiesToOPR or this list is ignored.

Acceptable values are 1-4.

SyncSMPrioritiesToOPR

ServiceManager incident priorities to synchronize to the event priorities on change:
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Note: prioritymust be included in SyncSMPropertiesToOPR or this list is ignored.

Acceptable values are 1-4.

Examples:

The following example synchronizes the OMi title, state and description to the ServiceManager
incident whenever the corresponding property is changed in the OMi event.

private static final Set SyncOPRPropertiesToSM = ["title", "state", "description"]

The following example will synchronize the OMi states resolved and closed to the ServiceManager
incident whenever the corresponding property is changed in the OMi event.

private static final Set SyncOPRStatesToSM = ["resolved", "closed"]

Note: The properties that are synchronized to the ServiceManager activity log are concatenated
together for each change and then appended to the ServiceManager incident activity log.

Localization

This section is provided to enable localizing some of the text that is displayed in the:

l The Event Browser Forwarding tab (not available for an Event Channel deployment)

l ServiceManager incident activity log

This sections is contained within the following comments:

l BEGIN Localization: Customization of text values for language localization

l END Localization: Customization of text values for language localization

The following sections describe the text that can be localized.

Forwarding tab

The ServiceManager incident properties urgency and priority are of type integer. In order to display a
moremeaningful value in the Forwarding tab, maps are provided to display a string. These strings may
be localized for display in the browser.

l Service Manager Urgency values

The text value will be displayed on the Forwarding tab.
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Note: This text may be localized for the desired locale.

privatestaticfinal Map SMUrgency = ["1": "1 - Critical", "2": "2 - High", "3":
"3 - Average", "4": "4 - Low"]

l Service Manager Priority values

The text value will be displayed on the Forwarding tab.

Note: This text may be localized for the desired locale.

privatestaticfinal Map SMPriority = ["1": "1 - Critical", "2": "2 - High", "3":
"3 - Average", "4": "4 - Low"]

Service Manager Incident Activity Log

Synchronization from OMi to ServiceManager appends various text to the ServiceManager incident
activity log. This text may be localized as follows.

l General Locale Setting: Usedmainly in formatting of dates. May be changed, for example to
Locale.JAPAN. See Java Locale class documentation for all possible values.

private static final Locale LOCALE = Locale.getDefault()

l Annotation date format: See JavaSimpleDateFormat class documentation for details on the
syntax. Script default is below.

private static final String ANNOTATION_DATE_FORMAT = "yyyy.MM.dd HH:mm:ss z"

l Description: In ServiceManager the incident description is a required attribute. In case it is not set
in OMi this value is taken. An empty string is NOT allowed.

private static final String EMPTY_DESCRIPTION_OVERRIDE = "<none>"

l Log Text: The following text is prefixed to the appropriate event property when synchronizing it to an
ServiceManager Incident activity log.

NOTE: This text may be localized for the desired locale. Defaults are as shown below.

private static final String ACTIVITY_LOG_TITLE = "[Title]\n"

private static final String ACTIVITY_LOG_TITLE_CHANGE = "Event title changed to:
"

private static final String ACTIVITY_LOG_STATE = "[State]\n"
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private static final String ACTIVITY_LOG_STATE_CHANGE = "Event state changed to:
"

private static final String ACTIVITY_LOG_DESCRIPTION = "[Description]\n"

private static final String ACTIVITY_LOG_DESCRIPTION_CHANGE = "Event description
changed to: "

private static final String ACTIVITY_LOG_SOLUTION = "[Solution]\n"

private static final String ACTIVITY_LOG_SOLUTION_CHANGE = "Event solution
changed to: "

private static final String ACTIVITY_LOG_ASSIGNED_USER = "[Assigned User]\n"

private static final String ACTIVITY_LOG_ASSIGNED_USER_CHANGE = "Event assigned
user changed to: "

private static final String ACTIVITY_LOG_ASSIGNED_GROUP = "[Assigned Group]\n"

private static final String ACTIVITY_LOG_ASSIGNED_GROUP_CHANGE = "Event assigned
group changed to: "

private static final String ACTIVITY_LOG_SEVERITY = "[Severity]\n"

private static final String ACTIVITY_LOG_SEVERITY_CHANGE = "Event severity
changed to: "

private static final String ACTIVITY_LOG_PRIORITY = "[Priority]\n"

private static final String ACTIVITY_LOG_PRIORITY_CHANGE = "Event priority
changed to: "

private static final String ACTIVITY_LOG_CONTROL_TRANSFERRED_TO = "[Control
Transferred To]\n"

private static final String ACTIVITY_LOG_CONTROL_TRANSFERRED_TO_CHANGED = "Event
control transfer state changed to: "

private static final String ACTIVITY_LOG_ANNOTATION = "[Annotation]\n"

private static final String ACTIVITY_LOG_CA = "[Custom Attribute]\n"

private static final String ACTIVITY_LOG_CAUSE = "[Cause] "

private static final String ACTIVITY_LOG_OMI_CAUSE = "[OMi Cause] "

private static final String ACTIVITY_LOG_OMI_SYMPTOM = "[OMi Symptom] "

private static final String ACTIVITY_LOG_DUPLICATE_COUNT = "[Duplicate Count] "
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private static final String ACTIVITY_LOG_PREVIOUS = "previous "

private static final String ACTIVITY_LOG_CURRENT = "current "

Mapping Table: OMi Event to BDM Incident Property

The standard integration synchronizes the following OMi Event properties to ServiceManager Incident
properties:

OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

- - - global_id id - There is no
mapping and
no
synchronizatio
n for global_
id between an
OMi event and
a Service
Manager
incident.

ID - id external_
process_
reference

external.proces
s.
reference

- Set only on
Service
Manager
incident
creation.

- External ID control_
transferre
d_to
external_id

referenc
e_number

number Incident ID Set only on
Service
Manager
incident
creation.

Title - title name brief.descriptio
n

Title Set on incident
creation.
Standard
configuration:
only the OMi
title changes
are
synchronized
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

to the Service
Manager
incident
activity log. If
the event title
exceeds 256
characters, or
contains a
newline
character, it is
truncated and
the entire title
is prepended
to the
description.

Description - description descriptio
n

action Descriptio
n

Can be a
combination of
the OMi event
title and
description.
See title
comments for
details.
Standard
configuration:
synchronized
in both
directions.

Solution - solution solution Resolution Solution Standard
configuration:
synchronized
in both
directions.

Lifecycle
State

- state incident_
status

problem.status Status Set on incident
creation.
Standard
configuration:
only 'closed'
state is
synchronized.
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

Severity Severity severity urgency severity Urgency Set on incident
creation.
Standard
configuration:
all value
changes are
synchronized.

Priority Priority priority priority priority.code Priority Set on incident
creation.
Standard
configuration:
all value
changes are
synchronized.

Assigned
User

- assigned_
user
login_
name

is_
requeste
d_by
party
display_
label

contact.name Contact By default not
synchronized.

- Assigned
User

- has_
assigned
party
display_
label

assignee.name Assignee OMi queries
the Service
Manager
Incident Web
Service in real
time for
display in
Forwarding
Tab only. No
synchronizatio
n between the
OMi event and
the Service
Manager
incident.

- - control_
transferre
d_to
initiated_
by

is_
recorded_
by
party
display_

opened.by Opened
By

By default not
synchronized.
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

label

Assigned
Group

Assigned
Group

assigned_
group
name

has_
assigne
d_group
functiona
l_group
display_
label

assignment Assignme
nt Group

OMi queries
the Service
Manager
Incident Web
Service in real
time for
display on the
Forwarding
tab only. No
synchronizatio
n between the
OMi event and
the Service
Manager
incident.

Category - category category sub_category Area Category is
set by OMi
only on
Service
Manager
incident
creation, but is
by default
ignored in
Service
Manager.

Subcategor
y

- sub_
category

sub_
category

product_type Subarea Subcategory
is set by OMi
only on
Service
Manager
incident
creation, but is
by default
ignored in
Service
Manager.

Related CI - related_ci is_
registere

logical.name Affected
CI

Affected CI is
set by OMi
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

d_for only on
Service
Manager
incident
creation.

Annotation
s

- annotatio
n_list

activity_
log
descriptio
n

update.action Activity
Log

Synchronized
from OMi to
Service
Manager only.
OOTB
synchronizatio
n enabled.

Custom
Attributes

- custom_
attribute_
list

activity_
log
descriptio
n

update.action Activity
Log

Can be
configured for
synchronizatio
n to a specific
Service
Manager
incident
property, or
the activity
log. For
Service
Manager
activity log,
synchronizatio
n is from OMi
to Service
Manager only.
Standard
configuration:
synchronizatio
n disabled.

Cause - cause->
control_
transferre
d_to
external_id

is_
caused_
by
-master_
referenc
e_number

Links the two
SM Incidents

Related
Records

If the cause
event has
been
synchronized
to Service
Manager, the
two Service
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OMi UI
(Event)

OMi UI
(Forwardin
g )

OMi Web
Service
(Event)

Service
Manager
Web
Service
(Incident)

Service
Manager
Object

Service
Manager
UI Comments

Manager
Incidents are
related,
otherwise
information
about the OMi
cause is
appended to
the Service
Manager
incident
activity log.
Standard
configuration:
synchronizatio
n enabled.

Symptoms - symptom_
list

activity_
log
descriptio
n

update.action Activity
Log

Synchronizati
on is from OMi
to Service
Manager only.
Standard
configuration:
synchronizatio
n enabled.

Duplicate
Count

- duplicate_
count

activity_
log
descriptio
n

update.action Activity
Log

Synchronizati
on is from OMi
to Service
Manager only.
Standard
configuration:
synchronizatio
n enabled.
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Chapter 24: Operations Manager i - Network
Node Manager i Integration Overview
Tip: The following is a high-level overview of the Operations Manager i - Network NodeManager i
(NNMi) integration. You can find comprehensive details on NNMi integrations in theNetwork Node
Manager i Software—Business ServiceManagement/Universal CMDB Topology Integration
Guide.

You can integrate NNMi with OMi to provide the following capabilities:

l NNMi topology > OMi RTSM topology. The topology integration populates the OMi RTSMwith
the NNMi network topology. OMi stores each device, interface, IP address, and a few other
artifacts in the NNMi network topology as a CI and includes it in the relevant views.

l NNMi events > OMi events. NNMi events are displayed in the Event Browser in OMi. You can
also access the NNMi console from theOMi Event Browser. The NNMi events are sent to OMi by
using the Operations Connector.

This integration has item ID 344 in the Integrations Catalog at the following location:

https://softwaresupport.hpe.com/km/KM01694988

l NNMi events > OMi health indicators. After you have set up the integration, if the NNMi events
have corresponding health indicators defined, these health indicators affect the status of relevant
CIs in OMi applications, such as Service Health.

l OMi > NNMi drill down. In OMi, you can configure a link to the NNMi management server that
enables you to drill down fromMy Workspace and other locations to NNMi, to view trace route
information between the client and the destinationmachine. You can also use URL tools to launch a
browser that enables you to connect to the NNMi management server and further analyze incoming
events in NNMi.

In addition, certain NNMi user interface components (network maps, items, detailed information
dialogs, and so on) can be displayed directly inWorkspaces > My Workspace.

Note: If the NNMi topology is not synchronized with the OMi RTSM topology, theMonitored by
property of the OMi CIs corresponding to the NNMi CIs is empty, and these CIs are not displayed
in the SystemMonitors only Perspective, System HardwareMonitoring, and System Software
Monitoring views.
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Chapter 25: How to Integrate Network Node
Manager i with Operations Manager i
This chapter describes how to integrate NNMi with OMi.

1. Prerequisite

Make sure you have theOMi and NNMi licenses installed. For details, see theOMi Administration
Guide.

2. Perform the integration in NNMi

Perform the steps needed to integrate NNMi with OMi in the NNMi application.

For details, see theNetwork NodeManager i Software—Business Service
Management/Universal CMDB Topology Integration Guide.

3. Configure LW-SSO in both OMi and NNMi

To be able to seamlessly switch between NNMi andOMi, it is recommended to use LW-SSO.
Make sure that LW-SSO is configured in both OMi and NNMi with the same initString. For details
on how to configure the initString in OMi, see theOMi Administration Guide. For details on how to
configure the initString in NNMi, see theNNMi Deployment Reference.

It is also possible to integrate NNMi with OMi without using LW-SSO. In this case, you are
prompted for a password every time you switch to an NNMi component.

4. Connect NNMi to more than one OMi instance

After connecting the first OMi instance to NNMi, NNMi stores in its own database the CI IDs
gained from the topology synchronization of the OMi's RTSM. When another OMi instance is
connected, another topology synchronization is carried out. As the OMi instances might contain
some of the sameCI IDs, the IDs need to be reconciled in the NNMi database. This reconciliation
works only partially and the NNMi log files still include several reconciliation errors that are caused
by the non-existing RTSM IDs. To fix the problem, perform the following steps:

a. Change the integration to the new OMi system.

b. Log on to the NNMi JMX console http://<NNMi_fqdn_and_port>/jmx-console using the
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system account and password.

c. Go tombean NnmBsmModule.

d. Run java.lang.String resetNnmBsmIds().

You should see a list of devices from which the RTSM ID was removed.

e. Disable and enable the topology integration to get the CIs into RTSM.

5. Configure OMi to display NNMi data

To display NNMi data in OMi and to access the NNMi components inWorkspaces > My
Workspace:

a. Open Infrastructure Settings:

Administration > Setup and Maintenance > Infrastructure Settings

b. Select Foundations.

c. Select Integrations with other applications.

d. In the Integrations with other applications - HP NNM table, locate andmodify the
following parameters:

l HP NNM Integration URL. The NNMi host and port number (protocol://host:port/nnm).

l HP NNM User name. The user name that is used for logging on to NNMi.

l HP NNM User password. The user password that is used for logging on to NNMi.

6. Results

You can view NNMi data inWorkspaces > My Workspace, as described in "NNMi Components
in My Workspace" on page 240.
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Chapter 26: NNMi Components in My
Workspace
If you set up an integration between NNMi andOMi, you can view the NNMi components described
below inWorkspaces > My Workspace as follows:

Note: Make sure you have a View Explorer component configured in addition to the new NNMi
component. The View Explorer component pulls the node information needed by the NNMi
component. For more information on the View Explorer component, see theOMi User Guide.

1. Click theNew Page icon.

2. Click Add Component. The Component Gallery window opens.

3. In All Categories, select theNNMi check box.

To access the NNMi components, youmust have the appropriate licenses installed. NNMi
components are only displayed if you configured a connection to an NNMi server in Infrastructure
Settings:

Administration > Setup and Maintenance > Infrastructure Settings

Select Foundations > Integrations with other applications > HP NNM.

Component
Name Description

Layer 2
Neighbor
View

Shows amap view of a selected device and its connector devices within a
specified number of hops from the selected device. This view is useful for
understanding the switch connectivity between devices.

Layer 3
Neighbor
View

Shows amap view of a selected device and its connector devices within a
specified number of hops from the selected device. This view is useful for
understanding the router connectivity between devices.

MPLS VPN
Inventory

This is an enterprise customer view of how their sites are connected via service
providedMPLS networks.

Open Key
Incidents

Shows the incidents that aremost important to network operators and that often
require more immediate action.

Overall
Network
Health (Node
Group

Displays amap containing all (top-level) NodeGroups that do not have parent Node
Groups.
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Component
Name Description

Overview)

Overall
Network
Health -
Routers

Displays a NodeGroupMap of the Router connectivity in your network.

Overall
Network
Health -
Switches

Displays a NodeGroupmap of the Switches connectivity in your network.

Router
Redundancy
Groups
Inventory

Shows the available Router Redundancy Groups created by the NNMi
administrator. Each Router Redundancy Group is a set of two or more routers that
use one or more virtual IP addresses to help ensure that information packets reach
their intended destination.
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Chapter 27: Operations Manager i - Operations
Orchestration Integration Overview
HPE Operations Orchestration (OO) provides a simple way for customers to run scripts for automatic
actions. The integration with OMi uses the OO capabilities for building investigation tools or service
remediation scripts, providing the operators with a simple way to validate a problem, investigate it, or
automatically correct it. A run book can be executedmanually.

OO run books can be launched from the Service Health and Event Browser applications.

The integration of OMi andOO provides the capability of mapping CI types to OO run books.

After you create suchmappings, you can run themappedOO run books:

l On CIs, by using the Invoke Run Books context menu option in Service Health. TheOO run
book parameters are populated by using themap to the CI attributes defined in the Run Book
Mapping Configuration wizard. For detailed information about the wizard, see theOMi
Administration Guide.

l At the event level. OMi opens an event and checks if the CI for this event has a run book assigned
to it, and if the run book is set to run automatically. TheOO run book parameters are populated by
using themap to the CI or event attributes defined in the Run Book Mapping Configuration wizard.
For detailed information about the wizard, see theOMi Administration Guide.
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Chapter 28: How to Integrate Operations
Manager i and Operations Orchestration
This chapter describes how to integrate OMi andOO.

1. Prerequisites

Before you configure the integration, the OO administrator needs to perform the following:

a. Enable user authentication and create an integration user with theAdministrator role:

l OO version 10.02 or higher: The user must be internal.

l OO 9.xx: The user must be external.

Users must have the following capabilities in OO: AUTHOR, SCHEDULE, MANAGE_
RUNS, RUN_REPORTS, and HEADLESS_FLOWS. You can either add users to groups
with these capabilities (for example, the administrator group has these capabilities) or you
can create such a group.

b. Deploy the following OOContent Packs (CPs) on the OO server: Base,Middleware, and
Operating Systems. For OO version 10.50 and higher, also deploy the Third-party content
pack.

First deploy theBaseCP, and then the other CPs.

For details on how to deploy CPs in OO, see theOO documentation.

Note: If you have upgraded to a newer OO version, youmust also upgrade theOO
Content Packs. For more information on Content Packs, see the HPOO documentation.

c. If you want to configure run book automation in a set up with a load balancer and a firewall,
ensure that port 8443 is open. If port 8443 is not open, the automatic run book execution will
fail. TheAutomatic Run Book Execution is triggered from the data processing server.

2. Configure the link between OMi and OO

To configure the integration betweenOMi andOO, in OMi:

a. Open Infrastructure Settings:

Administration > Setup and Maintenance > Infrastructure Settings

b. Select Foundations.

HPE Operations Manager i (10.60) Page 244 of 272



c. Select Integrations with other applications.

d. In theHPE Operations Orchestration table, locateOperations Orchestration application
server version. If you are using OO version 9.x, select OO 9, and if you are using OO version
10.x, select OO 10.

e. LocateOperations Orchestration application URL, andmodify the setting to the URL used
to access the OO application.

When connecting anOMi instance that employs Lightweight Single Sign-On (LW-SSO) toOO
version 10.02 or higher, youmust specify the connection URL of OO using the following
format: <protocol>://<FQDN>:<portNumber> (for example, http://lab.lab:8080). The port
can be 8080 for HTTP or 8443 for HTTPS, according to your needs. ForOO 9.xx, use:
https://<fully qualified server name>:8443.

If you want to enable run books to be invoked automatically, youmust enter a User Name and
Password in the same table. In this case, the user should be defined as internal in OO.

f. OO 9.xx only: To be able to invoke run books automatically, the user must be internal.

3. Configure LW-SSO authentication

Configure LW-SSO authentication betweenOMi andOO. Youmust configure LW-SSO in both
OMi andOO. Proceed to the relevant section depending on your version of OO.

For OO version 9.05 or lower:

a. Make sure Single Sign-On for OMi is enabled (it is disabled by default). In OMi, open
AuthenticationManagement:

Administration > Users > Authentication Management

In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor
panel. In the Single Sign On Editor panel, select Lightweight.

Copy the Token Creation Key (initString) to OO, and replace, in OO, all the initStrings in the
lwssofmconf.xml file located in the <OO installation directory>\Program Files\Hewlett-
Packard\Operations Orchestration\Central\conf\ directory.

b. In OO, in theweb.xml and applicationContext.xml files located in the
<OO installation directory>\Program Files\Hewlett-Packard\
Operations Orchestration\Central\WEB-INF\ directory, enable all filters andmappings
between LWSSO_SECTION_BEGIN and LWSSO_SECTION_END.

c. If OO andOMi are in different domains in theWindows operating system, youmust make sure
that the Trusted Hosts/Domains parameter is the same in OO andOMi. To set the
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parameter in OMi, open AuthenticationManagement:

Administration > Users > Authentication Management

In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor
panel. In the Single Sign On Editor panel, select Lightweight.

Configure the Trusted Hosts/Domains parameter in the field available when you select
Domain

d. Restart the following OO services:

l For OO version 9.02 or lower: RSCentral, RSJRAS, andRSScheduler.

l For OO version 9.03, 9.04, or 9.05: RSCentral andRSJRAS.

Note: If you need to enable logging for debugging LW-SSO: In OO, in the <OO installation
directory>\jetty\resources\log4j.properties file, uncomment the line that appears under the
LW-SSO comment.

For OO version 9.06 or higher:

a. Make sure Single Sign-On for OMi is enabled (it is disabled by default). In OMi, open
AuthenticationManagement:

Administration > Users > Authentication Management

l In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor
panel.

In the Single Sign On Editor panel, select Lightweight.

l Copy the Token Creation Key (initString).

l Add the domain where your OMi andOO systems are located to the Trusted
Hosts/Domains section.

l Click Save.

b. In OO, access the following:

l For OO version 10.20 or higher, select System Configuration > Security > SSO.

l For OO version 10.02 or higher (except version 10.20), select System Workspace >
Security > SSO.

l For OO version 9.xx, select Administration > System Configuration >
Authentication.

c. For OO version 9.2x, select theEnable Authentication check box in the LW SSO Settings
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area.

d. Replace the value of the LW SSO passphrase or the InitString parameter with the Token
Creation Key you copied from OMi. (This must have the same value on all OMi instances that
are integrated by using LW-SSO.)

e. Define domain-related parameters in the LW SSO Settings area:

l Domain. The domain of the OO server.

l Protected Domains. List of comma-separated domains used by the OMi instances that
employ LW-SSO.

Note: If OO andOMi are in different domains in theWindows operating system, make
sure that the Trusted Hosts/Domains parameter is the same in OO andOMi.

In OMi, open AuthenticationManagement:

Administration > Users > Authentication Management

In the Single Sign-OnConfiguration section, click Edit to open Single Sign On Editor
panel. In the Single Sign On Editor panel, select Lightweight.

Configure the Trusted Hosts/Domains parameter in the field available when you select
Domain

Note: Limitation with OO versions 10.02 to 10.22 and OMi

TheOMi integration with the OO versions 10.02 to 10.22 (inclusive) is only supported if OO
andOMi are in the same domain. If they are in different domains, the integration fails.

For further details on configuring LW-SSO in OO, see theOO documentation.

For further details on configuring LW-SSO in OMi, see theOMi Administration Guide.

4. Export server certificates from OO

To export server certificates from OO and import them into OMi in aWindows or Linux
environment, use the keytool utility, which is included in JRE.

For OO 9.xx:

a. On theOO server, enter:

l Windows:
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[OO install folder]\jre1.6\bin\keytool -keystore "[OO install folder]\Central\conf\rc_
keystore" -export -alias pas -file "<path>\<Operations Orchestration fully qualified
host name>.cer"

l Linux:

keytool -keystore "$ICONCLUDE_HOME/Central/conf/rc_keystore" -export -alias
pas -file "<path>/<Operations Orchestration fully qualified host name>.cer"

b. When prompted for a password, enter bran507025.

For OO version 10.02 or higher

a. On theOO server, enter:

l Windows:

[OO install folder]\java\bin\keytool.exe -keystore "[OO install folder]
\central\var\security\key.store" -export -alias tomcat -file "<path>\<Operations
Orchestration fully qualified host name>.cer"

l Linux:

keytool -keystore "$ICONCLUDE_HOME/central/var/security/key.store" -export -
alias tomcat -file "<path>/<Operations Orchestration fully qualified host
name>.cer"

b. When prompted for a password, enter changeit.

5. Import OO server certificates to OMi

Import the server certificate from theOO server to the OMi Gateway Server so that the two
systems can communicate with each other securely.

a. Import the Server Certificate to OMi. To import the server certificate you exported from OO
to the OMi cacerts keystores, on the OMi Gateway Server and Data Processing Server:

Enter the following commands:

opr-cert-mgmt.[bat|sh] -import <alias> <path>

Note: Formore information on the opr-cert-mgmt tool, see the OMi Extensibility Guide.

b. Restart OMi on the Gateway server.

c. To prevent a certificate error, make sure that this certificate is imported as a trusted root
certification authority on any browser that will be accessing OMi.
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The procedure for importing the certificate may vary slightly depending on the type of browser
that you are using. For example, if you are using Internet Explorer, follow these steps:

i. Click Tools > Internet Options > Content > Certificates.

ii. In the Trusted Root Certification Authorities tab, click the Import... button.

iii. Click Next to start the Certificate Import Wizard.

iv. Specify the file you want to import, and then click Next.

v. Select thePlace all certificates in the following store radio button, and then click
Browse.

vi. Select Trusted Root Certification Authorities, and then click Next.

vii. Click Finish.

Note: Repeat the above steps on the Data Processing Server as well.

6. Grant permissions

Grant permissions so that users can create, view, andmodify themapping betweenOMi CI types
andOO run books, and invokeOO run books from OMi.

To integrate with OO, youmust set up users in OMi with specific permissions. Navigate to:

Administration > Users > Users, Groups, and Roles

Select the user or create a new user and grant them a role withOperations Orchestration
Integration permissions.

When setting up the users, keep inmind the following:

o Set up an integration user with the same name in OMi andOO (for example, OMiOO_integr_
user).

Note: The username in OO should have all lowercase letters. If users with the same
username but different case sensitivity exist in OO, the lowercase username is used.

o In OMi, the user must have the following permissions to execute Run Books:

l TheOperations Console > Run Book Execution permission.

l TheAdvanced RTSM Permissions > Resources (tab) > Resource Type > Queries
permission.

l TheAdvanced RTSM Permissions > Resources (tab) > Resource Type > Views
permission.
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l TheAdvanced RTSM Permissions > General Actions (tab) > CI Related Actions
permission.

l TheAdvanced RTSM Permissions > General Actions (tab) > Data Retrieval Actions
permission.

o To enable anOMi user to map a run book to the selected CI type, in OMi, the user must have
theOperations Console > Run Book Mappings permission to administer Run Books.

o To enable anOMi user to administer Run Book Mappings and Automatic Run Book Execution
pages in OMi, the user must be created on both OMi andOO, as described above. The same
configuration and required permissions apply as for the integration user.

7. Map run books to CI Types

You canmapOO run book parameters to:

o CI type attributes. For details on the user interface, see theOMi Administration Guide.

The child CIs of a CI, for which you configure a run book, are also assigned to that run book.

Note: To be able tomap run books to CI types, either create a run book flow in OO, or
import a content pack in OOwith the Content Workspace.

o The event attributes are predefined in OMi.

For details, see theOMi Administration Guide.

8. Use OO functionality from OMi

You can trigger a run book:

o From Service Health by using the Invoke Run Books context menu option.

o From the Event Browser by using the context menu or from the Action Panel.
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Chapter 29: Troubleshooting Integration
Problems
Log Files

The oo_integration.log file enables you to perform basic troubleshooting of problems with OO
integration and run book execution.

For automatic run book execution, the oo_integration.log file is available on the data processing
server:

<OMi_HOME>/log/opr-backend/oo_integration.log

Log configuration can be performed in:

<OMi_HOME>/conf/core/Tools/log4j/opr-backend/OOIntegration.properties

For setting up and configuring the OO integration, as well as manual run book execution, the log file is
available on the gateway server:

<OMi_HOME>/log/jboss/oo_integration.log

Log configuration can be performed here:

<OMi_HOME>/conf/core/Tools/log4j/jboss/OOIntegration.properties

Connection Errors

Connection errors when accessing Run Book Mappings page in OMi

If you receive a remote connection error in the Run Book Mappings page, and no actions are available
for new or existing run books, check the oo_integration.log file on your gateway system. Look for
the following text:

Failure: User was not authenticated.

If you find this text, do the following:

1. Check that the LWSSO integration is correctly configured betweenOMi andOO.

2. Make sure that the logged in user exists in OO and has the correct permissions.

3. Check that the configured integration user can authenticate against the OO system and has the
correct permissions.
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Connection errors when selecting run books in Available Run Books

If you receive a connection error when you select run books in theAvailable Run Books pane
(Library > Operations), change the run.book.timeout and service.center.ws.timeout settings from
10000 to 60000 (1minute):

1. Open a JMX console on the OMi server:

https://localhost:29000

2. Select Foundations > service=Infrastructure Settings Manager.

3. To set the values, use setSettingValuePerCustomerId()with contextName: integrations and
settingName: settings.pm.settings.run.book.timeout or
settings.pm.settings.service.center.ws.timeout. Change to newValue: 60000.

Note: Restarting OMi is not required.

Different Domains

If OMi andOO are in different domains, and you are using Internet Explorer as your browser, youmay
need to add the domains to the list of allowed domains in the Privacy tab (Internet Options > Privacy
> Sites).

Web service API error

Problem: When logging into OMi with the integration user account, you receive the error "Web service
API returned HTTP status 403: Forbidden".

Solution: This is a known issue with OO 10.20. To resolve the problem, log into OMi as the
administrator and access Administration > Setup and Maintenance > Infrastructure Settings. In
the Foundations context, select Single Sign-On. Set Add user roles information to LW-SSO
token to false.
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Chapter 30: Examples of Operations Manager i
and Operations Orchestration Integrations
This section describes two possible scenarios to integrate OMi andOO.

Use Case Scenario in Service Health

In OO, theRestart a Node run book is associated with a Node CI Type. The parameters of the run
book aremapped to the relevant CI attributes of the Node CI.

In Service Health, the operator detects that a host has a system problem. The operator right-clicks the
CI to get a list of the run books relevant to the CI. One of the run books is Restart a Node. The run
book can execute automatically because the values of the parameters such as the host name or the IP
address are automatically populated by data taken from the CI context.

Use Case Scenario in the Event Browser

In the OMi Event Browser, the operator is going through the assigned events. The operator detects an
event related to a lack of disk space that causes a database performance issue. From the event
context, the operator can get a list of relevant run books. The operator can launch the appropriate run
book manually. The run book continues running without further input from the operator as all run book
parameters are extracted from the event or related CI.

Tip: If you set up the integration betweenOO andOMi, you can also useAutomatic Run Book
Execution to run anOO flow as an automatic action. For details, see theOMi Administration
Guide.

AlthoughOO flows are not set up as an automatic action in the policy, you can runOO flows
automatically when the event comes into OMi, or as a result of time-based event automation.
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Chapter 31: Operations Manager i - Operations
Bridge Analytics Integration Overview
Starting from theOperations Bridge Analytics (OBA) version 2.30, you can integrate OBA into your OMi
environment.

The integration betweenOMi andOBA provides you with the following capabilities:

l Cross Launch Integration. You can configure an integration that enables you to openOperations
Bridge Analytics directly from OMi in the context of a specific event or host. For more information,
see "Operations Bridge Analytics Cross Launch" on page 256.

l OMi Dashboard Integration. It is possible to configure a dashboard that displays the OBA user
interface within OMi. This can be done by adding opsa as a new component to OMi. For more
information, see the "Operations Bridge Analytics Dashboard Integration" on page 258.

l OBA alerts > OMi events. You can enable forwarding of OBA alerts to OMi, so that they are
managed as OMi events. OBA alerts are triggered by the OBA operator for the selected topology
elements in OBA. To be able tomanageOBA alerts within OMi, youmust first configure
connections betweenOMi andOBA. For more information on how to do this, see "Workflow:
Configuring Connections BetweenOMi andOBA" on page 262.

l OBA anomalies > OMi anomaly events. You can enable forwarding of OBA anomalies to OMi,
so that they aremanaged as OMi anomaly events. OBA anomalies are triggered automatically by
OBA when the greater deviation from the standard baseline is observed for a number of the
monitored topology elements, such as metrics. Upon arrival of an anomaly event, you can set a rule
that causes an alert to be created when the condition is met. This could be , for example, when the
sufficient number of anomalies are detected or when the severity reaches the threshold. To be able
tomanage anomalies within OMi youmust first configure connections betweenOMi andOBA. For
more information on how this is done, see "Workflow: Configuring Connections BetweenOMi and
OBA" on page 262.

Note: Forwarding OBA anomalies to OMi is supported starting with OBA version 3.0.
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Chapter 32: Operations Bridge Analytics Cross
Launch
You can configure an integration that allows you to openOperations Bridge Analytics from OMi in the
context of a specific event or host. This allows you to open analysis tools from Operations Bridge
Analytics, such as log analytics and predictive analytics, quickly and easily in the appropriate context.

How to set up a Cross Launch Integration for OMi

Events

You can configure a cross launch for individual CI types from theOMi Operations Console. To do so,
perform the following steps:

1. In OMi, navigate to:

Administration > Operations Console > Tools

2. In theCI Types pane, select the CI type for which you want to enable the cross launch.

3. In the Tools pane, select  New. Fill in the appropriate values on theGeneral tab.

4. On the Type tab, select URL.

5. On the URL tab, specify a URL as seen in the following examples:

To query a single specified host over the last day:

http://<opsa_server
>:8080/opsa/#/logsearchpql?search=host%20withkey%20%22${event.node.dnsName}%22&
selectedTimeRange=ONE_DAY

To query all hosts over the last hour:

http://<opsa_
server>:8080/opsa/#/logsearchpql?search=host%20withkey%20%20*&selectedTimeRange
=ONE_HOUR

For details, seeOperations Analytics URL Syntax.
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How to Use a Cross Launch Integration from OMi

1. In OMi, navigate to:

Workspaces > Operations Console > Event Perspective

2. Right click the desired event, and selected Launch > Tool... from the context menu.

3. Select the tool that you created for the OBA cross launch and click Run.
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Chapter 33: Operations Bridge Analytics
Dashboard Integration
In this chapter, you will configure anOMi dashboard that displays the event browser and theOperations
Bridge Analytics user interface.

1. Prerequisite. LW-SSOmust be configured in the Operations Bridge Analytics environment. For
more information on configuring LW-SSO in Operations Bridge Analytics, see theOperations
Bridge Analytics Configuration Guide.

2. In OMi, create a new component with a name of your choice and the URL <opsa server
FQDN>:<port>/<dashboard name>.

3. Use theConfigure Wiring section to append the URL you want to use when opening OBA. For
example, the fragment /dashboard&search=host%20withkey%20%22<<relatedCi.name>>%22
opens a dashboard focusing on a CI.

For details, seeOperations Analytics URL Syntax.
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4. Create a new page, and add the component you just created, as well as the Event Browser
component to the page.

5. Verify the wiring configuration for the page is as follows:
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6. Save the page.

7. In Operations Bridge Analytics, locate <opsa_
server>/opt/HP/opsa/jboss/standalone/deployments/opsa-ui-web.war/WEB-
INF/web.xml.

Modify the following section from:

<init-param>
<param-name>X-Frame-Options</param-name>
<param-value>SAMEORIGIN</param-value>
</init-param>

To:
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<init-param>
<param-name>X-Frame-Options</param-name>
<param-value>Allow-From http://<OMi URL>/opr-web</param value>

8. Restart the OBA server by running the command opsa-server restart.

9. HPE recommends adding amapping of the Operations Bridge Analytics IP and theOperations
Bridge Analytics FQDN in the window host file in every client machine that will be used to access
Operations Bridge Analytics.

10. Delete the cookies of all browsers used to access OMi.

11. Add the FQDN of the Operations Bridge Analytics environment to the list of trusted hosts in OMi
from the AuthenticationManagement section. To do so, navigate toAdministration > Users >
Authentication Management. In the Single Sign-OnConfiguration section, click Edit to open
Single Sign On Editor panel and add theOBA FQDN to the list of trusted hosts.

OMi Integrations Guide
Chapter 33: Operations Bridge Analytics Dashboard Integration

HPE Operations Manager i (10.60) Page 261 of 272



Chapter 34: Workflow: Configuring Connections
Between OMi and OBA

1. Install the Operations Agent on the OBA server

Note: You can skip this step in you have anOBA server version 3.0, because it has an
Operations Agent version 12 already preinstalled.

To be able tomanageOBA alerts and anomalies as OMi events, it is necessary to configure an
OBA server as anOMi managed node. This means that youmust have the Operations Agent
installed on theOBA server, which then enables monitoring the OBA alerts and anomalies and
forwarding them to OMi.

For task details, see "OBA 2.3x Only: Installing the Operations Agent on the OBA Server " on
page 264.

2. Connect the Operations Agent to the OMi server

In addition tomonitoring OBA alerts and anomalies, Operations Agent forwards them to OMi.
Therefore, make sure to connect the Operations Agent to OMi.

For task details, see "How to Connect the Operations Agent to OMi" on page 265.

3. Import the content pack from OBA to OMi

OMi content packs are the part of the OBA installation. They contain themanagement templates
and aspect area ready to be used by OMi.

For task details, see "Importing Content Packs from theOBA Server" on page 266.

4. Deploy and assign the management template from OMi to OBA

Import the OMi_Content_Pack-OPSA.zip from OBA to OMi. The importedmanagement template
must be deployed and assigned to the OBA server so that it canmonitor the log files in which the
OBA alerts and anomalies are written.

For task details, see "How to Deploy and AssignManagement Templates to anOBA Server " on
page 268.
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Overview: Forwarding OBA Alerts and Anomalies to

OMi

You can configure the Operations Agent to retrieve alerts and anomalies from OBA and forward them to
OMi as events. This enables you to get the benefit from using both the capabilities of OBA to identify
events by using analytic tools and the advanced event management capabilities available with OMi.

If configured so in OBA, the OBA alerts and anomalies are logged into two predefined log files located
on theOBA server. When theOperations Agent is installed and configured on theOBA server as an
OMi monitored node, it enables two sets of Logfile Entry policies tomonitor each of these log files and
then forward the OBA alerts and anomalies to OMi to bemanaged as events and anomaly events. You
can filter the log file entries by a set of rules in these policies. The following is the pattern of the log line
in the policy:

<*.instanceId>;<*.tenant>;<*.userId>;<*.alertId>;<*.alertName>;<*.alertType>;<*.sev
erity>;<*.conditionString>;<*.schedule>;<*.triggerTime>;<*.calculationPeriod>;<*.al
ertInstanceLink>;<*.allAlertsLink>;<*.description>

Note: TheOBA alerts and anomalies are sent with the Low, Medium and High severities, which
are thenmapped to the OMi severities (Critical, Major and Normal) in the policies.

For more information about policy management in OMi, see theOMi Administration Guide.

The following diagram shows the details of this integration:
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Chapter 35: OBA 2.3x Only: Installing the
Operations Agent on the OBA Server
To be able tomanageOBA alerts and anomalies as OMi events, youmust configure the OBA server as
anOMi monitored node. This means that youmust install the Operations Agent on the OBA server so
that the policy templates canmonitor the log files in which OBA alerts and anomalies are written and
create appropriate events in OMi.

Note: To be able to useOMi Monitoring Automation features, the Operations Agent 12 or later is
required.

When installing the agent, specify the gateway server, the load balancer, or the reverse proxy as the
agent's management server. For information about installing the Operations Agent, see theOperations
Agent andOperations Smart Plug-ins for Infrastructure Installation and Configuration Guide.

When the communication between the agent and the OMi server is established and the agent
processes are running, a node CI is created in the RTSM for the OBA server. You can then deploy
management templates, aspects, policies, and instrumentation to the node. Alternatively, if the node
matches an automatic assignment rule, OMi creates an assignment for the CI, and starts the
deployment jobs required to transfer themonitoring configuration to the node. After the agent starts
monitoring the system, it sends events to OMi, which you can view in the Event Browser.

Note: TheOperations Agent is available on the HPE Operations Agent media DVD, which is
included in the OMi media kit. The latest agent updates can be downloaded from the HPE
Software Support website.
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Chapter 36: How to Connect the Operations
Agent to OMi
When you install the Operations Agent on the OBA server, you connect it to OMi if you enter the
management server. If this is not the case, for example, when the agent is installed in inactivemode,
youmust manually connect the agent to OMi, and then grant the required certificates to connect the
OBA server as amonitored system toMonitoring Automation. To do so, follow these steps:

1. Connect the agent to OMi:

a. Log on to the OBA server.

b. Navigate to the following location:

l Windows 64-bit: %OvInstallDir%\bin\win64\OpC\install

Windows 32-bit: %OvInstallDir%\bin\OpC\install

%OvInstallDir% default: C:\Program Files\HP\HP BTO Software\

l AIX, HP-UX, Linux, and Solaris: /opt/OV/bin/OpC/install/

c. Run the following script to install the Operations Agent on the OBA server:

l Windows: cscript oainstall.vbs -a -i -srv <Gateway_Server>

l AIX, HP-UX, Linux, and Solaris: oainstall.sh -a -i -srv <Gateway_Server>

2. In the OMi user interface, open the Certificate Requests manager and accept the new certificate
request:

Administration > Setup and Maintenance > Certificate Requests

Formore information about granting certificate requests, see theOMi Administration Guide.

Tip: You can grant certificates automatically by using preconfigured IP ranges or a groovy
script. For details, see theOMi Administration Guide.

3. Optional. Check HTTPS communication in both directions:

bbcutil -ping https://<FQDN>

If the connection is successful, the command returns status=eServiceOK.
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Chapter 37: Importing Content Packs from the
OBA Server
Operations Bridge Analytics provides content packs that contain themanagement templates and
aspect area ready to be used by OMi. The following content packs are available for OMi. Import the
OMi_Content_Pack-OPSA.zip content pack from the following location:

For OBA 2.31:

/opt/HP/opsa/omi_content_pack/

l For OMi 9.2x and OpsA 2.31

omi_092x_content_pack-2.31.zip

l For OMi 10.0x and OpsA 2.31

omi_100x_content_pack-2.31.zip

For OBA 3.0:

/opt/HP/opsa/content_packs/omi_content_pack

l For OMi 10.0x and OpsA 3.0

omi_100x_content_pack-3.00.zip

How to Import Content Packs

When you import a content pack, existing items with the same ID are generally overwritten. If you are
importing a predefined content pack, only predefined content is overwritten with new data. Customized
content is left untouched. Importing a custom content pack always overwrites existing data.

Unresolved references in the imported definition (for example, to unknownCI types) are not allowed. To
import content packs, follow these steps:

Note: In SaaS installations, predefined content packs can only be imported by a SaaS Admin
(Super User).

1. In the Import Content Pack dialog box, click Browse and locate the content pack you want to
import.
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The default location for content packs is:

<OMi_HOME>/conf/opr/content/<locale>

In a distributed deployment, this directory is located on the data processing server.

Note: By default, OMi looks for content packs in the file system on the system where you
start the browser session. If the browser is running on a remote system, youmust navigate to
the file system of the OMi host.

2. Optional. Click Preview to list the artifacts that are included in the selected content pack and any
required andmissing dependencies:

o Contained artifacts (grouped by type)

o Fulfilled dependencies to other Content Packs

o Missing dependencies to other Content Packs

This does not run an import, no changes are committed to OMi.

The preview also shows whether the content pack to be imported is predefined or custom.

When it is predefined, there is a check mark next to the term Predefined. When it is custom, no
check mark is displayed.

3. Select Import to start the import or test operation.

Note: If the import is running, you cannot start another one.
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Chapter 38: How to Deploy and Assign
Management Templates to an OBA Server
You import a content pack from OBA to OMi, and then deploy and assign the importedmanagement
templates to the OBA server so that they can listen to the log files where the OBA alerts and anomalies
are written. To do so, follow these steps:

1. Import the OMi_Content_Pack-OPSA.zip content pack to OMi from the following location on the
OBA server:

<opsa_server>/opt/HP/opsa/omi_content_pack/

Formore information on importing content packs to OMi, see theOMi Administration Guide.

2. In OMi, openManagement Templates & Aspects:

Administration > Monitoring > Management Templates & Aspects

3. In theConfiguration Folders pane, select theOPSA folder.

4. In theManagement Templates & Aspects pane, select OPSA alerts and click Assign and
Deploy Item... .

Note: The Assign and Deploy Item button is grayed out if the policy template contains a stub
instrumentation. Upload the instrumentation by using the Content Manager.

5. In theAssign and Deploywizard, select ops as the configuration item to which you want to
assign themanagement template. Specify parameters and configuration as needed, then click
Finish.

6. Optional. In the Configure Options page, clear theEnable Assignment(s) check box if you do not
want to enable the assignment immediately. You can enable the assignment later by using the
Assignments & Tuningmanager.

7. Click Finish. OMi creates deployment job, which deploys themanagement template to the node.

Note: After a policy template is deployed, the OMi server specified in theDefault Virtual
Gateway Server for Data Collectors URL infrastructure setting becomes the owner of the
policy on the node.

8. To verify the deployment, select OPSA alerts in theManagement Templates & Aspects pane and

click List Assignments for Selected Item...
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Note: After a policy template is deployed, the OMi server specified in theDefault Virtual
Gateway Server for Data Collectors URL infrastructure setting becomes the owner of the
policy on the node.
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Part IX: OpsCx Integrations
OpsCx captures data such as events, metrics, and topology from third-party systems. Events and
topology data are forwarded to OMi; metrics data is stored locally on the OpsCx system and can be
viewed in OMi by using the Performance Dashboard. Service Health Reporter, a high-capacity
performance reporting solution also enables you to generate reports on data collected by OpsCx.

To access

In OMi, select:

Administration > Setup and Maintenance > Connected Servers

For details on configuring anOperations Connector server in OMi, see theOperations Connector User
Guide.

OpsCx Integrations Overview

From the Connected Servers page, you can access andmaintain all OpsCxs in the OMi deployment
environment, regardless of the operating system or host location on which the OpsCx is installed.

The Connected Servers page enables you to add, modify, or removeOpsCx integrations from theOMi
deployment environment.

Before you can add anOpsCx integration, OpsCx must be installed in the OMi deployment
environment. That is, the OpsCx host must have access to at least oneOMi Gateway Server in the
OMi deployment environment to which it sends the collected data. Additionally, OpsCx must have
access to the third-party system from which it is collecting data.

For some types of data sources, OpsCx must be installed and run locally on the host of the third-party
system with which it is integrating. Examples for local data sources are XML files, openmessage
interfacemessages, and scheduled tasks. For other types of data sources, OpsCx can be installed on
the host of the third-party system or on a remote system. For more information on supported data
sources, seeOpsCx Help.

The following diagram shows an example of an OMi deployment environment with four OpsCx
integrations.
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For information about installing OpsCx, see theOpsCx Installation and UpgradeGuide.

Controlling data transfer with policies

The data transfer is controlled by policies that you define in OpsCx. Policies monitor the data sources
and, if certain conditions apply, forward the data in the form of events or metrics to OMi. The policies
can optionally alsomap the data to topology and create configuration items (CIs) and CI relationships in
OpsCx. This enables OMi to associate the events andmetrics it receives with CIs.

Out-of-the box integrations

You can use one of the out-of-the box integrations that are available for Operations Connector.
Alternatively, if you do not find the integration that you are looking for, you can develop your own
custom integration.

HPE is continually updating the list of the integrations with third-party products. For details and for
download information, see the HPE Live Network Content Marketplace:
https://hpln.hpe.com/product/ops-bridge/content

More information

For complete information about the features, capabilities, and usage of OpsCx, seeOpsCx Help after

you install OpsCx. To access the help, click Help in the toolbar of the OpsCx user interface.

https://hpln.hpe.com/product/ops-bridge/content


Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on OMi Integrations Guide (Operations Manager i 10.60)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to ovdoc-asm@hpe.com.

We appreciate your feedback!

Go OMi!

mailto:ovdoc-asm@hpe.com?subject=Feedback on OMi Integrations Guide (Operations Manager i 10.60)
https://hpln.hpe.com/group/operations-manager-i-omi
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